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Welcome  

Hi! Welcome to the Embrilliance® Platform! 

4ÈÁÎËÓ ÆÏÒ ÒÅÁÄÉÎÇ ÔÈÉÓ 5ÓÅÒ 'ÕÉÄÅȦ 3ÉÎÃÅ ÙÏÕȭÒÅ ÈÅÒÅȟ ÌÅÔ ÕÓ ÔÅÌÌ ÙÏÕ ÁÂÏÕÔ ÔÈÉÓ ÅØÃÉÔÉÎÇ ÐÒÏÇÒÁÍ 
because it represents a giant step forward in embroidery. 

For starters, it is a small, yet feature packed, program that is easy to install. It has versions for both 
Mac OSX and Windows. Windows versions install on XP, Vista and Windows 7/8 (including a separate 
Win 7/8 64 -bit version.) It requires no hardware dongle and can be installed on multiple systems 
requiring only your personal serial number to be typed in for the program to run. Once you enter a serial 
number, register the program, which provides several benefits. One of those benefits is that if you ever 
lose your serial number, we can recover it for you.  

This manual covers the features in the platform and its available products. Some features are 
available to all licensed products, but are not available in Express Mode (free version). 

Welcome to Embrilliance , and let the fun begin!  

Products  

4ÈÅ %ÍÂÒÉÌÌÉÁÎÃÅ 0ÌÁÔÆÏÒÍ ÓÕÐÐÏÒÔÓ Á ÆÒÅÅ ÍÏÄÅ ÃÁÌÌÅÄ Ȭ%ØÐÒÅÓÓ -ÏÄÅȭ ÁÓ ×ÅÌÌ ÁÓ Á ÎÕÍÂÅÒ ÏÆ ÐÁÉÄ 
ÐÒÏÄÕÃÔÓȢ %ØÐÒÅÓÓ -ÏÄÅ ÉÓ ÒÕÎ ÂÙ ÓËÉÐÐÉÎÇ ÔÈÅ Ȭ3ÅÒÉÁÌ .ÕÍÂÅÒȭ ÒÅÑÕÅÓÔ ×ÈÅÎ ÔÈÅ ÐÒÏÇÒÁÍ ÉÓ ÒÕÎȢ %ØÐÒÅÓÓ 
Mode allows anyone to use the popular .BX-installer for embroidery design collections that are sold as 
fonts on the internet. If you have a .BX installer, please refer to the PDF document that came with the font. 

Other products that are sold for use in the platform include: 

Essentials, Enthusiast, Density Repair Kit, AlphaTricks and StitchArtist 

Each of these products has its own sections in this manual. 

Installation  

Installation of Embrilliance is easy. First install the disc or download the installer. If you have the 
disc, XP may automatically run it, but in later versions of Windows, Auto-Run has been turned off by 
-ÉÃÒÏÓÏÆÔȟ ÓÏ ÙÏÕȭÌÌ ÈÁÖÅ ÔÏ ÂÒÏ×ÓÅ ÔÏ ÉÔ ÕÓÉÎÇ 7ÉÎÄÏ×Ó File %ØÐÌÏÒÅÒ ɉÁȢËȢÁȢ Ȱ#ÏÍÐÕÔÅÒȱ ÏÒ Ȱ-Ù 
#ÏÍÐÕÔÅÒȱɊȢ ,ÏÏË ÆÏÒ ÔÈÅ ÐÒÏÇÒÁÍ ×ÉÔÈ Ȱ3ÅÔÕÐȱ ÉÎ ÔÈÅ ÎÁÍÅ ÁÎÄ ÄÏÕÂÌÅ ÃÌÉÃË ÏÎ ÉÔȢ 4ÈÉÓ ×ÉÌÌ ÓÔÁÒÔ ÔÈÅ 
installation. In Windows it looks like this: 
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#ÌÉÃË Ȭ.ÅØÔȭ ÔÈÅÎ ÁÃÃÅÐÔ ÔÈÅ ÌÉÃÅÎÓÅ Ágreement by clicking the button theÎ ÃÌÉÃË Ȭ.ÅØt.ȭ 

     

#ÌÉÃË Ȭ.ÅØÔȢȭ 9ÏÕ ×ÉÌÌ ÕÓÕÁÌÌÙ ×ÁÎÔ Á ÄÅÓËÔÏÐ ÉÃÏÎ ÆÏÒ ÅÁÓÅ ÏÆ ÒÕÎÎÉÎÇ ÔÈÅ ÐÒÏÇÒÁÍȢ #ÌÉÃË Ȭ.ÅØÔȭ 

 

    You are now ready to bÅÇÉÎ ÉÎÓÔÁÌÌÉÎÇȢ #ÌÉÃË Ȭ)ÎÓÔÁÌÌȢȭ  

 

Run Embrilliance now or just quit the setup by unchecking the ȬLaunchȣȭ box. 

You are finished installing!  
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Serial Numbers  

The serial number system in the Embrilliance Platform is a bit different but very powerful. To 

understand it, you first have to understand the Embrilliance Platform. What exactly is it? Well, it is a 

program that runs on your Mac or Windows computer. 

 

The basic serial number window. Click Continue. 

The Platform itself contains the features of several products, for example Essentials and StitchArtist. 

When you run the program, you are asked for your serial numbers, if you donôt have any already set. 

The serial numbers activate different products within the program. 

Why do this? Because different products, like Essentials and StitchArtist work well together, in one 

program. If we made you switch from program to program, it would be confusing and awkward, as each 

would work a bit differently from each other. This has been done before and it is a mess. Using one 

program, you can add features as you like. It makes your Platform tailor-fit to your embroidery needs 

(and budget!) 

Express Mode  (Free!)  

The Embrilliance Platform also can be run without any serial numbers at all. This is what we call, 

ñExpress Mode.ò 

 

To move past the serial number entry, Click Continue. 

Express Mode is useful. There are hundreds of designers making tens of thousands of embroidery 

fonts and designs, and they publish into the Embrilliance ñ.BXò installer. Why? So that you can use 

those fonts as easily as typing. If you only bought letters as designs, you would have to spell out 

everything by doing one letter at a time. Imagine aligning those designs to embroider a poem. Thatôs 
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how it used to be. We made the .BX system free to designers and free to all users. This stopped the 

annoyance of the layout and made using those beautiful embroidery fonts a true joy to use. 

If you donôt have any serial numbers for Embrilliance Platform titles, thatôs okay. We want you to 

use the program easily. When you run the program, you will see a request to enter serial numbers. 

Simply continue past that. Youôll get a note about the limits of Express Mode, and thatôs all weôll bother 

you with ð you can type and save. 

Of course, there are some limits to what we give away. You canôt resize designs, or merge your 

lettering with other stitch files, but those features, and a lot more, are made very easy using Essentials, 

our most popular title. 

Obtaining your serial numbers  

When you made your purchase, you got a serial number for each product. If you bought from us 

online, it was in the order confirmation email. It will also be shown if you look up the order in our 

online store. If you bought on a disc from a dealer or Amazon, the serial number will be on a label inside 

the disc case, directly above the disc. If the packaging is older, it might be that thereôs a serial number 

label on the back of the case, bottom right. 

For previously registered serial numbers, you can create an account in the Embrilliance store (if you 

haven't already) and log in. Even if you did not buy your Embrilliance products directly from our store, 

you can log into an account that has verified your email. From there you can use the My Account 

dashboard to have a list of all your registered serial numbers sent to you at any email address which you 

still receive.  

 

Example text from the Serial Number retrieval email. 

Note: You can select and copy this text to be pasted into the Serial Numbers window, below.  

Adding your serial numbers  

Use the menu Help->Serial Numbersé to add serial numbers that you own. 

We know that most of you have more than one Embrilliance product, and that means you are 
collecting serial numbers. Naturally, you can type them in, one per line, remembering to type the dashes 
in, but do not add spaces in the number. 

 If you have your serial numbers in text, either from the email we sent or from a text editor (a.k.a. 
Notepad) file, you can copy the serial numbers text and click Paste. 
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Copying from our email or a text file is easy. 

 

Pasted text 

Once you have pasted or typed the numbers into the window, click Set. This tells the program to 
look through the text to find and evaluate any serial numbers. Once it does, the numbers will appear in 
the lower white box, as a list of serial numbers. 
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Serial numbers have been set in the program. 

 

Repeat the process if you need to add text from multiple sources.  

Remember, this window only accepts serial numbers for Platform titles, not Thumbnailer. Platform 
may recognize some Embrilliance collections, but not all, as it depends what they contain. 

If you click Learn More, you will be taken to a web page at Embrilliance.com where you can see 
these instructions and more, as things develop, plus you can create an account and log into it to have your 
serial numbers emailed. 

Note: Once you have installed a Font collection, the program may ask for its serial number 
immediately or later, when you run the program. Once you enter the serial number, you 
will not be asked for it again.  

If you would like to create a text file (.txt) that contains all your serial numbers, click Copy All. This 
puts the numbers on the clipboard so you can paste them into Notepad or something similar. It is simple 
a convenience for saving your serial numbers in an easily accessible spot. 

In the unlikely event you want to remove something, you can do that too. You simply select the 
number to remove and click Remove. Sometimes, education programs occur where temporary serial 
numbers are handed out. Other times, you may be simply trying out one of our titles to see if it suits your 
needs. This makes that process simple. 

Register  

You can click Register to update our records. Otherwise, iÆ ÙÏÕȭÖÅ ÁÄÄÅÄ ÓÅÒÉÁÌ ÎÕÍÂÅÒÓȟ ÔÈÅ 
registration window will appear as you exit the serial numbers window. You have serial numbers, so 
please register them with us. If you ever need them and cannot find them, we can provide them to you. 
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You can update your information, including your email address anytime. 

 This allows us to provide them to you anytime in the future. If your email address changes, simply 
re-register. This will add that information to our system so you can get them again in the future. 

If you bought from our online store, you probably have your serial numbers registered, as our 
newer system does this automatically. You can look in your orders in the store and see. 

)Æ ÙÏÕ ÂÏÕÇÈÔ ÅÌÓÅ×ÈÅÒÅȟ ÉÔ ÄÏÅÓÎȭÔ ÍÁÔÔÅÒȢ 0ÌÅÁÓÅ ÒÅÇÉÓÔÅÒȢ 7Å ×ÉÌÌ ÎÏÔ ÐÅÓÔÅÒ ÙÏÕȢ )Ô ÍÁËÅÓ ÙÏÕÒ ÌÉÆÅ 
easier, which is why we work so hard at making the system friendly. 

Restart  

After entering the serial numbers, restart the program so the new features will be visible. Some can 
only be displayed when the program runs. 

 

Program License  

Embrilliance licenses for single-user use and you may install and run the program on as many 
computers as you own. You may even mix and match Mac and Windows versions. If you are a business 
that requires multiple users, please contact us for additional or site licenses, possibly at a discount. 
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The Windows Docking Pane Interface  

This interface can be configured and the configuration is persistent, i.e., it is remembered between 
program invocations. The controls for this interface consist of a Pin, a Close Box and a Tab. The Pin and 
Tab are relateÄȢ 7ÈÅÎ ÔÈÅ 0ÉÎ ÉÓ ȰÕÎÐÉÎÎÅÄȱ ÔÈÅ ×ÉÎÄÏ× ÓÌÉÄÅÓ ÉÎÔÏ ÔÈÅ ÍÁÉÎ ×ÉÎÄÏ× ÆÒÁÍÅ ÁÎÄ ÐÒÅÓÅÎÔÓ 
Á 4ÁÂ ×ÉÔÈ ÔÈÅ ×ÉÎÄÏ× ÎÁÍÅȢ 7ÈÅÎ ÔÈÅ 0ÉÎ ÉÓ ȰÐÉÎÎÅÄȱ ÔÈÅ ×ÉÎÄÏ× ÓÔÁÙÓ ÏÐÅÎ ÁÎÄ ÔÈÅ 4ÁÂ ÇÏÅÓ Á×ÁÙȢ 

In the unpinned configuration, hovering the cursor over the Tab reveals the window. When the 
cursor is moved out of the window it slides back into its unpinned position. 

The Close Box dismisses the window altogether. To restore a dismissed window, you must use the 
View Menu->Toolbars and Windows item to restore the dismissed window. 

   

Left: Unpinned     Right: Pinned 

    

Left: Pinned Windows.  Right: Reset Windows command in Menu. 

Note: If your system changes, some windows may be moved or hidden. This is easily corrected 
ÕÓÉÎÇ ÔÈÅ ÍÅÎÕ Ȭ6ÉÅ×->Windows and Toolbars ->Reset 7ÉÎÄÏ×Ó ÁÎÄ 4ÏÏÌÂÁÒÓȭȢ 
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Platform Overview  

This large section describes the overall Embrilliance Platform, which runs several products 
including Essentials, AlphaTricks, Density Repair Kit, and StitchArtist. As these platform features are 
common to the proÄÕÃÔÓȟ ×ÅȭÌÌ ÃÏÖÅÒ ÔÈÅÍ ÔÏÇÅÔÈÅÒ. 

Below is a picture of the Embrilliance window. 

 

Å  As with most programs at the top of the window is the main menu, and below the main Menu is the 
main toolbar. These two components are always available and handle the most significant 
commands of the program. 

Å  The Tool pane is a little different. It will display different contents, depending on what type of task 
you are performing. For instance, if you are running the Sewing Simulator, the controls for the 
simulator will appear in the Tool pane. 

Å  The Main view displays the current Design Page. A Design Page is a representation of a .BE file, 
which can contain multiple embroidery designs, lettering objects and frames. 

Å  More than one Design Page can be open, and these are selectable by using the tabs above the Main 
View, just below the Tool Pane. As you save Design Pages, they will take the names you have given 
ÔÈÅÍȢ 5ÎÔÉÌ Á ÐÁÇÅ ÉÓ ÓÁÖÅÄȟ ÉÔ ×ÉÌÌ ÂÅ ÃÁÌÌÅÄ Ȱ5ÎÔÉÔÌÅÄȢȢȢȱ 

Å  The Status bÁÒ ÐÒÏÖÉÄÅÓ ÒÅÌÅÖÁÎÔ ÉÎÆÏÒÍÁÔÉÏÎ ÁÂÏÕÔ ×ÈÁÔ ÉÓ ÇÏÉÎÇ ÏÎ ×ÉÔÈ ÔÈÅ ÐÒÏÇÒÁÍȭÓ ÃÕÒÒÅÎÔ 
operation. For instance, if you are measuring items, the text in the bottom right corner of the Status 
bar will update with the measurements created by that tool. 

Å  The Navigation view provides an easy-to-use way to navigate around the current design page, and 
to control the zoom for it. This is especially useful when you have a lot of objects on a large design 
page and you want to go from one place to another without repeatedly zooming and scrolling. 
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Å  The Object view displays Designs and Objects sequential order as they are opened or merged onto 
the design page.  Each root (leftmost) item in the Objects view is a Design. A Design or object may 
be, for example, a lettering design, or perhaps a regular embroidery design. 

Å  The Designs in the Object vÉÅ× ÃÁÎ ÈÁÖÅ ÏÂÊÅÃÔÓ ×ÉÔÈÉÎ ÔÈÅÍȢ 4Ï ÖÉÅ× ÔÈÏÓÅ ÏÂÊÅÃÔÓȟ ÃÌÉÃË ÔÈÅ ȬϹȭ 
×ÈÉÃÈ ÏÐÅÎÓ ÕÐ ÔÈÅ ÔÒÅÅȟ ÔÈÅÒÅÂÙ ȬÄÉÓÃÌÏÓÉÎÇȭ ÔÈÅ ÏÂÊÅÃÔÓ ÉÎ ÔÈÅ ÄÅÓÉÇÎȢ 7ÉÔÈ Á ÎÏÒÍÁÌ ÅÍÂÒÏÉÄÅÒÙ 
design merged into the page, you will be able to see individual colors within the design once you 
ÃÌÉÃË ÔÈÅ ȬϹȢȭ 3ÏÍÅ ÄÅÓÉÇÎÓȟ ÌÉËÅ ÌÅÔÔÅÒÉÎÇ ÄÅÓÉÇÎÓȟ ÍÁÙ ÎÏÔ ÄÉÓÃÌÏÓÅ ÔÈÅÉÒ ÉÎÄÉÖÉÄÕÁÌ ÏÂÊÅÃÔÓ ÂÅÃÁÕÓÅ 
all editing is done via the Properties view. 

Å  The Object view can also be used to select designs and objects, which is useful when objects within 
a design are grouped, such as with regularly merged embroidery designs. 

Å  The Property view displays information and controls for the currently selected objects and designs. 
For example, if a single-ÃÏÌÏÒ ÄÅÓÉÇÎ ÓÕÃÈ ÁÓ ÌÅÔÔÅÒÉÎÇ ÉÓ ÓÅÌÅÃÔÅÄȟ ÙÏÕ ×ÉÌÌ ÓÅÅ ÉÎ ÔÈÅ Ȭ#ÏÌÏÒȭ ÐÒÏÐÅÒÔÙ 
page only the single color for the lettering. If no design or object is selected, the Color property 
page is shown and the colors for the entire design page are shown. 

Embrilliance Design Pages  

A Design Page is where designs and lettering can come together to form a composition or a scene. 
That page is also represented as a single embroidery (or working) file. For example, you may have 
merged multiple embroidery designs, added a couple lettering designs, and then surrounded them with a 
Library  frame. All those individual designs exist on the Design Page. That scene can be saved as an 
embroidery file for use in yÏÕÒ ÍÁÃÈÉÎÅȟ ÁÎÄ ÉÔ ÃÁÎ ÁÌÓÏ ÂÅ ÓÁÖÅÄ ÁÓ Á Ȭ7ÏÒËÉÎÇ &ÉÌÅȭ ɉÅØÔÅÎÓÉÏÎ Ȣ"%Ɋ, 
which allows for editing later. (Suppose you miss-typed some lettering.) 

As Design Pages are opened or saved, their name will appear in the Tabs above the Main View. You 
can switch between Design Pages using the Tab View. This is handy for clipboard operations such as 
doing a copy and paste between Design Pages. 

 

Designs  

%ÁÃÈ $ÅÓÉÇÎ ÏÎ Á $ÅÓÉÇÎ 0ÁÇÅ ÉÓ ÏÎÅ ÏÆ ÔÈÅ ÔÈÒÅÅ ÔÙÐÅÓȟ Ȭ%ÍÂÒÏÉÄÅÒÙ $ÅÓÉÇÎȟȭ Ȭ,ÅÔÔÅÒÉÎÇ $ÅÓÉÇÎȭ ÁÎÄ 
ȬLibrary  DesiÇÎȢȭ 4ÈÅÓÅ design types work together to build useful embroidery compositions. The designs 
are visible on the Design Page in the Main View, and the sequence of the designs is visible in the Objects 
View. 

Designs are collections of objects. For example, a merged embroidery design is a collection of color 
objects, each of which contains stitches for a single color in the design.  

$ÅÓÉÇÎÓ ÍÁÙ ÂÅ ȬgÒÏÕÐÅÄȭ ×ÈÉÃÈ ÁÌÌÏ×Ó ÙÏÕȟ ÔÈÅ ÕÓÅÒȟ ÔÏ ÓÅÌÅÃÔ ÁÎÄ ÍÏÖÅ ÔÈÅ ÄÅÓÉÇÎ ÁÒÏÕÎÄ ÉÎ ÔÈÅ 
Main View as a single design. By default, when you merge an embroidery design into the page, it comes in 
as grouped. If you want to change one or more colors (or objects) in the design, you have some options: 

Å  Ungroup the design, which makes each object selectable in the Main View. 

Å  Select the object or objects in the Objects View. 
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$ÅÓÉÇÎÓ ÁÓ ÔÈÅÙ ÁÐÐÅÁÒ ÉÎ ÔÈÅ -ÁÉÎ 6ÉÅ× ÍÁÙ ÂÅ Ȭ,ÏÃËÅÄȭ ×ÈÉÃÈ ÐÒÅÖÅÎÔÓ ÉÎÁÄÖÅÒÔÅÎÔ ÍÏÖÉÎÇ ÏÒ 
editing. The lock may also be used to hide the design(s). The state of the Lock is set using the Objects 
View toolbar. 

Objects  

Each Design on the design page can contain one or more objects, each of which contains colors, 
stitches and other information. The only objects you will see are individual color objects within a merged 
embroidery design. Each object can be moved, edited, deleted, etc. 

Files  

Embrilliance uses a few different file types, each having its own file extension. For example, ȬȢ"%ȭ ÉÓ Á 
working file. This file type contains all the Designs and Objects representing a single Design Page. These 
designs and objects can be edited, as they have not been forced to become a simple set of stitches, which 
is what most machine embroidery files are. 

Licensed files, such as fonts will have .BF and .LF files. These are installed by the installer for our 
collections. You cannot edit or use these files as a user. The program loads them automatically as needed. 

3ÔÉÔÃÈ ÆÉÌÅÓȟ ×ÈÉÃÈ ÉÎ ÔÈÅ ÃÏÍÍÅÒÃÉÁÌ ÅÍÂÒÏÉÄÅÒÙ ÔÒÁÄÅ ÁÒÅ ÃÁÌÌÅÄ ȬÅØÐÁÎÄÅÄȭ ÆÉÌÅÓ ÓÕÃÈ ÁÓ Ȣ0%3 ÏÒ 
.DST are simply collections of stitches, and if you are lucky, colors. 

Saving  

When you save a Design Page it will ask you to choose which Stitch File type you want to use. For 
example, a Baby Lock / Brother embroidery machine owner will choose .PES as the stitch file type. In 
addition, the program will also silently save a working file (.BE) thus saving you the extra step of saving it 
separately. As mentioned earlier, the working file allows you to edit your designs including text. If you 
want to save individual files (not both stitch and working) you have all the options on the File menu. 

Working File Versions  

Each design page is given a unique code when it is created. When saving a working file (.BE) which 
ÒÅÐÒÅÓÅÎÔÓ Á ÄÅÓÉÇÎ ÐÁÇÅȟ ÔÈÁÔ ÃÏÄÅ ÉÓ ÓÁÖÅÄ ÉÎ ÔÈÅ ÆÉÌÅ ÔÏÏȢ 3ÕÂÓÅÑÕÅÎÔ Ȭ3ÁÖÅÓȭ ×ÉÌÌ ÃÈÅÃË ÔÈÅ ÃÏÄÅ ÆÏÒ ÔÈÅ 
design page. If it is different, the working file being saved will be given a revision number in its name such 
ÁÓ ȰɉςɊȢȱ 

The purpose for this can be explained in the following scenario:  

Suppose you create a page with lettering or StitchArtist objects. These objects contain far more 
ÉÎÆÏÒÍÁÔÉÏÎ ÔÈÁÎ ÓÔÉÔÃÈÅÓȢ .Ï× ÙÏÕ ÄÏ Á ÎÏÒÍÁÌ Ȭ3ÁÖÅȭ ×ÈÉÃÈ ÓÁÖÅÓ ÔÈÅ 3ÔÉÔÃÈ &ÉÌÅ ÁÎÄ ÔÈÅ 7ÏÒËÉÎÇ &ÉÌÅȢ 
Ok, all normal so far.  

Next, you Ȭ/penȭ the stitch file to see what it looks like, which actually creates a new design page and 
merges the stitch file onto it. 

Perhaps you make a small edit ɀ color or stitches, etc. YÏÕ ×ÁÎÔ ÔÏ ÓÁÖÅ ×ÈÁÔ ÙÏÕȭÖÅ ÊÕÓÔ ÄÏÎÅ ÓÏ ÙÏÕ 
ÃÌÉÃË Ȭ3ÁÖÅȭȢ 4ÈÅ ÐÒÏÇÒÁÍ ÌÅÔÓ ÙÏÕ ÐÉÃË Á ÎÁÍÅȟ ÂÕÔ ÙÏÕȭÒÅ ÈÁÐÐÙ ×ÉÔÈ ÔÈÅ ÏÎÅ ÙÏÕȭÖÅ ÇÏÔȢ .Ï× ÔÈÅ 
ÏÐÅÒÁÔÉÎÇ ÓÙÓÔÅÍ ÁÓËÓ ÉÆ ÙÏÕ ×ÁÎÔ ÔÏ Ȭ2ÅÐÌÁÃÅȭ ÔÈÅ ÆÉÌÅÓ ÓÉÎÃÅ ÔÈÅ ÎÁÍÅÓ ÁÒÅ ÉÄÅÎÔÉÃÁÌȢ 9ÏÕ ÔÈÉÎËȟ Ȱ3ÕÒÅȟ )ȭÌÌ 
replace it,ȱ ÆÏÒÇÅÔÔÉÎÇ ÔÈÁÔ ÙÏÕȭve Ȭ/ÐÅÎÅÄȭ ×ÉÔÈ the Stitch file, not the original Working file. 
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)Æ ÔÈÅ ÐÒÏÇÒÁÍ ÄÉÄ ÎÏÔ ÃÈÅÃË ÔÈÅ ÃÏÄÅÓȟ ÉÔ ×ÏÕÌÄ ÓÁÖÅ ÔÈÅ ȬÎÅ×ȭ ×ÏÒËÉÎÇ ÆÉÌÅ ÏÖÅÒ ÔÏÐ ÏÆ ÔÈÅ ÏÒÉÇÉÎÁÌ 
one, that ÈÁÄ ÁÌÌ ÔÈÅ ÏÂÊÅÃÔ ÄÁÔÁȢ "ÕÔ ÉÎ ÔÈÉÓ ÃÁÓÅȟ ÔÈÅ ÃÏÄÅÓ ÄÏÎȭÔ ÍÁÔÃÈ ÓÏ ÙÏÕ ÇÅÔ Á ÎÅ× ÖÅÒÓÉÏÎ ×ÏÒËÉÎÇ 
file. The stitch file will be overwritten, as it has no object data to be concerned about. 

Open vs.  Merge  

Files can be Ȭopenedȭ which starts a new Design Page in the Main View so that you can see the open 
file. Use Open for .BE files. 

If you already have a Design Page open, you can ȬÍergeȭ files, which adds the contents of the files to 
whatever you have on your page currently. To merge a file, click on the Merge icon on the Toolbar or go 
to File/Merge Stitch file or Merge Working file. 

.ÏÔÅȡ 7ÈÅÎ ÙÏÕ Ȭ/ÐÅÎȭ Á ÓÔÉÔÃÈ ÆÉÌÅ ÆÒÏÍ ÔÈÅ ÏÐÅÒÁÔÉÎÇ ÓÙÓÔÅÍ ɉÆÏÒ ÉÎÓÔÁÎÃÅ ÄÏÕÂÌÅ-clicking on a 
.PES file) you are actually creating a new design page and merging the stitch file into it.  
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Stitch Files  

   Clicking the Merge button found on the main toolbar or selecting Merge from the File 
menu will display the Open Design Files dialog. Here you browse for embroidery designs to add to 
the Design Page.  

   

The Merge Design view allows you to browse thumbnails 

of your files and select one or more files in import. 

 

Å  The Size control of this dialog determines the preview size of the design thumbnails (the design 
does not have to be selected for the determined size). The 3D control shows the preview in 3D, i.e., 
it shows simulated stitches. 

Å  Click Import to bring the selected design(s) into the Design Page. The imported design will be 
centered on the Design Page. 

 

Merged Stitch File behind Monogram. 
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The Main View  

Design pages are displayed in the Main View of the program. There can be multiple design pages 
open at any given time. For each page in use, a Tab control is displayed below the Tool Pane. Additional 
pages are added by clicking the New button on the Main tool bar, by pressing Ctrl-N by choosing New 
Page from the File menu or choosing New from the Window menu: 

        

A design page is activated by clicking its Tab control or select it from the list in the Window menu. 

 

The Tab control will display the name of the file associated with the page once it has been saved, 
ÏÔÈÅÒ×ÉÓÅ ÉÔ ÉÓ ÎÁÍÅÄ ȰÕÎÔÉÔÌÅÄ Øȱ ×ÈÅÒÅ Ø ÉÓ Á ÒÕÎÎÉÎÇ ÎÕÍÂÅÒȢ 

The Main View has a background, a hoop, and rulers along the side and, naturally, the designs you 
have placed in the Design Page. 
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Hoops  

The hoop that you will view in the Main View is chosen for the Design Page using the Preferences 
Window. 3ÅÅ ÔÈÅ ÓÅÃÔÉÏÎ ÕÎÄÅÒ 0ÒÅÆÅÒÅÎÃÅÓȟ ÃÁÌÌÅÄ Ȱ(ÏÏÐÓȢȱ 

     

Left: Hoop selection.   Right: What a hoop looks like in the Main View. 

When changing the hoop, you have the option of setting it as a preference for new pages, or simply 
setting it on the current page. 

Navigation  

   The Navigation H.U.D. (Heads Up Display) is an ingenious device that keeps 
navigation tools tucked away, yet readily available for easy access to the entire working area on 
your Design Page. To access the Navigation H.U.D. (aka: Nav H.U.D.), click the Compass Rose icon 
at the top of the zoom slider in the upper right -hand area of the main view.  

 

The Nav H.U.D. is especially useful when working on large designs and/or a small monitor. It quickly 
ÇÉÖÅÓ ÙÏÕ Á ÂÉÒÄȭÓ ÅÙÅ ÖÉÅ× ÏÆ ÙÏÕÒ ×ÏÒË ÁÒÅÁ ÁÓ ×ÅÌÌ ÁÓ Á convenient ȰÙÏÕ ÁÒÅ ÈÅÒÅȱ ÉÎÄÉÃÁÔÏÒȢ )Î ÔÈÅ 
following image, the area around ÔÈÅ ÍÏÕÓÅȭÓ eyes will be centered on the screen. 

!Ó ÙÏÕ ÍÏÖÅ ÔÈÅ ÃÕÒÓÏÒȟ ÔÈÅ ȬϹȭ ÉÎÄÉÃÁÔÅÓ ÔÈÅ ÁÒÅÁ ÏÆ ÆÏÃÕÓȢ The panel lets you pan around the design 
page. The benefit is that you can make edits to different design sections while you are still zoomed in to a 
comfortable level.  
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The Nav H.U.D works in conjunction with the Pan Tool, which is accessible by holding down the 
spacebar.  

Hold the spacebar and drag with this cursor to pan. 

Whereas the Pan Tool is useful for moving around the area in which you are currently working, the 
Nav H.U.D. makes it easy to scroll across the entire page to a specific place in one easy step. 

The chosen hoop is shown in the Nav H.U.D. whether that hoop is visible or not. This is because the 
size of your workspace is related to the size of that hoop. The selected hoop is a visual reference only and 
does not prevent you from designing or saving projects larger than the selected hoop or, for that matter, 
larger than your machine can sew. 

Therefore, if you have a small hoop selected and a design that well exceeds the hoop boundaries, it 
ÉÓ ÐÏÓÓÉÂÌÅ ÔÈÁÔ ÙÏÕ ×ÏÎȭÔ ÂÅ ÁÂÌÅ ÔÏ ÎÁÖÉÇÁÔÅ ÔÏ ÔÈÅ ÏÕÔÅÒ ÒÅÁÃÈÅÓ ÏÆ ÙÏÕÒ ÄÅÓÉÇÎȢ 4ÈÅ ÓÏÌÕÔÉÏÎ ÉÓ ÔÏ ÓÅÌÅÃÔ 
a larger hoop from the Environment > Hoops option in the Program Preferences panel. 

 

Same design with the hoop set to 60mm x 40mm with the cursor shown  
at the upper left limit. Parts of this design are inaccessible. 

.ÏÒÍÁÌÌÙȟ ÏÎÃÅ ÙÏÕȭÖÅ ÐÁÎÎÅÄ ÏÒ ÚÏÏÍÅÄ ÉÎ ÔÈÅ .Áv H.U.D. the panel will automatically close when 
ÙÏÕ ÒÅÌÅÁÓÅ ÔÈÅ ÍÏÕÓÅȢ )Æ ÙÏÕȭÄ ÌÉËÅ ÔÏ ÌÅÁÖÅ ÔÈÅ .ÁÖ (Ȣ5Ȣ$Ȣ ÏÐÅÎ ×ÈÉÌÅ ÙÏÕ ÍÏÖÅ ÔÏ ÓÅÖÅÒÁÌ ÌÏÃÁÔÉÏÎÓȟ ÃÌÉÃË 
ÔÈÅ Ȭ0ÉÎȭ ÂÕÔÔÏÎ ÊÕÓÔ ÔÏ ÔÈÅ ÌÅÆÔ ÏÆ ÔÈÅ ÃÌÏÓÅ ÂÏØȢ /ÎÃÅ ÐÉÎÎÅÄȟ ÔÈÅ ÐÁÎÅÌ ×ÉÌÌ ÓÔÁÙ open until you click out of 
it  ÏÒ ÃÌÉÃË ÔÈÅ Ȭ#ÌÏÓÅȭ ÂÕÔÔÏÎ ÏÎ ÔÈÅ ÔÏÐȟ ÒÉÇÈÔ ÉÎ ÔÈÅ (Ȣ5Ȣ$Ȣ 
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Unpinned (default setting)  Pinned 

.ÏÔÉÃÅ ÏÎ ÔÈÅ ÔÏÐ ÏÆ ÔÈÅ .ÁÖ (Ȣ5Ȣ$Ȣ ÁÒÅ ÔÈÒÅÅ ÓÍÁÌÌ ÂÕÔÔÏÎÓ ÌÁÂÅÌÅÄ Ȭ!ȟȭ Ȭ3ȟȭ ÁÎÄ Ȭ(Ȣȭ 4ÈÅÓÅ ÂÕÔÔÏÎÓ 
correspond to preset zoom settings ÏÆ Ȭ!ÌÌȟȭ Ȭ3ÅÌÅÃÔÅÄȟȭ ÁÎÄ Ȭ(ÏÏÐȟȭ ×ÈÏÓÅ ËÅÙÂÏÁÒÄ ÓÈÏÒÔÃÕÔÓ ÁÒÅ 
ÒÅÓÐÅÃÔÉÖÅÌÙ Ȭ!ȟȭ Ȭ3ȟȭ ÁÎÄ ȬπȢȭ 

Just below the compass rose icon is a zoom slider. Slide up to zoom in; down to zoom out. Click on 
ÔÈÅ ȬϹȭ ÁÎÄ Ȭ-ȭ ÂÕÔÔÏÎÓ ÔÏ ÚÏÏÍ ÉÎ ÁÎÄ ÏÕÔ ÁÌÓÏȢ )Æ ÙÏÕȭÖÅ ÅÖÅr used an online map, this zoom slider control 
should feel familiar. The slider control also responds to numeric key entry. For example, pressing 5 will 
move the slider control to 500%.  

Size and Rotate  

The lettering, the Library  designs and the merged stitch files can all be sized and moved.  

Note: Using some of the products, existing embroidery files can be resized with stitch 
recalculation. You can resize embroidery up to 250% and down to 50%. If you want to 
resize an existing design without stitch recalculation, hold down the Ctrl key while 
dragging the handle.  

¶ If you want to resize the design in place, hold down Shift. 

¶ Click and drag on a black handle to resize the design.  

¶ Click and drag the round blue handle to rotate the element. 

¶ Alt while sizing will shear (skew) or warp (Essentials, StitchArtist). 

 

Black handles resize, round blue handle in upper right rotates. 

Click and drag anywhere on a design element to move it. As the design is moved off the page, in any 
direction, the page will automatically scroll if the cursor is in the ruler area of the page.  

For finer movements (1mm at a click), the selected design element(s) can be nudged using the 
keyboard arrow keys. To move objects one stitch point at a time (.1mm), hold down the control key while 
pressing an arrow key. 

When resizing, understand that not every design can be recalculated perfectly. Some designs such as 
cross-stitch and freestanding lace are not going to resize correctly. Another consideration is the level of 
detail. Highly detailed designs radically reduced will lose clarity and crispness as the details become 
squished together. 
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Note: This is one major benefit of the Library designs; they can usually scale and calculate their 
stitches for you.  

Rotate around a point  

In the design library is an alignments collection (See the Design Libraries section of this manual). In 
ÔÈÅ ÁÌÉÇÎÍÅÎÔÓ ÉÓ Á ÒÏÔÁÔÉÏÎ ÐÏÉÎÔȢ !ÄÄ Á ÒÏÔÁÔÉÏÎ ÐÏÉÎÔ ÔÏ ÔÈÅ ÄÅÓÉÇÎ ÐÁÇÅ ÙÏÕȭÒÅ ×ÏÒËÉÎÇ ÏÎȟ ÔÈÅÎ ÓÅÌÅÃÔ 
it along with other designs and objects. This will cause all the selected items to rotate around the rotation 
point, when you use the rotation handle. 

The rotation point is further described in the Design Libraries section. 

Viewing in 3D  

   The default setting for the Main View is to display stitches in a realistic 3D, which 
lets you clearly see where the needles will penetrate the fabric. This can be turned off using the 
Ȭσ$ȭ ÂÕÔÔÏÎ ÏÎ ÔÈÅ ÍÁÉÎ ÔÏÏÌÂÁÒȢ 

Zooming  

   Zooming is handy for edits, and these controls make the process of 
zooming more convenient. Also, one of the options in the program is to be able to use a mouse 
wheel to scroll the design page up and down. If you have this mode on, the zoom slider is an 
alternate tool. Just a reminder, there are also keyboard shortcuts for zÏÏÍÉÎÇȡ ȬÚȭ ÚÏÏÍÓ ÉÎȟ ÁÎÄ Ȭ:ȭ 
(shift -z) zooms out. 

 

Zooming can also be accomplished with the Zoom Menu and Toolbar controls.  

Å  Ȭ!ÌÌȭ ÚÏÏÍÓ ÔÏ ÁÌÌ ÏÂÊÅÃÔÓ ÏÎ ÔÈÅ ÄÅÓÉÇÎ ÐÁÇÅȢ 

Å  Ȭ3ÅÌÅÃÔÅÄȭ ÚÏÏÍÓ ÔÏ ÓÅÌÅÃÔÅÄ ÏÂÊÅÃÔÓ ÏÎ ÔÈÅ ÐÁÇÅȢ 

Å  From the Zoom menu specify what should be zoomed: The Hoop, all elements or the Selected 
element or choose the amount of zoom. 

Tip: Memorize the keyboard shortcuts for the Zooming and Panning; using them can speed your 
designing!  
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Use the Zoom slider to zoom on the Main view. Up zooms in, down zooms out.  

  

There are zooming keyboard shortcuts: 

Å  ȬÚȭ ÔÏ ÚÏÏÍ ÉÎ 

Å  Ȭ:ȭ ÔÏ ÚÏÏÍ ÏÕÔȢ 

Å  0 = Fit Hoop 

Å  Ȭ!ȭ ÔÏ ÚÏÏÍ ÁÌÌ 

Å  Ȭ3ȭ ÔÏ ÚÏÏÍ ÓÅÌÅÃÔÅÄ 

Å  1 - 9 will zoom to 100%-900% of real-world scale. 

Panning and Scrolling  

   The scroll bars at the right and bottom of the Main View can be used to 
scroll the view around, which is very useful when you are zoomed in. 

4ÈÅÒÅ ÉÓ ÁÌÓÏ Á ÍÏÄÅ ÔÈÁÔ ÁÌÌÏ×Ó ÙÏÕ ÔÏ Ȭ0ÁÎȭ ÔÈÅ ÄÅÓÉÇÎȟ ×ÈÉÃÈ ×ÏÒËÓ ÌÉËÅ Á ÓÃÒÏÌÌȟ ÂÕÔ ×ÈÅÒÅ ÙÏÕ 
move the view by dragging the mouse. Hold the space bar down and drag the mouse to pan the view.  

Auto -Scroll  

 As you drag on the main view, you may come near the edge of the page. This will cause the page to 
scroll, enabling you to drag into a position thatȭÓ ÎÏÔ ÉÎ ÖÉÅ×Ȣ 

Rules and  Rulers  

Rulers exist along the top and left sides of the main view. 
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They indicate location from the center of the hoop. You can switch the rulers between metric and 
inches using the radio buttons on the Tool pane or by double-clicking in the size window in the status bar. 

You can also drag rules (also known as guidelines) onto the Main view. Move the mouse over one of 
the rulers and then drag down into the view. If you later want to move a rule, you can drag it . If you want 
to remove it , drag it  back onto the ruler. The View menu has an option to clear all the guidelines as 
needed. 

Magnify  

 The Magnifier on the Main toolbar will let you change the zoom in three ways after you 
click on the button:  

Å  Left-click to zoom in 

Å  Right-click to zoom out 

Å  Drag a rectangle to zoom on just that area. (This will also cancel the tool.) 

.ÏÔÅȡ 4ÈÅ .ÁÖÉÇÁÔÉÏÎ ×ÉÎÄÏ× ÃÁÎ ÁÌÔÅÒ ÔÈÅ ÚÏÏÍ ÔÏÏȟ ÁÎÄ ×ÅȭÌÌ ÃÏÖÅÒ ÔÈÁÔ ÉÎ ÉÔÓ Ï×Î ÃÈÁÐÔÅÒȢ 

Background and Grid  

   You can alter the background of the Main View. Click the Preferences button on the Main 
toolbar. This will bring up the Program Preferences window, which allows you to set many program and 

Design Page options. Click on the Grid Settings to adjust them. 

    

To change the background color, click the Color button, which will display a standard color picker: 

You can even create your own colors and add them to the custom colors section. 

Select a Custom color and click OK to set the new color. 
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Adjustments:  

Å  The Grid is adjustable too. You can alter the display of gridlines by choosing between lines and 
dots. You can also set the spacing of the grid, and that can be set separately for both metric and inch 
settings.  

Å  4ÈÅ ÁÒÒÏ× ÂÕÔÔÏÎÓȟ ÌÁÂÅÌÅÄ ȰЄЄȱ ÁÎÄ ȰЃЃȟȱ ×ÉÌÌ ÃÏÐÙ ÔÈÅ ÓÅÔÔÉÎÇÓ from inches to metric and vice 
versa. Thus, you can set up a grid that has metric spacing for machine/hoop accuracy, but can 
display information to you in inches. 

Å  Snap-to-Grid will help align objects to the grids as you move them in the Main View. As you move in 
ÏÎÅ ÄÉÒÅÃÔÉÏÎ ɉÕÐȟ ÄÏ×Îȟ ÌÅÆÔȟ ÒÉÇÈÔɊ ÔÈÅ ÅÄÇÅ ÏÆ ×ÈÁÔÅÖÅÒ ÙÏÕ ÁÒÅ ÍÏÖÉÎÇ ×ÉÌÌ ȬÓÔÉÃËȭ ÌÉËÅ Á ÍÁÇÎÅÔ 
to the grid as you approach a grid line in that direction. If you want to overcome the snap-to-grid, 
you can pass the grid and then come back in the reverse direction. (Which means the opposite edge 
will want to snap to some other grid.) 

Å  Grids do not force you to stick to them when Snap-to-Grid is on. Rather, it merely enables the snap 
as you get close, which may help with precision alignment as you move things around. 

Å  Using the menu or the Grid button on the toolbar, you can turn the Main View display of the grid on 
and off. 

Measure Size and Counts (Stitches and Colors)  

 The Measure button on the Main toolbar will set the program in a mode that allows 
you to measure items in the Main View. 

 

!Ó ÙÏÕ ÄÒÁÇ ÔÈÅ ÃÕÒÓÏÒȟ ÙÏÕ ÁÒÅ ÍÅÁÓÕÒÉÎÇ ÔÈÅ ÄÉÓÔÁÎÃÅ ÙÏÕȭÖÅ ÄÒÁÇÇÅÄȢ 4ÈÉÓ ÄÉÓÔÁÎÃÅ ÉÓ ÄÉÓÐÌÁÙÅÄ 
on the status bar: 

 

To cancel measuring, click again on the Measure button in the toolbar or click the Selection Tool 
(arrow) in the toolbar. Items that are selected also have their size, stitch count and color count shown in 
the status bar. If nothing is selected, the size and counts for the entire Design Page will be shown. 

 

Selection  

   One of the most common tasks in the Main view is to select items. Using the Selection 
Tool (Arrow button on the main toolbar) you can select and move items in the design page. Select 
ÉÔÅÍÓ ÂÙ ÃÌÉÃËÉÎÇ ÏÎ ÔÈÅÍȢ 4ÈÉÓ ×ÉÌÌ ÐÌÁÃÅ Ȭhandles and a dotted line around the selected items. 
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You can also see that items are selected by looking in the Objects view. Another way to select items 
in the Main view is to drag a rectangle around those items. Anything completely in the rectangle will be 
selected. However, if an object is grouped with something outside the rectangle, it will not be selected. 

Ghost Mode  

Ghost Mode is an option relating to how the Main View displays objects when not selected. The idea 
for Ghost Mode is to make it more obvious which objects are selected by fading out those items that are 
not selected. 

 

Left: Ghost Mode on     Right: Ghost Mode off 

 

The intensity of the Ghost Mode can be altered with the Preferences. 

Transform Controls  

Sizing and positioning of design elements can also be accomplished using the Size and Position 
controls panel located on the Tool pane. The first control on this panel sets the unit of measure for the 
design page. The choices are millimeters and inches. 

 

The width and height of a selected design element can be precisely set by entering the desired value 
in the width and height text box and pressing the enter key. If an exact size is not known, the element can 
be sized as a percentage of its original size by entering a percent value in the percent text box and 
pressing the enter key.  
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These controls are also updated as a design element is moved or re-sized using its handles. 

The element is scaled proportionally if the Scale Proportionally control is locked, otherwise height 
and width changes are applied individually.  

 

LockedɂScale Proportionally 

 

UnlockedɂScale Height and Width Individually 

Note: If you have sized an element and want to return to its original size, simply lock the Scale 
Proportionally control and enter a value of 100 in either of the percentage fields. 
Embrilliance  will remember the original size even when you reopen the design at  a 
future date.  

Mirror and Rotate  

The next four controls mirror and rotate selected elements. Mirroring is about the horizontal or 
vertical axes. Rotation is clockwise or counter clockwise in 90-degree increments with the pivot point in 
the center of the selection. Alternatively, enter a specific value for the degree of rotation. Enter a positive 
value to rotate counter-clockwise and a negative value to rotate clockwise. 

 

Centering in  the Hoop  

   Centering in the Hoop can be accomplished by this button, although it is not necessary 
because, as a rule, designs are centered when stitch files are saved.  This is also available from the 
Utility menu. 
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Align and Distribute  

 Alignment of multiple items can be set using the Align button which will open the 
Align and Distribute window. Alignment will place the edges or centers of designs all on one line. 

  

If you have two or more items selected, you can align them.  For example, these items are Aligned 
Left: 

 

Distribution is different from alignment. Distribut ion places designs equidistant across a span. This 
is useful if you want to make regular patterns, such as a tiled design. If you would like items distributed 
across an area, move the first and last items to the outside areas that you want to fill. In this example, the 
ɉÔÏÐȟ ÌÅÆÔɊ Ȭ!ȭ ÁÎÄ ÔÈÅ ɉÂÏÔÔÏÍȟ ÒÉÇÈÔɊ Ȭ!ȭ ÍÁËÅ ÔÈÅ ÄÅÓÉÇÎ ÓÉÚÅȢ "ÕÔ ÎÏÔÉÃÅ ÈÏ× ÔÈÅ Ȭ!ȭ ÄÅÓÉÇÎÓ ÂÅÔ×ÅÅÎ 
ÔÈÏÓÅ ÁÒÅ ÎÏÔ ÐÌÁÃÅÄ ÒÅÇÕÌÁÒÌÙȩ $ÉÓÔÒÉÂÕÔÅ ×ÉÌÌ ÍÁËÅ ÔÈÏÓÅ Ȭ!ȭÓ ÉÎÔÏ ÁÎ ÏÒÄÅÒÌÙ ÒÏ×ȡ 

 

5ÓÉÎÇ Ȭ#ÅÎÔÅÒȭ ÄÉÓÔÒÉÂÕÔÉÏÎ ×ÉÌÌ ÄÉÓÔÒÉÂÕÔÅ ÔÈÅÓÅ letters evenly, ÂÁÓÅÄ ÏÎ ÅÁÃÈ ÌÅÔÔÅÒȭÓ ÃÅÎÔÅÒȢ 

If you choose a different edge to distribute with, for instance, Left, then the distribution will be made 
using the left edges of all the designs. This can be useful to create a geometric composition with dif ferent 
sized designs. 
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The Design Librar ies  

The Design Library  window is used to merge Embrilliance designs into the current Design Page. 

 

The design library can have multiple catalogs, which are folder-based groups of designs, based on 
where they come from and what category they may fall into, according to the person who made them. 
You select a catalog by clicking the drop-arrow in the top, left of the program. 

Clicking on a collection icon on the left will result in the designs from that collection to appear on 
the right. To import a design, select it and click OK. You can also double-click on a design to import it and 
close the window. 

Note: In most cases, the merged Library design will be placed on the screen to fit the hoop, 
whether the hoop is displayed or not. If you have a very small hoop selected, the library 
design may be too complex to be shrunk to fit the hoop. Library designs can be resized to 
the desired proportions after placement.  

Note 2: Whenever you add any designɂwhether Library,  Lettering, or any design file ɂit will be 
ÐÌÁÃÅÄ ÉÎ ÔÈÅ ÃÅÎÔÅÒ ÏÆ ÔÈÅ ÈÏÏÐȢ )Æ ÆÏÒ ÓÏÍÅ ÒÅÁÓÏÎ ÙÏÕ ÄÏÎȭÔ ÓÅÅ Á ÎÅ×ÌÙ ÁÄÄÅÄ ÄÅÓÉÇÎȟ 
zoom out so that you can see the center of the hoop.  

Embrilliance Collections  

The collections that Embrilliance releases will show in the libraries. Some are straightforward 
ÄÅÓÉÇÎÓȟ ×ÈÉÌÅ ÏÔÈÅÒÓ ÁÒÅ )ÎÔÅÒÁÃÔÉÖÅΆ ÄÅÓÉÇÎÓȟ ÓÕÃÈ ÁÓ #ÈÒÉÓÔÍÁÓ 4ÒÁÄÉÔÉÏÎÓȢ )ÎÔÅÒÁÃÔÉÖÅ ÄÅÓÉÇÎÓ 
are combinations of design and software, made to provide unique changes to the design, resulting 
in many variations (sometimes even millions of variations). 

Alignments Library Collection  

   The alignments library collection comes with the platform in the Embrilliance 
catalog. These simple marks are used to help as visual guides when placing multiple items. 

The V and Z items are sometimes used for placing multi-hoop alignments. 

The vertical and horizontal runs can also be used as simple basting stitches. 

One alignment tool worth calling out separately is the rotation point. 
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Rotate Around a Point  

!Î ÏÂÊÅÃÔ ÎÁÍÅÄ Ȱ2ÏÔȱ ÉÓ Á ÓÐÅÃÉÁÌ ÎÁÍÅ ÉÎ ÔÈÅ 0ÌÁÔÆÏÒÍȢ 7ÈÅÎ ÉÔ ÉÓ ÓÅÌÅÃÔÅÄ ×ÉÔÈ ÏÔÈÅÒ ÉÔÅÍÓȟ ÙÏÕ 
can rotate those other items around the point. These other items can be lettering, created objects, etc. The 
rotation works like you would normally expect, except instead of rotating around the center of the 
selected objects, the center of the rotation is around the rotation object. 

The rotation object in the library is simply a StitchArtist-created circle with no stitching. It is 
included in the library for convenience and for ÔÈÏÓÅ ×ÈÏ ÄÏÎȭÔ Ï×Î 3ÔÉÔÃÈ!ÒÔÉÓÔȢ )Æ ÙÏÕ ÄÏ Ï×Î 
3ÔÉÔÃÈ!ÒÔÉÓÔȟ ÙÏÕ ÁÒÅ ÆÒÅÅ ÔÏ ÍÁËÅ ÙÏÕÒ Ï×Î ÏÂÊÅÃÔÓ ÌÁÂÅÌÅÄȟ Ȱ2ÏÔȱ ÆÏÒ ÔÈÉÓ ÐÕÒÐÏÓÅȢ 

Note: If multiple rotation objects are in the selection, the first one in the sequence is used and 
the others rotate along  as normal objects.  

Using this method of adding rotation objects, you may lay them on the page wherever you like, and 
have as many as you want. Then, different selections can be made, all referencing the single point of 
rotation. It is handy for manually making carousel or spiral design layouts. 

 

Pasting multiple copies and rotating around a point.  
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The  Stitch F iles Window  

The Merge Files Window is used to merge existing embroidery files into the current Design Page. 

 

4ÈÅ "ÒÏ×ÓÅ ÖÉÅ× ÏÎ ÔÈÅ ÌÅÆÔ ÓÉÄÅ ÉÓ ÃÁÌÌÅÄ Á Ȭ4ÒÅÅȭ ÃÏÎÔÒÏÌȟ ÁÎÄ ÉÔ ÈÁÓ Á Ȭ2ÏÏÔȭ ÌÅÖÅÌȟ ×ÈÉÃÈ ÉÓ ÌÅÆÔ-most 
ÁÎÄ ȬÂÒÁÎÃÈÅÓȭ that ÏÐÅÎ ÁÎÄ ÃÌÏÓÅ ÕÓÉÎÇ ÔÈÅ ȬϹȭ ÁÎÄ Ȭ-ȭȢ 9ÏÕ ×ÉÌÌ ÁÌÓÏ ÓÅÅ ÉÎÄÉÖÉÄÕÁÌ Ȣ:)0 ÆÉÌÅÓ ÁÓ ÂÒÁÎÃÈÅÓȟ 
so you can import designs directly from within those as well. 

/Î ÔÈÅ ÔÏÏÌÂÁÒȟ ÔÈÅÒÅ ÁÒÅ ÃÏÎÔÒÏÌÓ ÆÏÒ ÔÈÕÍÂÎÁÉÌ ÓÉÚÅ ÁÎÄ σ$ ÄÉÓÐÌÁÙȢ 4ÈÅ Ȭ#ÌÏÓÅȭ ÂÕÔÔÏÎ ×ÉÌÌ ÃÌÏÓÅ ÔÈÅ 
×ÉÎÄÏ× ×ÉÔÈÏÕÔ ÉÍÐÏÒÔÉÎÇ ÁÎÙÔÈÉÎÇȢ 4ÈÅ Ȭ3ÅÌȢ !ÌÌȭ ÂÕÔÔÏÎ ÓÅÌÅÃÔÓ ÁÌÌ ÔÈÅ ÄÅÓÉÇÎÓ ÉÎ ÔÈÅ ÖÉÅ× ÏÎ ÔÈÅ ÒÉÇÈÔȢ 

To bring designs in, ÃÌÉÃË Ȭ)ÍÐÏÒÔȭȢ 

As with most views like it in Windows, the thumbnail view on the right allows single design 
selection by clicking on an item. Select a range of designs by first selecting a design then holding the shift 
key down while clicking another design. Additionally, use the control key to click on non-adjacent 
designs. This is called a disjointed selection. 

You can also double-click on a design to import it and close the window. 

Status Bar  

 

The status bar is located at the bottom of the program window. Size, stitch count and color count 
information appear on the right side of the status bar. If you have no design selected, then the display will 
contain information about the entire design page. If you have something selected, then the information 
ÃÏÎÔÁÉÎÓ ÔÈÅ ×ÏÒÄȟ Ȭ3ÅÌÅÃÔÅÄȭ ÁÎÄ ÒÅÐÒÅÓÅÎÔÓ ÏÎÌÙ ÔÈÏÓÅ ÓÅÌÅÃÔÅÄ ÉÔÅÍÓȢ 

Double-click on the size information in the status bar to quickly switch between metric and inches 
on the design page and status bar. 

The status bar also has a line of text on the left that can provide additional information about an 
onscreen control. Hover the mouse over a control, specifically a toolbar button, and the status bar may 
provide additional clarification of what the button does. 
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Object View  

   The Object view shows the designs that have been opened or merged onto the 
Design Page and objects within those designs. 

Notice that the designs are numbered in the Object view. The designs or objects are numbered in the 
order that they have been opened or merged onto the design page. In the illustration above lettering was 
opened onto the Design Page first. So, it has been numbered 1. The following merged design is number 2 
in the sequence. When re-sequencing objects the numbers will change accordingly. 

Using the Object view designs may be selected, sequenced and deleted. The Object view can display 
individual objects within designs where allowed. Stitch files (merged embroidery designs) are one 
example of a design type that allows the display of individual objects within the ÄÅÓÉÇÎȢ #ÌÉÃËÉÎÇ ÏÎ ÔÈÅ ȬϹȭ 
at the left of the design will expand that design in the Object view. Under that design will then appear the 
individual objects. 

Using the Object view, objects may be selected, re-sequenced or deleted. 

Selecting  

 Using the Object view you can select any number of Designs or Objects, 
regardless of whether or not they are locked, hidden or grouped. This allows for editing of objects or 
designs without ungrouping. For example, the following design is all grouped so that it can be moved 
around the page as a single design. However, you may want to select just the second color to change it, re-
sequence it or even delete it. 

 

The toolbar on the Object vÉÅ× ÁÌÓÏ ÈÁÓ ÓÅÌÅÃÔÉÏÎ ÏÐÔÉÏÎÓ ÉÎÃÌÕÄÉÎÇ Ȭ3ÅÌÅÃÔ !ÌÌȭ ×ÈÉÃÈ ÉÓ ÔÈÅ first 
button on the left. If the Main view is active, you can also type Ctrl-A to select all or you can use the Edit 
menu for this option too.  

Reverse Selection  

The second button will reverse the current selection. This means that whatever you have selected 
will no longer be selected, but everything else will become selected. This is useful when you want to 
delete everything except for a single design element. 
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Range Selection  

Using the Object view you can select multiple designs or objects. If a single object is selected, use the 
shift key while clicking a second object and this will select a range of objects: Everything in between the 
two will be selected.  

Disjointed Selection  

If you use the Ctrl key while clicking on objects, you can singly select designs or objects. To de-select 
ÁÎ ÏÂÊÅÃÔ ÔÈÁÔȭÓ ÁÌÒÅÁÄÙ ÓÅÌÅÃÔÅÄȟ #ÔÒÌ-click on it. This will reverse its selected state. 

Graphical Selection  

Drag a rectangle around objects in the Object view to select whatever is in the rectangle. 

Note: Dragging enables Auto -Scroll, and your view will move allowing you to select items that 
×ÅÒÅÎȭÔ ÉÎÉÔÉÁÌÌÙ ÖÉÓÉÂÌÅȢ 

Selecting by Color  

If you want to select all objects of a given color, select one of the objects as described above. Then 
use menu option, Edit->Select by Color. This will find and select all the objects on the page that have 
those same colors in them. This is a handy feature to change the color of several things at once. 

Auto -Scroll  

 As you drag on the Object view, you may come near the top or bottom edge. This will cause the view 
ÔÏ ÓÃÒÏÌÌ ÔÈÕÓ ÅÎÁÂÌÉÎÇ ÙÏÕ ÔÏ ÄÒÁÇ ÉÎÔÏ Á ÐÏÓÉÔÉÏÎ ÔÈÁÔȭÓ ÎÏÔ ÃÕÒÒÅÎÔÌÙ ÉÎ ÖÉÅ×Ȣ 

Locking  

If you want to prevent designs or objects from being ÓÅÌÅÃÔÁÂÌÅ ÉÎ ÔÈÅ -ÁÉÎ 6ÉÅ×ȟ ÙÏÕ ÃÁÎ Ȭ,ÏÃËȭ 
them. Locking an object does not affect its grouping; it only prevents it from being clicked on. The second 
ÂÕÔÔÏÎȟ Á ×ÈÉÔÅ ÌÏÃË ×ÉÔÈ ÁÎ Ȭ8ȭ ÏÎ ÉÔȟ ×ÉÌÌ ÎÏÔ ÏÎÌÙ ÌÏÃË ÔÈÅ ÄÅÓÉÇÎ ÏÒ ÏÂÊÅÃÔȟ ÂÕÔ ×ÉÌÌ ÐÒÅÖÅÎÔ ÉÔ ÆÒÏm being 
displayed in the Main View. 

To unlock something, click the third lock, which appears as an open lock icon. 

Note: Locking does not prevent you from selecting it in the Object view, where it can be re-
sequenced, copied, or deleted. 
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Sequencing  

 The sequence of objects and designs can be changed using the Objects view. One 
way is to right-click on a selected item which will cause a pop-up menu to be displayed. That menu has 
options to move items earlier or later in the sequence. 

You can also drag and drop items in the tree to re-ÓÅÑÕÅÎÃÅ ÔÈÅÍȢ $ÒÏÐÐÉÎÇ ÁÎ ÉÔÅÍ ɉÌÅÔȭÓ ÃÁÌÌ ÉÔ Ȭ"ȭɊ 
ÏÎ ÁÎÏÔÈÅÒ ɉÃÁÌÌÅÄ Ȭ!ȭɊ ×ÉÌÌ ÐÌÁÃÅ ÔÈÁÔ ÄÒÏÐÐÅÄ Ȭ"ȭ ÉÔÅÍ ÒÉÇÈÔ ÁÆÔÅÒ Ȭ!ȭ ÉÎ ÔÈÅ ÓÅÑÕÅÎÃÅȢ )Æ ÙÏÕ ÄÒÁÇ ÁÎ ÏÂÊÅÃÔ 
onto the design icon, then that drop will be placed at the head of the design. 

Re-ÓÅÑÕÅÎÃÅ ÓÅÌÅÃÔÅÄ ÄÅÓÉÇÎÓ ÁÎÄ ÏÂÊÅÃÔÓ ÕÓÉÎÇ ÔÈÅ Ȭ3ÅÑÕÅÎÃÅ /ÂÊÅÃÔÓȭ ÃÏÍÍÁÎÄ ÏÎ ÔÈÅ %ÄÉÔ ÍÅÎÕȢ 

Deleting a Color  

Often you will want to delete a section of stitches from a design that has been merged. When those 
stitches are all grouped as one color this is easily accomplished using the Object View. Open the design 
ÕÓÉÎÇ ÔÈÅ ȬϹȭ ÉÎ ÔÈÅ ÔÒÅÅȢ .ÅØÔȟ ÓÅÌÅÃÔ ÔÈÅ ÃÏÌÏÒ ÙÏÕ ×ÁÎÔ ÔÏ ÄÅÌÅÔÅȢ .ÅØÔȟ ÃÈÏÏÓÅ Ȭ$ÅÌÅÔÅȭ ÆÒÏÍ ÔÈÅ %ÄÉÔ ÍÅÎÕ 
ÏÒ ÕÓÅ ÔÈÅ Ȭ$ÅÌÅÔÅȭ ËÅÙ ÏÎ ÙÏÕÒ ËÅÙÂÏÁÒÄȢ 

Below, the first color of the design is selected. 3ÉÍÐÌÙ ÐÒÅÓÓ Ȭ$ÅÌÅÔÅȭ on your keyboard to remove the 
first color along with the stitches associated with it. 

Note: Another way to delete is to use the menu, Edit->Delete. 

    

Left: Color is selected.    Right: Color has been deleted. 
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The Property Sheet  

 When you have design or object items selected, there may be properties that 
ÙÏÕ ÃÁÎ ÁÄÊÕÓÔȢ 4ÈÅ 0ÒÏÐÅÒÔÙ 3ÈÅÅÔ ÃÏÎÔÁÉÎÓ ÉÎÄÉÖÉÄÕÁÌ Ȭ0ÒÏÐÅÒÔÙ 0ÁÇÅÓȭ ÔÈÁÔ ÌÅÔ ÙÏÕ ÁÄÊÕÓÔ ÔÈÅ ÓÅÌÅÃÔÅÄ 
items. The pages are displayed as tabs. Click on the tab to work with the design or object items that are 
selected. 

If nothing is selected, the Property Sheet will display the Color property page, which in turn will 
show every color in the Design Page. This is a convenience that allows you to change colors on the page. 

 

 

Note: Sometimes, users will confuse the Colors property tab  with the Object View. You cannot 
select anything using the Colors property page. This page merely reflects what is selected 
and lets you change the colors on display.  

The individual tabbed pages that you see will depend on the designs and objects that you have 
ÓÅÌÅÃÔÅÄȟ ÁÎÄ ×ÅȭÌÌ ÃÏÖÅÒ ÔÈÏÓÅ ÉÎÄÉÖÉÄÕÁÌ ÃÏÎÔÒÏÌÓ ÉÎ ÔÈÅ ÒÅÓÐÅÃÔÉÖÅ ÓÅÃÔÉÏÎÓ ÆÏÒ ÔÈÅ ÄÅÓÉÇÎ ÔÙÐÅÓȠ 
Lettering, Embroidery and Library  designs. 
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Sewing  Simulator  

The Stitch Simulator lets you see how the design will sew out by sewing on the screen. It is activated 
by clicking the Stitch Simulator tool in the View tool bar or selecting Stitch Simulator from the View 
menu. 

 

Stitch Simulator controls 

  

Stitch Simulator Controls 

The controls are easy to use and give complete control of the simulated sewing process. 

 Player Control:  This control lets you sew forward, backward and stop. The right 
arrow starts sewing forward. The double bars stop sewing. The left arrow starts sewing backward. 

 

 Step Stitch Control: This control lets you sew one stitch at a time forward or 
backward. Right arrow: forward, Left arrow: backward. 

 

 Speed Control: Use the slider to change the speed of sewing. Move to the left for 
slower or to the right for faster. 

 

 Manual Control:  Click and drag this slider forward or backward to quickly move to a 
particular section of the design. 

 Insert Color Stop: Click the Stop button to insert a color stop in the design. This allows 
you to change colors on the fly. Or creatively use this to isolate parts of the design that you want to 
remove or isolate. When you inseÒÔ Á ÓÔÏÐȟ ÔÈÅ ÃÏÌÏÒ ×ÉÎÄÏ× ×ÉÌÌ ÁÐÐÅÁÒ ÔÏ ÌÅÔ ÙÏÕ ÐÉÃË ÔÈÅ ÃÏÌÏÒ ÙÏÕȭÒÅ 
changing into. Make sure you pick something different. Once you have picked a color, the Stop command 
will be inserted in the stitches at the point of the simulator, and the new color will appear in the Object 
view. 
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Preferences  

 There are a number of preferences for the program and design page that can be adjusted. 
Click on the Preferences button to reveal these controls. 

Embroidery Hoops  

In the Preference window, under Environment, you can choose a hoop. Hoops are displayed in a 
sorted list, organized by embroidery file format. Most embroidery hoops are made using the metric 
system, so the sizes for the hoops are displayed according to the way the manufacturer sells the hoop. An 
approximate size in inches is also shown. 

There are many hoops that are built into the program, and you can add your own. As the program 
ÕÐÄÁÔÅÓ ÏÖÅÒ ÔÉÍÅȟ ÏÒ ÉÆ ÙÏÕ ÈÁÖÅ ÅÄÉÔÅÄ Á ÈÏÏÐȟ ÕÓÅ ÔÈÅ Ȱ$ÅÆÁÕÌÔÓȱ ÂÕÔÔÏÎ ÔÏ ÒÅÓÔÏÒÅ ÔÈÅ ÐÒÏÇÒÁÍ ÔÏ ÔÈÅ 
hoops provided. ThÅ Ȱ$ÅÆÁÕÌÔȱ ÂÕÔÔÏÎ ×ÉÌÌ ÎÏÔȟ ÈÏ×ÅÖÅÒȟ ÒÅÍÏÖÅ ÁÎÙ ÈÏÏÐÓ ÙÏÕȭÖÅ ÁÄÄÅÄ ÙÏÕÒÓÅÌÆȢ 

Optional by product: Depending on which products are licensed, some multi-position hoops may be 
listed ɀ ÔÈÅÙ ÈÁÖÅ Ȱ-ÕÌÔÉȱ ÌÉÓÔÅÄ ÁÆÔÅÒ ÔÈÅ ÓÉÚÅȢ  $ÅÓÉÇÎÓ ×ÉÌÌ ÁÕÔÏÍÁÔÉÃÁÌÌÙ ÓÐÌÉt upon the Save and a text 
ÆÉÌÅ ×ÉÌÌ ÂÅ ÃÒÅÁÔÅÄ ×ÉÔÈ ÔÈÅ ÓÔÉÔÃÈÉÎÇ ÉÎÓÔÒÕÃÔÉÏÎÓȢ  3ÅÅ ÔÈÅ ÓÅÃÔÉÏÎ ÏÎ Ȱ-ÕÌÔÉ-ÐÏÓÉÔÉÏÎ (ÏÏÐÓȱ ÆÏÒ ÍÏÒÅ 
information. 

Many times, you will want to sew a design sideways in the hoop. But rather than laying out your 
ÄÅÓÉÇÎ ÓÉÄÅ×ÁÙÓȟ ÉÔ ÍÉÇÈÔ ÂÅ ÃÏÎÖÅÎÉÅÎÔ ÔÏ ÈÁÖÅ ÔÈÅ ÈÏÏÐ ÄÉÓÐÌÁÙÅÄ ÁÓ ÒÏÔÁÔÅÄȢ #ÈÅÃËÉÎÇ ÔÈÅ Ȱ2ÏÔÁÔÅ ωπȱ 
button accomplishes this. Double-click the hoop indicator on the status bar to rotate the hoop 90°. 

You can create hoops and edit hoops too. )Æ ÙÏÕ ÕÓÅ ÔÈÅ ×ÏÒÄȟ Ȱ2ÏÕÎÄȱ ÏÒ Ȱ/ÖÁÌȱ ÉÎ ÔÈÅ ÎÁÍÅȟ ÙÏÕÒ 
hoop will be drawn using that shape. When you create a new hoop, it will become  

the selected hoop. If you have added a hoop, or if you decide to have the program display only the 
hoops that ÙÏÕ Ï×Îȟ ÙÏÕ ÃÁÎ ÄÅÌÅÔÅ ÈÏÏÐÓ ÆÒÏÍ ÔÈÅ ÌÉÓÔȟ ÕÓÉÎÇ ÔÈÅ Ȱ$ÅÌÅÔÅȱ ÂÕÔÔÏÎȢ 

 

The width and height fields are self-explanatory, and you can name your hoop as desired. Hoop 
names should be unique. 

Note: Do not create a hoop that is bigger than the sewing field of your embroidery machine.  
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Left: Hoop selection.   Right: What a hoop looks like in the Main View. 

When you create a new hoop or modify an existing hoop, you are really defining the embroidery 
ÆÉÅÌÄȟ ÎÏÔ ÔÈÅ ÐÈÙÓÉÃÁÌ ÄÉÍÅÎÓÉÏÎÓ ÏÆ ÔÈÅ ÈÏÏÐȢ 9ÏÕ ÍÕÓÔ ËÎÏ× ÙÏÕÒ ÍÁÃÈÉÎÅȭÓ ÅÍÂÒÏÉÄÅÒÙ ÆÉÅÌÄ ÁÓ ÙÏÕ 
cannot use a hoop that is larger than what your embroidery machine can sew, unless you are creating a 
multi -ÐÏÓÉÔÉÏÎ ÈÏÏÐȟ ×ÈÉÃÈ ×ÅȭÌÌ ÄÉÓÃÕÓÓ ÓÅÐÁÒÁÔÅÌÙ ÉÎ ÔÈÅ -ÕÌÔÉ-Position Hooping section.  

Check the status bar at the bottom of the window for hoop information, which displays the selected 
hoop size whether it is vÉÓÉÂÌÅ ÏÒ ÎÏÔȢ :ÏÏÍ ÏÕÔ ÔÏ ÆÉÎÄ ÔÈÅ ÈÏÏÐ ɉÉÆ ÉÔ ÉÓÎȭÔ hidden by your design). 

.ÏÔÅȡ )Æ ÙÏÕÒ ÐÒÏÇÒÁÍ ÉÓ ÌÉÃÅÎÓÅÄ ÔÏ ÕÓÅ ÉÔȟ ÔÈÅÒÅ ÉÓ ÏÎÅ ÈÏÏÐȟ ÔÈÅ Ȣ0%3 *ÕÍÂÏ ρτȱ ÈÏÏÐȟ ÉÓ ÓÈÏ×Î 
in both the Normal and Multi -Position section of the Hoop Preference. Using eith er 
selection will create the correct file for use with this hoop, however, the Normal version 
displays it as a single sewing field, and the Multi -Position version shows both fields in 
use. 

Graphics Scale / Calibrat ion  

The Main View is calibrated to a real-world scale for precise display of designs. Use the Preferences 
Window to calibrate your display for real-world size: 

 

Hold a ruler up to your screen and adjust the slider until the measurement in the program matches 
your real-world ruler. This will help you better estimate real design size while editing designs. 

When digitizing, using a multiple of a real-world scale is very productive. If you operate at a set of 
scales that are consistent (typically 3x and 6x) then you will not be tempted to add extra nodes along 
your outline, and you can ignore details in the image you are digitizing which would be too small to 
digitize effectively. 

The DPI set by this calibration is also used to other graphics within the program to display at a 
useable size. High-DPI systems like 4K laptops can make images appear very small without this. 
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On this property ÐÁÇÅ ÔÈÅÒÅ ÉÓ ÁÎ ÁÄÄÉÔÉÏÎÁÌ ÓÃÁÌÅ ÃÁÌÌÅÄ Ȭ(ÁÎÄÌÅ 3ÉÚÅȭȢ 4ÈÅ ÈÁÎÄÌÅÓ ÁÒÅ ÔÈÅ ÇÒÁÐÈÉÃÓ 
you place the mouse over on the main view so you can drag: Sizing, rotating, outline nodes, etc. It will also 
adjust the size of the rulers at the top and left of the screen. The handles will scale with the main 
calibration, but this slider allows you to increase/decrease the size of those handles. This can be useful to 
accommodate small displays, accessibility issues, hi-res monitors, etc. 

 

Handle sizes can be varied depending on preference, monitor, etc. 

The Mouse Wheel  

The Mouse Wheel can be used to zoom the Main View. It can also be used to scroll the page up and 
down. We recommend that you use the setting that allows for zooming as this is more useful to most 
users. The Zoom and Pan feature will center the view at the point of the cursor while zooming. 

 

Auto Recover  

Auto recover will save your file in a separate space every so often. This is adjusted using the slider. 
This feature is useful when working on a complex arrangement where a power outage or program crash 
(unlikely) or freeze by the operating system (it happens) could force the program to quit and you might 
lose your work. If you are working while power-outs are happening, well, turn this on. Please ÄÏÎȭÔ ÒÕÎ 
your embroidery machine when the power is unreliable, as brown-outs are not good for them. 

Check ing  for  Updates  

The program can check for updates if it is running on a system connected to the internet. This will 
occur once each day, the first time that you run the program. The program does not send your 
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information or anything about you or your computer to us. It merely checks the current version available 
ÏÎÌÉÎÅ ÆÏÒ ÙÏÕÒ ÐÒÏÇÒÁÍ ÁÎÄ ÉÆ ÔÈÅÒÅȭÓ ÁÎ ÕÐÄÁÔÅȟ ÉÔ ÌÅÔÓ ÙÏÕ ËÎÏ×Ȣ )Æ ÙÏÕ ÄÏÎȭÔ ×Ánt this, you can turn this 
off. 

You can also check for updates at any time from the option in the Help menu. 

Preferred Stitch Format  

Most embroiderers have one machine or other that they use most for embroidery and that machine 
has a format that it uses. To save time, the format that you choose here will automatically be selected 
during the save. 

 

Note: Even though you have set a preferred format, you can still choose File > Save Stitch File As 
if you need to occasionally save in a dif ferent format. After selecting a new format in the 
Ȭ3ÁÖÅ !Óȭ ÄÉÁÌÏÇ ÂÏØ ÔÈÁÔ ÆÏÒÍÁÔ ×ÉÌÌ ȰÓÔÉÃËȟȱ overriding  the Preferred Stitch Format until 
you either reselect the preferred one or select a new one. 

Note about SHV: Setting the preferred format to SHV do es not create the file structure your 
machine may expect to see. To create a proper Designer 1 diskette or stick, please read 
the section on Creating A Designer 1 Disk or USB Stick.  

File Conversion  

Designs can be saved into many different formats. The Conversion Preference allows you to adjust 
some parameters when you save in those different formats. 

 

The file format itself may have inherent limitations on the number of colors or stitches, such as the 
16-color limit in .PCS. But there are also machine limitations too. Older machines that use the .PES format 
had limits of 100 colors, whereas the newer ones can go to 127. To help you save files correctly for your 
machine, there are options for some formats, such as .PES. 

PES Files have to support two distinct machine types, and also have different data for the support of 
card reader/writers that ÍÁÎÙ Ȣ0%3 ÍÁÃÈÉÎÅÓ ÒÅÑÕÉÒÅÄȢ ,ÅÔȭÓ ÌÏÏË ÁÔ ÔÈÅ Ȣ0%3 ÏÐÔÉÏÎÓ ÍÏÒÅ ÃÌÏÓÅÌÙȢ 

Ȱ5ÓÅ ÖÅÒÓÉÏÎ υ ÁÎÄ ÌÁÔÅÒ ÆÏÒ ÒÅÁÌ ÔÈÒÅÁÄÓȢȱ 4ÈÉÓ ÓÅÔÔÉÎÇ ÅØÉsts because the version 5 of the Palette/PE-
Design software, which invented the .PES file, added support for real thread colors. This was a wonderful 
addition for this format. However, if you own an earlier version of the software, and you want to use files 
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created in Embrillianceȟ ÔÈÅÎ ÙÏÕ ÎÅÅÄ ÔÏ ÌÅÁÖÅ ÔÈÉÓ ÓÅÔ ÔÏ Ȱ&ÏÒÃÅ ÖÅÒÓÉÏÎ ρȢȱ 4ÈÅ ÒÅÁÓÏÎ ÉÓ ÓÉÍÐÌÅȡ 4ÈÅ ÏÌÄ 
software simply cannot open those version 5 files. 

The machine specific settings are for machines like the Ellegante, which takes the 180 x 300 hoop 
(while other machines may not be able to accept this hoop, so why write a file for it.) Or the multi-needle 
machines that have their embroidery field rotated to a landscape position. So, a 200x300 or a 300x200 
field, while technically the same size, have different rotational parameters. 

Certainly, you know if you have a multi-needle machine, or require the use of older software to 
write your card. If not, or if you are distributing these designs, please just leave the settings as-is. The 
program actually finds a Lowest Common Denominator in the format that it will output, making the file 
available to the widest range of users. 

 

DST Options are different 

DST and EXP Files have a different type of information contained in them where it pertains to jump 
stitches. Rather, those formÁÔÓ ÈÁÖÅ ÔÏ ÈÁÖÅ ÓÏÍÅ ÎÕÍÂÅÒ ÏÆ Ȱ*ÕÍÐȱ ÃÏÍÍÁÎÄÓ ÉÎ Á ÒÏ× ÂÅÆÏÒÅ ÔÈÅÙ ×ÉÌÌ 
cycle their thread trimmer. When making a DST file, and converting from something else, these jump 
commands need to be translated. As machines differ in setup for the number of commands needed to 
cycle the trimmers, we offer this setting in the conversion preferences. 

DST files also have the ability to place themselves anywhere in the hoop. By default, the program 
will center designs when opening and saving, however users of commercial machines may require this to 
ÂÅ ÔÕÒÎÅÄ ÏÆÆȢ 5ÓÅ ÔÈÅ ÃÈÅÃËÂÏØÅÓ Ȭ#ÅÎÔÅÒ ÏÎ ÏÐÅÎȭ ÁÎÄ Ȭ#ÅÎÔÅÒ ÏÎ ÓÁÖÅȭ ÆÏÒ ÔÈÉÓ ÐÕÒÐÏÓÅȢ 

Some commercial embroidery machines do not automatically return the needle to the start of the 
design. The option Return to Origin will add these commands to the end of a DST file. 

Jumps / Overlaps  

There are several operations that occur during the process of saving a stitch file.  
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4ÈÅ Ȭ2ÅÍÏÖÅ ÏÖÅÒÌÁÐÓȣȭ ÓÅÔÔÉÎÇȟ ÂÅÔÔÅÒ ËÎÏ×Î ÁÓ Ȭ2ÅÍÏÖÅ (ÉÄÄÅÎ 3ÔÉÔÃÈÅÓȭ ÏÒ Ȭ2(3ȭ ×ÉÌÌ ÌÅÔ ÔÈÅ 
program run a process to remove stitches in one design that will be hidden by another design. This does 
not affect objects within a design, as those would naturally be hidden or not, as digitized. 

Removing overlaps allow you to merge designs onto the page with them touching or overlapping 
each other. This operation is common in graphics, but stitches are not graphics. Adding one design on top 
of another will cause excess density and can break needles, ruin projects and all the accompanying 
misery that comes with it. By removing those hidden stitches, using our patented method, you will find 
that your composition sews without the density headaches. 

Overlapped appliques are even harder for software to handle. Where layering in stitches is a 
concern, layering of applique fabric has extra considerations. The program has color settings where the 
user can tell it that a certain color is a specific applique step. With this information, the program can 
avoid performing RHS on appliques, as necessary. 

Jump stitches are created when, within a single color, the needle must travel across the design 
without sewing stitches. Jumps are normally trimmed by hand or machine. Sometimes there are merged 
designs which have jumps that the digitizer assumes will not be cut, such is the case with many 
ÃÏÍÍÅÒÃÉÁÌ ÄÅÓÉÇÎÓȢ 7ÈÅÎ ÔÈÅ ÄÉÇÉÔÉÚÅÒ ÄÅÃÉÄÅÓ ÎÏÔ ÔÏ ÃÕÔ ÔÈÅ ÊÕÍÐȟ ÔÈÅÙ ÄÏÎȭÔ ÕÓÕÁÌÌÙ ÌÅÁÖÅ Á ÔÉe-off 
stitch, which prevents the thread from unravelling after the jump gets cut. 

Ensuring that there are tie-offs on either side of a jump will allow you to cut those jumps even if the 
ÐÅÒÓÏÎ ÄÉÇÉÔÉÚÉÎÇ ÔÈÅ ÄÅÓÉÇÎ ÈÁÄÎȭÔ ÐÌÁÎÎÅÄ ÆÏÒ ÉÔȢ 

Jumps have other parameters, usually concerning commercial embroidery.  For instance, an 
embroiderer may prefer to hand trim, or have the option to hand trim, small jumps. In commercial 
embroidery, these are often left untrimmed. 

Sometimes jumps are short enough that the machine can place a stitch or two instead of jumping. 
4ÈÉÓ ÐÒÏÃÅÓÓȟ ÃÁÌÌÅÄȟ ȰÎÅÓÔÉÎÇ Á ÓÔÉÔÃÈȟȱ ÓÁÖÅÓ ÔÈÅ ÍÁÃÈÉÎÅ ÏÐÅÒÁÔÏÒ ÔÉÍÅ ÂÙ ÎÏÔ ÈÁÖÉÎÇ ÔÏ ÃÕÔ ÁÎÄ ÎÏÔ 
ÈÁÖÉÎÇ ÔÈÅ ÍÁÃÈÉÎÅ ÃÕÔȟ ×ÈÉÃÈ ÔÁËÅÓ ÍÁÎÙ ÓÅÃÏÎÄÓȟ ÃÕÔÔÉÎÇ ÐÒÏÄÕÃÔÉÏÎ ÅÆÆÉÃÉÅÎÃÙȢ 4ÈÅ ÓÅÔÔÉÎÇȟ Ȱ2ÕÎ when 
ÊÕÍÐÓ ÁÒÅ ÓÍÁÌÌȱ ÁÌÌÏ×Ó ÙÏÕ ÔÏ ÓÅÔ ÔÈÅ ÓÉÚÅ ÏÆ Á ÊÕÍÐ ÔÈÁÔ ÍÁÙ ÂÅ ÎÅÓÔÅÄ ×ÉÔÈ ÓÔÉÔÃÈÅÓ ÁÎÄ ÔÈÅ Ȭ2ÕÎ ÓÔÉÔÃÈ 
ÌÅÎÇÔÈȭ ÃÏÎÔÒÏÌÓ ÈÏ× ÍÁÎÙ ÎÅÓÔÅÄ ÓÔÉÔÃÈÅÓ ×ÉÌÌ ÂÅ ÃÒÅÁÔÅÄȢ ! ÓÈÏÒÔ ÒÕÎ ÓÔÉÔÃÈȟ ÓÕÃÈ ÁÓ ρȢπÍÍȟ ÏÒ ÅÖÅÎ 
smaller, will nest well in most fabrics, bÕÔ ÙÏÕ ÄÏÎȭÔ ×ÁÎÔ Á ÌÏÎÇ ÒÕÎ ÏÆ ÓÍÁÌÌ ÓÔÉÔÃÈÅÓȟ ×ÈÉÃÈ ÉÓ ×ÈÙ ÔÈÅ 
Ȭ-ÉÎÉÍÕÍ *ÕÍÐ ,ÅÎÇÔÈȭ ÐÁÒÁÍÅÔÅÒ ÉÓ ÔÈÅÒÅȢ 

View Options  

The View menu has several options including the ability to reset the window placement. This is 
ÕÓÅÆÕÌ ÉÆ ÙÏÕȭÖÅ ÒÅÓÉÚÅÄ ÔÈÉÎÇÓȟ ÏÒ ÃÌÏsed your properties view or anything similar. 

About this Page will show you all the font usage, size and stitch counts, all notes and other details 
from every design on the page. You can copy this text and use it in a word processor or note/text editor if 
you like, to keep it for use with a project. 

Jumps is an option on the View menu to see jumps as a dotted line when the file transits from one 
object to another. When viewing jumps in StitchArtist you will see a red dashed line, which calls out 
possible missing travel runs. 
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Color  

 Color is surprisingly  influential. We may be initially attracted to or repelled by 
an item or design simply because of its color. The ability to view designs in realistic thread colors is an 
asset to the embroiderer.  

You may want to recolor a design to better suit your tastes, to coordinate with the threads you have 
ÉÎ ÙÏÕÒ ÓÔÁÓÈȟ ÏÒ ÔÏ ÃÏÌÏÒ Á ÄÅÓÉÇÎ ÔÈÁÔ ÙÏÕȭÖÅ ÃÏÎÖÅÒÔÅÄ ÆÒÏÍ Á ÆÏÒÍÁÔ ÔÈÁÔ ÄÏÅÓÎȭÔ ÈÏÌÄ ÃÏÌÏÒ ÓÅÔÔÉÎÇÓȟ 
such as .DST. 

When you merge a Library  design, create a lettering design, or merge a stitch file, the objects come 
in with the colors and the thread brand that the designer has assignedɂeven if you have another brand 
specified as preferred (more on that in a bit).  

If the merged stitch file is a .DST file or other format that does not hold set colors, then threads 
cannot be matched to any thread brand and will simply be a list of generically named colors. 

Tip: )Æ ÙÏÕȭÄ ÌÉËÅ ÔÏ ÇÅÔ ÁÎ ÉÄÅÁ ÏÆ ÈÏ× ÙÏÕÒ ÄÅÓÉÇÎ ÌÏÏËÓ ÏÎ Á ÐÁÒÔÉÃÕÌÁÒ ÃÏÌÏÒȟ ÙÏÕ ÃÁÎ ÃÈÁÎÇÅ ÔÈÅ 
background of your main window in Environment -> Grid Settin gs in the Program 
Preferences.  

Changing colors is done via the Color tab on the Property Sheet, which is the lower panel on the 
right -hand side of your screen. The color tab displays the thread sequence of the design. Selecting a color 
Ó×ÁÔÃÈ ÏÎ ÔÈÅ ÔÁÂ ÄÏÅÓÎȭÔ ÓÅÌÅÃÔ ÁÎÙÔÈÉÎÇ ÉÎ ÔÈÅ ÄÅÓÉÇÎȠ ÉÔ ÓÉÍÐÌÙ ÁÌÌÏ×Ó ÙÏÕ ÔÏ ÓÅÌÅÃÔ ÁÎÄ ÁÐÐÌÙ Á 
different color from any of the thread brands loaded into the program. 

When first getting acquainted with Embrilliance, it may be confusing to see what looks like two 
color lists. The top list shows a tree-like structure of all the various objects in the current main window. 
This includes Library  designs, letters, and any merged files. In the sample shown below, a single design 
has been merged and the design has been opened in the objects panel so that all the various objects can 
be viewed. 

Because this is a stitch file, each object is all the stitches that are contained within a given color. In 
this instance, when you ÃÏÍÐÁÒÅ ÔÈÅ ÏÂÊÅÃÔ ÌÉÓÔ ÎÅØÔ ÔÏ ÔÈÅ ÃÏÌÏÒ ÌÉÓÔȟ ÙÏÕȭÌÌ ÓÅÅ ÔÈÁÔ ÔÈÅÙ ÍÁÔÃÈȢ &ÏÒ 
example, object 1:6 corresponds to color number six in the following samples.  
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The color tab shows the colors of the currently selected object(s). If nothing is selected, the list 
shows all the colors on the current design page. Select areas of your design by clicking them in the object 
list. Select more than one area by holding down the Ctrl Key.  

     

The colors list only shows the colors of the selected items. 

Thread Brand and Color  

There are three buttons across the top of the Color properties tab: 

Å  4ÈÒÅÁÄȣ Select a thread library to use and set a preferred thread brand 

Å  ρ #ÏÌÏÒȣ Make the design monochromatic (one color) 

Å  Preferred  Change the colors to the closest match in your preferred thread brand 

To change a thread color, simply click on the color swatch that you wish to change on the Color tab. 
The Thread palette will open with the color selected in the original thread brand specified by the 
designer. You can select a different thread line from the drop-down menu and the program will find the 
closest match in that chosen thread line. 
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Embrilliance includes a wide range of popular thread brands and lines. 

Note: In the case of a DST, TAP or EXP file, the Color tab displays a list of generic color names. 
This is because these formats have no color information in them. Using Embrilliance you 
can color these designs, and when you save the working file, the colors will be saved 
there in . 

Similarly, PCS, PCM and HUS formats have limited color palettes. Again, saving the working file will 
preserve your colorization, and you can print colorized design templates and color information. This is 
especially handy for commercial embroiderers. 

Clicking one of these color swatches will open the thread brand that you have set as preferred 
(Madeira Thread Chest is the default). To change the color, navigate to the desired color and click OK. 

 

 .DST file shown with generic colors and the thread palette displayed. 

Some thread lines only have thread numbers, while others have numbers and color names. You can 
search either line by thread number but you can only search by name if the threads have color names. 
4ÙÐÅ ÉÎ ÔÈÅ ÃÏÌÏÒ ÏÒ ÔÈÒÅÁÄ ÎÕÍÂÅÒ ÉÎ ÔÈÅ ÓÅÁÒÃÈ ÂÏØ ÁÎÄ ÃÌÉÃË Ȭ'ÏȢȭ /Òȟ ÙÏÕ ÃÁÎ ÓÉÍÐÌÙ ÓÃÒÏÌÌ ÔÈÒÏÕÇÈ ÔÈÅ 
list and pick one that appeals to you. Once the color is selected, click OK to apply it and close the Thread 
palette. 
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Threads can be searched by number or name. 

4ÈÅ Ȭ4ÈÒÅÁÄȣȭ ÂÕÔÔÏÎ ÁÌÌÏ×Ó ÙÏÕ ÔÏ ÃÈÁÎÇÅ ÔÈÒÅÁÄ ÂÒÁÎÄÓ ÏÒ ÔÏ ÓÅÔ Á ÐÒÅÆÅÒÒÅÄ ÂÒÁÎÄ ÂÙ ÃÈÏÏÓÉÎÇ Á 
thread brand from the drop-down list. Once a preferred brand is selected, you can easily change all of the 
colors in any design to your preferred brand by clickingȟ ȰUse this as my preferred brand.ȱ  

 

A thread brand can be selected on a per-design basis or can be made preferred. 

Note: Be advised that while this may be convenient for you, if your design has carefully chosen 
and blended colors, converting brands may cause a less than desirable result ɂespecially 
ÉÆ Á ȰÃÌÏÓÅ ÍÁÔÃÈȱ Äoes not exist in the new brand.  

 

Left: Original Hemingworth colors.  Right: Shown using Brother Flesh Tones. 

The color list does not name the areas that are colored. For example, suppose you want to change 
the pink shorts on the mouse design to blue. An easy way to do this is to find the area in the Object panel 
and select it. The color is now isolated in the Color panel and you can easily click it and select a blue. 
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Coloring Letters  

Coloring Letters works a bit differently. To color individual letters, click on the center of the letter to 
select it. Then, as before, click the color swatch to select a new thread color. 

 

Selecting by Color  

There a couple ways to select by color.  

1.) The edit menu has Select by Color which will use the colors of any selected objects 
and select all other objects that are colored with those colors. 

2.) Right-click the color chip and chose Select Object. This is useful when there are a large 
number of objects on the page and you want to easily find and select one or a few 
based on color. 

Changing  a color on the page  

7ÈÅÎ ÙÏÕ ÈÁÖÅ ÍÁÎÙ ÏÂÊÅÃÔÓ ÏÎ ÔÈÅ ÐÁÇÅȟ ÙÏÕ ÍÁÙ ×ÁÎÔ ÔÏ ÃÈÁÎÇÅ Á ÃÏÌÏÒ ÔÈÁÔȭÓ ÉÎ ÕÓÅ ÂÙ ÍÁÎÙ 
objects. Right-click on the color and choose Change Color on Page. 
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Keep color S top  

When there are successive objects that have the same color, normally the embroidery machine will 
not stop. Where is it useful, for instance when doing applique on a multi-needle machine, you may want 
to instruct the machine to stop, but not switch colors. Right-click the color chip and select Keep Stop. 

 Applique settings  

Colors can be assigned to applique steps. This setting instructs the program how to interact with the 
stitches in processes such as color sort or when removing hidden stitches. Applique positions will not 
ÈÁÖÅ ÔÈÅÉÒ ÓÔÉÔÃÈÅÓ ÒÅÍÏÖÅÄȢ !ÐÐÌÉÑÕÅ ÍÁÔÅÒÉÁÌ ÓÔÅÐÓ ÉÎÄÉÃÁÔÅ ÔÈÁÔ ÔÈÅÒÅȭÓ ÆÁÂÒÉÃ ÔÈÁÔ ÈÁÓ ÂÅÅÎ ÌÁÉÄ ÄÏ×Îȟ 
which will cover other things, not just where the stitching exists. Also, stopping the machine during 
applique is necessary, so if you color sort the file, the applique setting helps the color sort system add 
flags to keep the stops. 

Thread Weight  Overview  

-ÏÓÔ ÔÈÒÅÁÄ ÆÏÒ ÅÍÂÒÏÉÄÅÒÙ ÈÁÓ Á ÔÙÐÉÃÁÌ Ȱ7ÅÉÇÈÔȱ ÏÆ ȰτπȱȢ 7ÈÁÔȭÓ ÔÈÉÓȩ 7ÅÌÌȟ ÉÔ ÃÏÍÅÓ ÆÒÏÍ the old 
Japanese manufacturer GunzeȭÓ numbered naming system for their thread (ex: #40), and the USA 
adopted an incorrect version of it , probably due to translation error, calling all threads by weight (ex: 40 
wt.). Outside the US, the numbers are commonly sold using different systems. 

Imagine if you will, being a thread maker. You need to buy the stuff to make your thread: cotton, silk, 
etc. You buy that stuff by weight, so it makes sense to sell your thread by weight too. And the idea that 
you have 1 gram of silk making up 100 meters of thread, gives your customers an insight into how thin, 
and how valuable, your thread is. Hence silk thread is often sold as 100wt. 

Man-made material is measured similarly, but using the term Denier, which is the weight of 9,000 
ÍÅÔÅÒÓ ÏÆ ÔÈÒÅÁÄȢ )Æ ωȟπππ ÍÅÔÅÒÓ ×ÅÉÇÈÓ ρςπ ÇÒÁÍÓȟ ÔÈÁÔȭÓ ρςπ $ÅÎÉÅÒ ÔÈÒÅÁÄȢ 

It would make sense if there was a common numbering system, and there is, called Tex (1,000m/g), 
ÂÕÔ ÉÔ ÉÓÎȭÔ ÁÓ ÐÏÐÕÌÁÒ ÉÎ ÕÓÅȢ  

In embroidery, the traditional thread is rayon, and the 40-weight common thread is made by taking 
2 thinner threads of 120 denier thickness, and winding them together. That makes the thread thick 
enough to embroider with a 75/11 needle and a .4mm density. When the makers of polyester began 
making embroidery thread, they approximated the rayon by using three pieces of 50 wt. thread wound 
together. Often, ÙÏÕȭÌÌ ÓÅÅ ÔÈÉÓ ÁÓ υπȾσ ÏÎ Á ÓÐool. (Realize that 50/3 is 50% more than 50/2!) 

"ÕÔ ÎÏÎÅ ÏÆ ÔÈÅ ÓÙÓÔÅÍÓ ÁÃÔÕÁÌÌÙ ÁÄÄÒÅÓÓ ÔÈÒÅÁÄ ÔÈÉÃËÎÅÓÓ ÄÉÒÅÃÔÌÙȢ 7Å ÃÁÎȭÔ ÔÅÌÌ ÙÏÕ ×ÈÙȟ ÏÔÈÅÒ ÔÈÁÎ 
ÔÈÁÔ ÔÈÅ ÔÈÒÅÁÄ ÍÁËÅÒÓ ÁÒÅÎȭÔ ÔÈÒÅÁÄ ÕÓÅÒÓȟ ÁÎÄ ÔÈÅ ÔÈÒÅÁÄ ÕÓÅÒÓ ÕÓÅ ÔÈÅÉÒ ÆÉÎÇÅÒÓ ÔÏ ÆÅÅÌ ÉÔȢ 

You will notice that on some threads the thread weight is part of the name. This is important, as the 
program assumes a normal thickness (A.K.A. #40) ÂÕÔ ×ÉÌÌ ÒÅÁÄ ÔÈÅ Ȱ×ÔȢȱ ÏÆÆ ÔÈÒÅÁÄ ÎÁÍÅÓ ÁÎÄ ÁÄÊÕÓÔ 
things such as short-stitching in native objects. More on that can be found in the section on the Thread 
Utility.   
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Printing  

A design template showing the design at full size and with registration marks can be printed. Just 
choose print from the File menu. 

 

On the left are common options for printing templates. This includes 3D and crosshairs that mark 
the center of the design for hoop placement. Also, you can choose not to print design information (Design 
Only). 

Applique printing with Essentials and StitchAr tist  

Several options have been included for use with Applique. See the Applique section for images and a 
description of using the Applique. 

Ȭ3ÅÌÅÃÔÅÄ #ÏÌÏÒÓ ÏÎÌÙȭȟ ÃÁÎ ÂÅ ÕÓÅÄ ×ÉÔÈ ÍÁÃÈÉÎÅÓ ÔÈÁÔ ×ÉÌÌ ÓÃÁÎ ÁÎÄ ÃÕÔ. By printing only an outline 
you could make it easier for those machines to scan the shape you need. 

When printing an applique for hand-ÃÕÔÔÉÎÇ ÙÏÕ ÐÒÏÂÁÂÌÙ ×ÁÎÔ ÔÏ ÔÕÒÎ ÔÈÅ Ȭ0ÒÉÎÔ !ÐÐÌÉÑÕÅ /ÕÔÌÉÎÅȭ 
mode on so that you have a clean dark line to cut on.  

4ÈÅ Ȭ0ÒÉÎÔ 3ÔÉÔÃÈÅÓȭ ÏÐÔÉÏÎ may be turned off to print a background image, for use with creating a 
photograph as an applique via printable fabric or transfer fabric. There, you want to print the image, not 
the stitches that will be applied over top. 

Ȭ0ÒÉÎÔ !ÐÐÌÉÑÕÅȭ ÉÓ Á ÓÅÔÔÉÎÇ ÔÈÁÔ ÔÕÒÎÓ ÏÎ ÐÒÉÎÔÉÎg of a selected Simulated Fill or photograph (on the 
applique tab of the Color Window.)  

 Ȭ-ÉÒÒÏÒȭ ÉÓ ÕÓÅÆÕÌ ÆÏÒ ÔÒÁÎÓÆÅÒ ÐÁÐÅÒ ÁÓ ÔÈÅ ÉÍÁÇÅ ×ÉÌÌ ÂÅ ÒÅÖÅÒÓÅÄȢ 

Other Printing Options  

Ȭ0ÒÉÎÔ #ÏÌÏÒ 3ÅÑÕÅÎÃÅȭ ÁÄÄÓ Á ÓÅÐÁÒÁÔÅ ÐÁÇÅ ×ÉÔÈ ÁÌÌ ÔÈÅ ÃÏÌÏÒÓ. See the following images: 



Lettering  

45

 

The template can be previewed before sending the output to the printer. Below is a sample template 
with a monogram surrounded by a frame. Note the registration marks. 

 

The second page of the worksheet displays size, stitch and color counts, and a list of the colors used 
in the design with approximate thread requirements. 

 

Printing preferences, found in the Program Preferences window. 

 

Lettering  

 Creating a simple letter design or monogram is, well, simple! Just click the Create Letters 
tool found on the Design Toolbar. This action will place the new lettering in the center of the design page 
and display the Letters Property tab. 

 
Design Toolbar 

Types of Lettering  

The Embrilliance platform supports two types of lettering: 
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1.) Built -in Fonts 
2.) Stitch file collections (Imported Fonts) 

The built-in fonts are based on our software, and offer many features, and are available in 
purchased products, such as Essentials or Font Collections. 

Stitch File collections are those brought in as a .BX file which installs a font from an outside 
digitizing source, such as a font provider on the internet. Stitch File fonts also can be created using our 
AlphaTricks product. When using a stitch-file font, your ability to re-size it will depend on what products 
you have licensed. AlphaTricks and Essentials will both let you re-size the fonts and recalculate their 
stitches, whereas the free Express Mode will not. 

This manual section will present the basics of manipulating lettering, which works nearly identical 
regardless of which font type you are using. 

About Built -in  Fonts  

If you have a product with built-in fonts, the program gives you significant control over them. The 
speÃÉÆÉÃÓ ÖÁÒÙ ÄÅÐÅÎÄÉÎÇ ÏÎ ×ÈÉÃÈ ÌÅÔÔÅÒÉÎÇ ÓÔÙÌÅ ÙÏÕȭÒÅ ÕÓÉÎÇȟ ÂÕÔ ÉÎ ÇÅÎÅÒÁÌȟ ÙÏÕ ÃÁÎ ÁÄÊÕÓÔ ÔÈÅ ÆÏÎÔȟ 
color, size, aspect, center, rotation, mirroring, slant, kerning, layout, stagger, sequence, envelope shape, 
stitching properties including density, underlay, underlay density and compensation (which can be used 
to increase boldness) for the design as a whole. Furthermore, you can adjust the color, size, position, 
rotation, kerning, aspect and mirroring down to the individual letter. You can adjust the letter sequence 
for Monograms so that letters may overlap exactly how you want them. And if you do overlap your letters 
within a Monogram, the hidden stitches are automatically removed for you so that the design sews out 
nice and flat. For fast and easy Monogram setup, you have 14 Quick Styles to layout your design, including 
Vertical, Square, Oval and Diamond. 

When sizing letters, your letters automatically switch to a fill-like satin stitch. This looks like a fill, 
but unlike a fill, the stitches maintain the beauty of the curved satin column. Another benefit of this is that 
fonts can be made far larger than ordinary embroidery fonts - some as tall as 8ȱ. 

To make the fonts even more versatile in size, automatic adjustments are made for you to help the 
letters sew in a smaller size than they would in other programs. For instance, when you make the letters 
smaller, narrow satin stitching is automatically adjusted to keep long-enough stitches to actually sew. 
Although some small designs look good on screen, they wÏÎȭÔ ÅÍÂÒÏÉÄÅÒ ×ÅÌÌȢ 4ÈÅ ÆÏÎÔÓ ÉÎ the program 
protect your stitching automatically. 

Multi -Line text offers line spacing options. Circle Text lets you keep on typing, right into a spiral! 

The platform can further be extended by adding font and design packs, now available from your 
favorite digitizer, sewing machine dealer or online at http://www.Embrilliance.com . 

Monograms vs. Letters  

Traditionally, monograms were a single letterɂ ȰÍÏÎÏȱ ÍÅÁÎÉÎÇ ÏÎÅ ÁÎÄ ȰÇÒÁÍȱ ÒÅÆÅÒÒÉÎÇ ÔÏ ÔÈÅ 
letter. Today most monograms are three-letter combinations with the center letter larger than the outer 
two.  

&ÏÎÔÓ ÏÒ ÌÅÔÔÅÒÓ ÓÔÙÌÅÄ ÓÐÅÃÉÆÉÃÁÌÌÙ ÆÏÒ ÓÕÃÈ ÍÏÎÏÇÒÁÍÓ ÁÒÅ ÐÒÅÆÉØÅÄ ×ÉÔÈ Ȱ-'-ȱ ÔÏ ÄÉÓÔÉÎÇÕÉÓÈ ÔÈÅÍ 
easily from more standard fonts. Of course, you can make a monogram with any font style and use the 
enveloping features to shape the design. 

http://www.embrilliance.com/
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Monogram using MGM Diamond 

 

Monogram Properties on the Single Line Page 

Now, set the monogram to your desired value by typing into the Text box and pressing 
ÔÈÅ Ȭ%ÎÔÅÒȭ ËÅÙȢ 

 

Selecting Letter Type  

!ÌÔÈÏÕÇÈ ÔÈÅ ÆÏÎÔÓ ÐÒÅÆÉØÅÄ ×ÉÔÈ Ȱ-'-ȱ ÁÒÅ ÄÅÓÉÇÎÅÄ ÆÏÒ ÔÒÁÄÉÔÉÏÎÁÌ ÔÈÒÅÅ-letter monograms, you 
are by no means restricted to three letters. For example, if you just want the large center letter, enter a 
space and the character you want. 

 

Type a space before a letter for a large single letter 



The Embrilliance Platform  

48 

For fun, you can use a monogram font with entire words. This method works best with all capital 
letters and fairly short words. 

 

Sample above uses MGM Rounded applied to a word. 

Overlapping letters are sometimes needed for your design, and when you do that within a lettering 
object, the stitches that are hidden get removed automatically: 

 

Customize the Design  

The Letters Property tab provides a number of tools that allow the design to be customized. 

There are three basic styles for lettering: 

Å   Multi -Line Text 

Å  Single line of text or Monograms 

Å  Text on a Circle 

The lettering design can switch between these styles using the three buttons at the top of the 
property tab as shown above. 

Multi -Line Text is useful when you want to enter an entire saying, poem, etc. 
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Single line of text or Monograms is useful for entering a single line of text or a Monogram. With a 
single line of text there is more flexibility in the shape such as the enveloping feature. With Monograms 
there are some fun Quick Styles that re-shape the 3-letter monogram and when overlapping the 
monogram letters, the Sewing Order finishes the look. 

Circle Text wraps lettering around a circle. If you overflow the number of letters that can fit on the 
circle, you will see your text spiral outwards. To see the text on a circle, you will have to adjust the 
Ȭ2ÁÄÉÕÓȭ ÏÆ ÔÈÅ ÃÉÒÃÌÅ ÕÓÉÎÇ ÔÈÅ ÓÌÉÄÅÒȢ 

                 

Spiral text starts in the center. 

When writing on a circle, you have the option to put text either on the inside or outside; when 
embroidering, we usually think of this as text at the bottom or top of a circular patch or badge. To switch 
this, use the ÃÈÅÃËÂÏØ ÌÁÂÅÌÅÄ Ȱ0ÌÁÃÅ ÏÎ ÂÏÔÔÏÍȢȱ 

Monogram Font and Quick Style  

The font and style are changed using the selections in the Font and Monogram Style boxes. 
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Monogram Quick Style menu 

When lettering is initially placed on the page, the letters are automatically kerned (letter spacing) 
for a good visual effect. Note that these styles are designed to accomplish traditional monograms, and 
therefore some only work properly with two or three letters. 

Characters in a Font  

Some fonts may only have ÕÐÐÅÒÃÁÓÅ ÌÅÔÔÅÒÓȢ )Æ ÙÏÕȭÒÅ ÕÓÉÎÇ Á ÆÏÎÔ ÁÎÄ ÎÏÔ ÓÅÅÉÎÇ ÔÈÅ ÄÅÓÉÒÅÄ 
ÃÈÁÒÁÃÔÅÒÓȟ ÃÌÉÃËÉÎÇ ÔÈÅ Ȭȩȭ ÂÕÔÔÏÎ ÔÏ ÔÈÅ ÒÉÇÈÔ ÏÆ ÔÈÅ &ÏÎÔ ÂÏØȠ ÉÔ ×ÉÌÌ ÄÉÓÐÌÁÙ ÁÌÌ ÃÈÁÒÁÃÔÅÒÓ ÁÖÁÉÌÁÂÌÅ ÉÎ ÔÈÅ 
selected font along with size recommendations. 

 

Characters available shown with recommended size ranges. 

Navigating the Font list  

 

Some of you have a zillion mapped fonts. Great! But you have the long list to scroll through. Click the 
arrow to pop-up the list of fonts. Now, type the first few letters of what you're looking for. You can type 
and even backspace. 
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Slant and Space  

The slant of a monogram and the spacing of the monogram letters are controlled with the Slant and 
Space slider controls. If you use these controls and want to return the monogram to its default settings, 
simply click the zero control. This will restore the default setting. The Slant gives an italic effect to the 
monogram. 

 

Enveloping  

The envelope (containing top and bottom outlines) of the lettering (single or multi-line) can be 
individually customized. The Envelope Type box and Envelope Slider control the envelope. There 
is an Envelope Slider control for the envelope top and there is an envelope slider control for the 
envelope bottom. There are four styles of envelope: Curve, Grow, Peak and Shrink. 

If you use these controls and want to return the lettering to its default setting simply click the zero 
control. 

   

Enveloping                                     Curved Top and Bottom Envelope 

Enveloping can produce a variety of creative designs, especially when you begin breaking up the 
words into segments and enveloping each one separately. 

 

3ÁÍÐÌÅ ÁÂÏÖÅ ÕÓÅÓ Ô×Ï ÅÎÖÅÌÏÐÅÓ ÁÎÄ Á ÌÏ×ÅÒ ÃÁÓÅ ȰÏȱ ÒÅÓÉÚÅÄ ÆÏÒ ÂÕÂÂÌÅÓȢ 

Changing the Color of one Letter  

Change the color of a single letter by selecting that one letter. To select it, first make sure the 
lettering object or monogram is selected, then click on the green handle that appears centered over the 
letter you want to change. Once a single letter is selected, change the color(s) of just that one letter using 
the color property page as described previously. 

For more information on threads and colors, see the section on Color. 
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Monogram Sewing Order  

On the Letters tab there is a Sewing Order box. Choose the order in which the letters are sewn from 
this control. For a simple monogram you probably do not want to change the default order. However, if 
ÙÏÕ ×ÁÎÔ ÔÏ ÏÖÅÒÌÁÐ ÔÈÅ ÃÅÎÔÅÒ ÌÅÔÔÅÒ ÏÎ ÔÈÅ ÏÔÈÅÒÓȟ ÙÏÕ ÃÏÕÌÄ ÃÈÏÏÓÅ ÔÈÅ Ȭ!#"ȭ ÏÒÄÅÒ ɉÓÅÃÏÎÄ ÃÈÏÉÃÅɊ.  

 

Stitch Properties  

The Stitch tab contains controls for the actual stitch generation of the Lettering. 

Note: This is the tab for built -in fonts. See below about imported fonts.  

 

Satin Density Control:  This control ranges from 3 to 20 with each tick representing 0.1mm. So, the 
range in millimeters is .3 to 2.0 mm. The smaller the density number the closer together the satin stitches 
will be. Normal is 0.4mm. 

Compensation : This control ranges from 0 to 10 with each tick being 0.1 millimeter. As the value 
increases the stitch length increases, in effeÃÔ ȬÆÁÔÔÅÎÉÎÇȭ ÔÈÅ ÓÔÉÔÃÈÉÎÇȢ 4ÈÉÓ ÉÓ ÕÓÅÆÕÌ ÏÎ ÆÁÂÒÉÃÓ ÔÈÁÔ ÈÁÖÅ Á 
loft or nap, and can also be used to make a font appear bolder.  
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Remove Hidden : When selected, stitches that are completely hidden by top stitches will be 
removed. This process allows the design to sew with less density. Note that this only affects stitching 
within the monogram itself, for instance where one letter is positioned on top of another letter. 

Nearest Point : When this is available, it allows the lettering to adjust the entry and exit points for 
each letter to minimize travel to its neighbors. This will also work for alternate sewing sequences such as 
center-out or right-to-left. Not all fonts have this ability, so it is up to the digitizer. 

Edge Run: When checked, this adds a running stitch underlay. This setting is the amount of inset for 
the edge run and ranges from .1 to 1.2 mm. A normal edge-run amount is 0.8mm (about the width of a 
typical needle) 

Satin: When checked, this adds a satin underlay. When checked, it applies the density value, which 
ranges from .3 to 2.0 mm just like the satin stitch. 

The Set Defaults button restores each of these controls to their default values. 

Note: This is the Stitch tab for imported fonts with a licensed product such as Essentials.  

 

Imported fonts are really just merged stitch files, with a few extras built-in for alignment. These 
fonts may have been added using a .BX-format installer or with the Import Font window if you have a 
product such as AlphaTricks. 

Because the stitches already exist at whatever density the digitizer created them with, all you can do 
to the density is modify it ɀ and you do that with a percentage. Likewise, if any of the stitches are 
recognized by the program as fills, we can adjust the percentage of the density here too. Sliding the 
sliders right, for example to 10% will add 10% more stitches, while keeping the size of the lettering the 
same. More density provides more coverage, but too much density sews thick and noisy and can pucker 
the fabric. 

The compensatiÏÎ ÔÏÏÌȟ Ȱ#ÏÍÐȟȱ ÉÓ ÕÓÅÄ ÔÏ ÓÌÉÇÈÔÌÙ ÆÁÔÔÅÎ ÔÈÅ ÌÅÔÔÅÒÉÎÇȢ 4ÈÉÓ ÃÁÎ ÂÅ ÕÓÅÆÕÌ ÆÏÒ Á ÂÅÔÔÅÒ 
look on the font if it is too thin or is being sewn on a pile fabric. If you make the font too fat though, you 
can move to far from any edge run that may exist, which would alter the look at the edge of the satin. 

The Remove Hidden Stitches function allows you to position one letter on top of another and have 
the program remove hidden stitches underneath. This also works with applique lettering, where the top-
stitch will be removed, but Position and Material runs will be left intact. 



The Embrilliance Platform  

54 

4ÈÅ Ȭ,ÉÍÉÔ 3ÁÔÉÎ ,ÅÎÇÔÈȭ ÏÐÔÉÏÎ ÉÓ ÕÓÅÄ ÔÏ ÈÅÌÐ ÐÒÅÖÅÎÔ ÌÏÏÐÉÎÇ ÏÎ ÔÏÐ ÏÆ ÔÈÅ ÆÁÂÒÉÃ ÁÎÄ ÒÅÄÕÃÅ ȬÓÎÁÇ-
ÁÂÉÌÉÔÙȭ ÆÒÏÍ ÌÏÎÇ ÓÁÔÉÎ ÓÔÉÔÃÈÅÓȢ 4ÈÅÒÅ ÁÒÅ ÓÅÖÅÒÁÌ ÏÐÔÉÏÎÓ ÔÏ ÃÈÏÏÓÅ ÆÒÏÍ ×ÈÅÎ ÔÈÅ Ìengths are long. An 
Ȭ!ÎÃÈÏÒȭ ÉÓ Á ÓÉÍÐÌÅ ÒÕÎ ÔÈÁÔȭÓ ÐÌÁÃÅÄ ÅÖÅÒÙ ÏÔÈÅÒ ÌÉÎÅ ÏÆ ÓÔÉÔÃÈÉÎÇȢ 4ÈÉÓ ÁÌÌÏ×Ó ÔÈÅ ÁÌÔÅÒÎÁÔÉÎÇ ÓÁÔÉÎ 
strokes to cover the added needle penetrations. The result is a reasonably smooth stitch, almost as 
smooth as a satin, but well tackÅÄ ÄÏ×Îȟ ÁÎÄ ÎÏÔ ÌÉËÅÌÙ ÔÏ ÓÎÁÇ ÏÒ ÌÏÏÐȢ Ȭ,ÅÎÇÔÈ ,ÉÍÉÔȭ ÉÓ ÏÎÅ ÔÒÁÄÉÔÉÏÎÁÌ 
ÌÏÏË ÔÏ ÁÎÃÈÏÒ ÔÈÅ ÓÁÔÉÎȟ ÁÎÄ ÉÔ ×ÉÌÌ ÓÉÍÐÌÙ ÄÒÏÐ ÔÈÅ ÎÅÅÄÌÅ ×ÈÅÎÅÖÅÒ ÔÈÅ ÓÔÉÔÃÈ ÉÓ ÔÏÏ ÌÏÎÇȢ Ȭ3ÐÌÉÔȭ ×ÉÌÌ 
ÉÎÓÅÒÔ Á ÎÅÅÄÌÅ ÌÁÎÄ ÉÎ ÔÈÅ ÍÉÄÄÌÅ ÏÆ ÁÎÙ ÓÔÉÔÃÈ ÔÈÁÔȭÓ ÔÏÏ ÌÏÎÇȟ ×ÈÉÃÈ ÒÅsults in the look of a split-satin, or 
columnar appearance. 

Text Path  

 You can manipulate text to form a shape or path. Each letter has several handles to 
ÁÃÃÏÍÐÌÉÓÈ ÔÈÉÓȢ #ÌÉÃË ÏÎ Á ÌÅÔÔÅÒȭÓ ÃÅÎÔÅÒ ÇÒÅÅÎ ÈÁÎÄÌÅ ÔÏ ÓÅÌÅÃÔ ÔÈÁÔ ÌÅÔÔÅÒȢ  

The center handle will move that letter.  

The green pennant handle on top of the center will stagger the letters from that one forward: 

 

 

The blue handle at the center rotates the letter and all subsequent letters. The green pennant under 
the center handle will move that letter and all the letters on the line following it. 

 

Using these handles, you can make your letters into virtually any shape. 
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A Closer Look:  You can manipulate text to fit virtually any kind of path using the handles for the 
text design as well as the individual letter and rest-of-line handles. The letters have additional control 
handles that display when the monogram is selected: 

 

Letter Size and Rotation:  As with any design, the letter itself has four black handles for resizing, 
and a blue handle at the top, right used to rotate the letter on its own. 

End-of-Line Handles:  Note the Center Green Handle in each letter. 

This handle that appears in the center of a letter when the lettering design is selected and it is used 
to move the individual letter. Simply click on it and drag the letter to the desired position. 

Clicking the center green handle also allows you to change the color of that letter only, leaving the 
others untouched. Use the Colors page in the Property Sheet to change the letter color, as you would 
change any color layer in a design. 

Clicking on the green center handle displays three additional handles. These handles give a wide 
range of control over the positioning of the letters. The handles work on the selected letter and all letters 
ÔÏ ÔÈÅ ÒÉÇÈÔ ÏÆ ÔÈÅ ÓÅÌÅÃÔÅÄ ÌÅÔÔÅÒȢ ,ÅÔȭÓ ÔÁËÅ Á ÃÌÏÓÅÒ ÌÏÏË ÁÔ ÔÈÅÓÅ ÈÁÎÄÌÅÓȡ 

 

Top Green Handle:  The handle over the center handle is a line stagger. This handle staggers the 
letters vertically and changes the spacing simultaneously. The example shows a stagger upward.  
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Bottom Green Handle: This handle is the kerning handle. It can be used to move letters beginning 
with the one selected to the end of a line. 

This handle moves the letters to a new location without affecting the spacing on anything from the 
selected letter forward to the end of the line. 

 

 

Center Blue Circle Handle: This handle is another tool that moves all text until end-of-line. This 
handle rotates the letters around the center of the selected letter. 
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Lettering Templates  

You can design templates for lettering to use in name drops, word walls, subway art, etc. Templates 
are interactions between two different elements: A lettering design, and a template object. To 
accommodate multiple template designs on a page, the template and lettering items are named using a 
numbering system that will match them together. 

   

The lettering works with the built -in fonts or any .BX fonts. The templates work with lettering of a 
normal single-line style only. Template objects must be native objects from the Create Mode of the 
platform, and the stitch type must be Line, not Run or other stitch type. Template objects may be drawn if  
you have the tools, or if a .BE working file has template objects within it, you can use those. 

There are three types of template objects: Namedrop, Envelope and Baseline. Use the object tree to 
name the shape with one of those names, followed by a number, ex: namedrop 1  

To associate a lettering design with a template, add the matching number to its name, ex: letters 1 

Once you have the names matching, use the letter properties to generate the letters ɀ type or hit 
enter, or adjust one of the properties on the page to cause the lettering to regenerate. When the lettering 
generates, it looks up through the design layers (earlier in the design) for matching template objects. 
Once found, the template and the lettering work together. 

The template object must be in a design that comes before the lettering design. When the lettering 
design gets updated, it only looks backward to see if there is a matching template for it to use. 

 

Lettering used with templates has optional parameters, depending on the template object. You can 
ÁÄÄ ÔÈÅ ÐÁÒÁÍÅÔÅÒ ÔÏ ÔÈÅ ÌÅÔÔÅÒÉÎÇ ÎÁÍÅȟ ÅØȡ ȰÌÅÔÔÅÒÓ ɀÃ ςȱȢ 4ÈÉÓ ÅØÁÍÐÌÅ ×ÉÌÌ ÃÁÕÓÅ ÔÈÅ ÌÅÔÔÅÒÉÎÇ ÔÏ ÕÓÅ ÔÈÅ 
ÔÅÍÐÌÁÔÅ ÏÂÊÅÃÔ ×ÉÔÈ Á ÎÕÍÂÅÒ ς ÁÔ ÔÈÅ ÅÎÄ ÏÆ ÉÔÓ ÎÁÍÅ ɉÅØȡ ȰÂÁÓÅÌÉÎÅ ςȱɊ ÁÎÄ ÁÌÓo will center the design. 

You can place all your template objects in one design, which is customary. As long as that design 
comes before the lettering designs in the sequence, the template items will be found. You do not need to 
have the template objects in any order; the sequence of the lettering designs controls the sewing order. 
All that matters is that the index numbers in the names match. 



The Embrilliance Platform  

58 

Namedrop  

The simplest of the template forms is a namedrop. It is a simple 2-point line, running left to right, 
which controls where lettering will be placed. 

Namedrops have the options: ɀc (center), -l (left), -r (right), -j (justify), -m (middle), -t (top). These 
options inform the template where on the line to place the lettering. The middle and top options refer to 
vertical placement. 

 

.ÁÍÅÄÒÏÐ ÓÈÁÐÅÓ ÃÁÎ ÂÅ ÎÁÍÅÄ ÕÓÉÎÇ ÔÈÅ ÏÐÔÉÏÎÓ ÁÌÏÎÇ ×ÉÔÈ Á ÎÕÍÂÅÒȟ ÅØȡ ȰÎÁÍÅÄÒÏÐ ɀÃÍ ρȱ ×ÉÌÌ 
ÃÁÕÓÅ ȰÌÅÔÔÅÒÓ ρȱ ÔÏ ÂÅ ÐÌÁÃÅÄ ÉÎ ÔÈÅ ÃÅÎÔÅÒ ÈÏÒÉÚÏÎÔÁÌÌÙ ÁÎÄ ÍÉÄÄÌÅ ÖÅÒÔÉÃÁÌÌÙȢ )Æ ÔÈÅ ÌÅÔÔÅÒ ÎÁÍÅ ÓÐÅÃÉÆÉÅÓ Á 
different option, that will  override the template name. 

Once the lettering is linked with the template, most of the normal lettering handles still do all the 
regular operations such as move and rotate. The only difference is that the lettering will always stay on 
the template line. 

 

 

If you have StitchArtist, iÎÆÏÒÍÁÔÉÏÎ ÁÂÏÕÔ ÄÒÁ×ÉÎÇ ÎÁÍÅÄÒÏÐÓ ÃÁÎ ÂÅ ÆÏÕÎÄ ÉÎ ÔÈÅ Ȭ$ÒÁ×ÉÎÇ 
,ÅÔÔÅÒÉÎÇ 4ÅÍÐÌÁÔÅÓȭ ÓÅÃÔÉÏÎ ÏÆ ÔÈÉÓ ÍÁÎÕÁÌȢ 
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Envelope  

Envelopes can yield effects from simple placement to re-shaping of the lettering.  

 

The options for envelopes are: ɀc (center), -l (left), -r (right), -m (middle), -t (top), -b (bottom).  
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These options control placement of lettering within the template. If no options are specified, the 
template will stretch the lettering design to fill the envelope.  

As with namedrop, envelope shapes can be named using the options along with a number, ex: 
ȰÅÎÖÅÌÏÐÅ ɀÃÍ ρȱ ×ÉÌÌ ÃÁÕÓÅ ȰÌÅÔÔÅÒÓ ρȱ ÔÏ ÂÅ ÐÌÁÃÅÄ ÉÎ ÔÈÅ ÃÅÎÔÅÒ ÈÏÒÉÚÏÎÔÁÌÌÙ ÁÎÄ ÍÉÄÄÌÅ ÖÅÒÔÉÃÁÌÌÙȢ )Æ ÔÈÅ 
letter name specifies a different option, that will override the template name. 

Envelopes have a unique ability: They allow editing as visually normal letters when selected. To see 
the lettering in the envelope, click off the letters (de-select them). 

 

If you have StitchArtist, information about drawing envelÏÐÅÓ ÃÁÎ ÂÅ ÆÏÕÎÄ ÉÎ ÔÈÅ Ȭ$ÒÁ×ÉÎÇ 
,ÅÔÔÅÒÉÎÇ 4ÅÍÐÌÁÔÅÓȭ ÓÅÃÔÉÏÎ ÏÆ ÔÈÉÓ ÍÁÎÕÁÌȢ 
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Baseline  

Baselines provide a means for lettering to follow on a path, whether open line or closed shape. 

 

Lettering with baselines have the options: -m (middle), -t (top), -b (bottom) , -c (center).  

Note: The lettering design gets named with the option, not the baseline. Baseline names would be 
ÓÉÍÐÌÙ ȰÂÁÓÅÌÉÎÅȱ ÆÏÌÌÏ×ÅÄ ÂÙ Á ÎÕÍÂÅÒȟ ÅØȡ ȰÂÁÓÅÌÉÎÅ ρȱȢ 

 

There is an additional option for closed shape baselines: -l (lower)  or ɀu (upper) . 

Baselines have pre-determined default settings which can be overridden by the lettering options. An 
open baseline will initially place the lettering at the left start of the shape. Closed shape baselines will 
place the lettering at the top, centered. 

The control handles for lettering work slightly different on a baseline. The center handle, used to 
select a letter, also will allow the letter to be placed anywhere both vertically and horizontally on the 
baseline. 

 

The lower pennant handle causes the lettering to move along the baseline, and to have all the letters 
to the right of it follow. The pennant handle above the center causes the letter to move above or below 
the baseline and all the letters following will do the same. 

The rotation handle connected to the center handle causes the letter to rotate and all the following 
letters rotate in place to match. 
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The middle and top options describe how the lettering will be placed vertically along the baseline. 
Top indicates that the top of the lettering design will be placed along the baseline. Middle places the 
lettering design centered vertically on the baseline. Bottom is the default, so no option is required unless 
using the ɀl (lower) option.  

When using a closed shape, such as a circle, it is often desired to place lettering both above the top 
and below the bottom of the circle. This can be accomplished with two lettering designs, one for the top, 
and one for the bottom. This allows each line of text to have its own settings, even a separate font. When 
specifying that the lettering will go to the bottom of the shape, and the ɀl (lower) parameter. The 
template will switch the default placement to ɀt for lower shape lettering. You can change this using ɀm 
or ɀb. 

 

You can achieve any letter placement ×ÉÔÈ Á ÂÁÓÅÌÉÎÅȢ %ÖÅÎ Ȭ×ÁÖÙȭ ÖÅÒÔÉÃÁÌ ÔÅØÔ ÃÁÎ ÂÅ 
accomplished using a vertical line and rotating the letters using the center rotation handle. 

If you have StitchArtist, information ÁÂÏÕÔ ÄÒÁ×ÉÎÇ ÂÁÓÅÌÉÎÅÓ ÃÁÎ ÂÅ ÆÏÕÎÄ ÉÎ ÔÈÅ Ȭ$ÒÁ×ÉÎÇ 
Lettering 4ÅÍÐÌÁÔÅÓȭ ÓÅÃÔÉÏÎ ÏÆ ÔÈÉÓ ÍÁÎÕÁÌȢ 
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Monogram  Placement  Guide  

Towels  

General Instructions:  The placement goes on the opposite side of the fabric and at the opposite 
end from the label. This allows a traditional triple fold to display the monogram. Folding the towel as you 
would display it helps visualizing and marking the correct placement. 

Bath Towel:  4ÈÅ ÂÏÔÔÏÍ ÏÆ ÔÈÅ ÍÏÎÏÇÒÁÍ ÓÈÏÕÌÄ ÂÅ τȱ ÁÂÏÖÅ ÔÈÅ ÈÅÍ ÏÒ ρȱ ÔÏ ςȱ ÁÂÏÖÅ ÔÈÅ ÄÏÂÂÙ 
ÂÏÒÄÅÒȟ ÉÆ ÐÒÅÓÅÎÔȢ 4ÈÅ ÍÏÎÏÇÒÁÍ ÓÈÏÕÌÄ ÂÅ τȱ ÔÁÌÌȢ 

Beach Towel: The bottom oÆ ÔÈÅ ÍÏÎÏÇÒÁÍ ÓÈÏÕÌÄ ÂÅ υȱ ÁÂÏÖÅ ÔÈÅ ÈÅÍ ÏÒ ςȱ ÔÏ σȱ ÁÂÏÖÅ ÔÈÅ ÄÏÂÂÙ 
ÂÏÒÄÅÒȟ ÉÆ ÐÒÅÓÅÎÔȢ 4ÈÅ ÍÏÎÏÇÒÁÍ ÓÈÏÕÌÄ ÂÅ υȱ ÔÁÌÌȢ 

Golf Towel:  The monogram should be centered horizontally with the top of the monogram .υȱ 
ÂÅÌÏ× ÔÈÅ ÇÒÏÍÍÅÔȢ 4ÈÅ ÍÏÎÏÇÒÁÍ ÓÈÏÕÌÄ ÂÅ ρȱ ÔÏ ςȱ ÔÁÌÌȢ 

Hand Towel:  4ÈÅ ÂÏÔÔÏÍ ÏÆ ÔÈÅ ÍÏÎÏÇÒÁÍ ÓÈÏÕÌÄ ÂÅ ςȱ ÁÂÏÖÅ ÔÈÅ ÈÅÍ ÏÒ ρȱ ÔÏ ρȢυȱ ÁÂÏÖÅ ÔÈÅ 
dobby border, if present. The ÍÏÎÏÇÒÁÍ ÓÈÏÕÌÄ ÂÅ σȱ ÔÁÌÌȢ 

Sports Towel:  4ÈÅ ÂÏÔÔÏÍ ÏÆ ÔÈÅ ÍÏÎÏÇÒÁÍ ÓÈÏÕÌÄ ÂÅ ρȢυȱ ÁÂÏÖÅ ÔÈÅ ÈÅÍȢ 4ÈÅ ÍÏÎÏÇÒÁÍ ÓÈÏÕÌÄ 
ÂÅ ρȢυȱ ÔÁÌÌȟ ÁÎÄ ÍÁÙ ÂÅ ÐÌÁÃÅÄ ÏÎ Á τυ-degree angle. 

Wash Cloth: 4ÈÅ ÂÏÔÔÏÍ ÏÆ ÔÈÅ ÍÏÎÏÇÒÁÍ ÓÈÏÕÌÄ ÂÅ ρȢυȱ ÁÂÏÖÅ ÔÈÅ ÈÅÍ ÏÒ ρȱ ÁÂÏÖÅ ÔÈÅ dobby 
ÂÏÒÄÅÒȟ ÉÆ ÐÒÅÓÅÎÔȢ 4ÈÅ ÍÏÎÏÇÒÁÍ ÓÈÏÕÌÄ ÂÅ ρȢυȱ ÔÁÌÌ ÁÎÄ ÍÁÙ ÂÅ ÐÌÁÃÅÄ ÏÎ Á τυ-degree angle. 

Bedding  

General Instructions:  $ÏÎȭÔ ÁÎÎÏÙ ÙÏÕÒ ÓÌÅÅÐÅÒȢ 0ÌÁÃÅÍÅÎÔ ÁÎÄ ÔÈÒÅÁÄ ÃÁÎ ÁÆÆÅÃÔ ÔÈÅ ÃÏÍÆÏÒÔ ÏÆ ÔÈÅ 
item. Spread out the item as you would see it on a well-made bed to help with visualizing and marking the 
correct placement. 

Top Sheet: Top Sheets are placed on a bed upside-down and the top (wide hem) is then folded back 
to right -side-up. This means that the monogram is apparently embroidered upside down. Looking at a 
made-ÕÐ ÂÅÄ ×ÉÌÌ ÈÅÌÐ ÙÏÕ ÖÉÓÕÁÌÉÚÅ ÔÈÉÓȢ 0ÌÁÃÅ ÔÈÅ ÂÏÔÔÏÍ ÏÆ ÔÈÅ ÍÏÎÏÇÒÁÍ ςȱ ÆÒÏÍ ÔÈÅ ×ÉÄÅ ÈÅÍȟ 
ÃÅÎÔÅÒÅÄȢ 4ÈÅ ÍÏÎÏÇÒÁÍ ÓÈÏÕÌÄ ÂÅ σȱ ÔÏ τȱ ÔÁÌÌȢ %ÍÂÒÏÉÄÅÒÉÎÇ ÉÎÓÉÄÅ ÔÈÅ ×ÉÄÅ ÈÅÍ ÉÓ ÓÏÍÅÔÉÍÅÓ 
preferred, and when doing so the design is sized to fit. 

Pillowcase:  Embroidering inside the wide hem is generally preferred, and when doing so the design 
ÉÓ ÓÉÚÅÄ ÔÏ ÆÉÔȢ )Æ ÔÈÅ ÆÏÎÔ ÁÌÌÏ×Ó ÉÔȟ ÔÈÅ ÍÏÎÏÇÒÁÍ ÓÈÏÕÌÄ ÂÅ ςȢυȱ ÔÏ σȱ ÔÁÌÌȢ 0ÌÁÃÅÍÅÎÔ ÉÓ ÃÅÎÔÅÒÅÄȟ 
monogram facing toward the opening. 

Pillow Sham : Center the design on the sham, facing the long edge as if it were a pillowcase with an 
ÏÐÅÎÉÎÇȢ 4ÈÅ ÍÏÎÏÇÒÁÍ ÓÈÏÕÌÄ ÂÅ ςȢυȱ ÔÏ τȱ ÔÁÌÌȢ 

Blanket:  Centered on the top like a sheet or facing into the bottom, right corner at a 45-degree 
angle. The monogram sÈÏÕÌÄ ÂÅ τȱ ÔÁÌÌȢ 

Duvet Cover: #ÅÎÔÅÒÅÄ ÏÎ ÔÈÅ ÔÏÐȢ 4ÈÅ ÍÏÎÏÇÒÁÍ ÓÈÏÕÌÄ ÂÅ ÌÁÒÇÅȟ ÕÐ ÔÏ ρςȱ ÔÁÌÌȢ 

Home Decor 

General Instructions:  None. This is all according to taste, fashion and style. 

Napkin:  %ÍÂÒÏÉÄÅÒ ςȱ ÉÎ ÆÒÏÍ ÐÏÉÎÔ ÏÆ ÃÏÒÎÅÒȢ $ÉÓÔÁÎÃÅ ÍÁÙ ÎÅÅÄ ÔÏ ÂÅ ÉÎÃÒÅÁÓÅÄ ÉÆ ÔÈÅÒÅȭÓ Á ÂÏÒÄÅÒ 
ÏÒ ÈÅÍȢ 0ÌÁÃÅ ÏÐÐÏÓÉÔÅ ÏÆ ÌÁÂÅÌ ÏÒ ÔÁÇȢ 4ÈÅ ÍÏÎÏÇÒÁÍ ÓÈÏÕÌÄ ÂÅ ρȱ ÔÏ ςȱ ÔÁÌÌȢ 
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Placemat:  Top-ÒÉÇÈÔ ÃÏÒÎÅÒȟ σȱ ÄÉÁÇÏÎÁÌÌÙ ÆÒÏÍ ÐÏÉÎÔ ÏÆ ÃÏÒÎÅÒȢ 4ÈÅ ÍÏÎÏÇÒÁÍ ÓÈÏÕÌÄ ÂÅ ρȱ ÔÏ ςȱ 
tall. 

Table Runner:  %ÍÂÒÏÉÄÅÒ ÍÁÔÃÈÉÎÇ ÄÅÓÉÇÎÓ τȱ ÆÒÏÍ ÅÎÄȢ 4ÈÅ ÍÏÎÏÇÒÁÍ ÓÈÏÕÌÄ ÂÅ τȱ ÔÏ υȱ ÔÁÌÌȢ 

Table Cloth:  %ÍÂÒÏÉÄÅÒ τȱ ÆÒÏÍ ÃÏÒÎÅÒȟ ×ÉÔÈ ÄÅÓÉÇÎ ÆÁÃÉÎÇ ÉÎÔÏ ÃÏÒÎÅÒ ÁÔ Á τυ-degree angle. The 
ÍÏÎÏÇÒÁÍ ÓÈÏÕÌÄ ÂÅ τȱ ÔÏ φȱ ÔÁÌÌȢ 

Garments  

Coat Lining:  %ÍÂÒÏÉÄÅÒ ÏÎ ÔÈÅ ÒÉÇÈÔ ÓÉÄÅ ÁÔ ÔÈÅ ×ÁÉÓÔ ÌÅÖÅÌȟ σȱ ÆÒÏÍ the seam. Monograms should be 
ρȱ ÔÏ ρȢςυȱ ÔÁÌÌȢ 

Collar:  %ÍÂÒÏÉÄÅÒ ÏÎ ÔÈÅ ÌÅÆÔ ÓÉÄÅȟ ÁÂÏÖÅ ÂÕÔÔÏÎÈÏÌÅ ÉÆ ÐÒÅÓÅÎÔȢ -ÏÎÏÇÒÁÍÓ ÓÈÏÕÌÄ ÂÅ σȾψȱ ÔÁÌÌȢ 

Golf/Polo Shirt:  χȢυȱ ÔÏ ωȱ ÂÅÌÏ× ÔÈÅ ÓÈÏÕÌÄÅÒÓ ÌÅÆÔ ÓÅÁÍ ÁÎÄ τȱ ÔÏ φȱ ÆÒÏÍ ÃÅÎÔÅÒȢ $ÅÐÅÎÄÉÎÇ ÏÎ ÔÈÅ 
design, you can also look for a line down from where the collar meets the shoulder seam, and look over 
from the 2nd buttonhole. 

Long Sleeve Shirt: Top and center of wrist, ×ÈÉÃÈ ÉÓ ÁÂÏÕÔ ρȱ ÔÏ ρȢςυȱ ÆÒÏÍ ÔÈÅ ÃÅÎÔÅÒ ÔÏ×ÁÒÄ ÔÈÅ 
buttonhole. The bottom of the monogram should sit very near the top stitching of the cuff. Monograms 
ÓÈÏÕÌÄ ÂÅ σȾψȱ ÔÁÌÌȢ 

Robe: $ÒÁ× Á ÌÉÎÅ ÓÔÒÁÉÇÈÔ ÄÏ×Î ÆÒÏÍ ÔÈÅ ÓÈÏÕÌÄÅÒ ÓÅÁÍ τȱ ÔÏ φȱ ÆÏÒ ×ÏÍÅÎ ÁÎÄ χȱ ÔÏ ρπȱ ÆÏÒ ÍÅÎȢ 
Find the center of the armholes from the armpit to the shoulder, and draw line straight across toward the 
ÃÅÎÔÅÒ ÏÆ ÔÈÅ ÒÏÂÅ ÏÒ ÇÏ ÁÃÒÏÓÓ σȱ ÔÏ υȱ ÆÒÏÍ ÔÈÅ ÃÅÎÔÅÒȢ 

Shirt Placket:  Center the design between 2nd and 3rd buttonholes. The desiÇÎ ÓÈÏÕÌÄ ÂÅ ρȾτȱ ÔÏ 
σȾψȱ ÉÎÃÈ ÔÁÌÌȢ 

Shirt with no pocket:  Draw a line straight down from where the shoulder seam meets the collar 
seam. Find the center of the armholes from the armpit to the shoulder, and draw line straight across 
toward the center of the shirt. The center of the design is marked where the lines intersect. If the 
armÈÏÌÅÓ ÁÒÅ ÄÅÅÐȟ ÔÈÅ ÌÉÎÅ ÃÁÎ ÂÅ ÍÁÄÅ ÔÏÏ ÌÏ× ÏÎ Á ×ÏÍÁÎȭÓ ÓÈÉÒÔȟ ÓÏ ËÅÅÐ ÔÈÁÔ ÉÎ ÍÉÎÄȢ 

Shirt with pocket:  #ÅÎÔÅÒ ÔÈÅ ÄÅÓÉÇÎ ÏÎ ÔÈÅ ÐÏÃËÅÔ ÈÅÍȟ ×ÉÔÈ ÔÈÅ ÔÏÐ ÏÆ ÔÈÅ ÄÅÓÉÇÎ ρȾτȱ Âelow the 
ÔÏÐ ÏÆ ÔÈÅ ÐÏÃËÅÔȢ -ÏÎÏÇÒÁÍÓ ÓÈÏÕÌÄ ÂÅ ρȾτ ÔÏ σȾψȱ ÔÁÌÌȢ )Æ ÐÏÃËÅÔ ÈÁÓ ÂÕÔÔÏÎ ÉÎ ÃÅÎÔÅÒȟ ÓÈÉÆÔ ÄÅÓÉÇÎ ÔÏ ÔÈÅ 
right. 

Shorts Leg: Halfway between center-ÆÒÏÎÔ ÁÎÄ ÓÉÄÅ ÓÅÁÍȢ 4ÈÅ ÂÏÔÔÏÍ ÏÆ ÔÈÅ ÄÅÓÉÇÎ ÓÈÏÕÌÄ ÂÅ ρȾτȱ 
ÔÏ ρȾςȱ ÁÂÏÖÅ ÔÈÅ ÈÅÍ ÓÔÉÔÃÈÉÎÇ ÁÔ the leg hole. 

Short Sleeve Shirt:  #ÅÎÔÅÒ ÄÅÓÉÇÎ ρȾτȱ ÔÏ ρȾςȱ ÁÂÏÖÅ ÔÈÅ ÈÅÍ ÏÎ ÔÈÅ ÓÌÅÅÖÅȢ -ÏÎÏÇÒÁÍÓ ÓÈÏÕÌÄ ÂÅ 
ρȾτȱ ÔÏ σȾψȱ ÔÁÌÌ. 
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Product Features  

Several Embrilliance products make use of the feature sets in this section. These features are not 
universal in the platform, but may appear in various products such as Essentials, Enthusiast and 
StitchArtist. The specifics are noted with each feature. For current feature information you can also refer 
to the Embrilliance website. 

Open Library Folder  

The Utility menu is available only with purchased titles. It adds certain convenience features, 
ÄÅÐÅÎÄÉÎÇ ÏÎ ÔÈÅ ÐÒÏÄÕÃÔÓ ÌÉÃÅÎÓÅÄȢ /ÎÅ ÔÈÁÔȭÓ ÁÌ×ÁÙÓ ÁÖÁÉÌÁÂÌÅ ÉÓ ÔÈÅ /ÐÅÎ ,ÉÂÒÁÒÙ &ÏÌÄÅÒȢ 4ÈÉÓ ÁÌÌÏ×Ó 
you to browse the file system in the folder in which your designs, motifs and fonts are located. 

Note: When making changes to this folder, it is best to close the program. 

Most of these files are licensed products, such as imported fonts. As such, you cannot simply rename 
them in the operating system folder. You can delete those files if you wish to remove the font from your 
system. 

To backup your fonts, designs and motifs to another computer, simply copy the entire folder to 
something like a USB drive. Then you can copy those files onto the new computer, if desired. 

Save Image (Enthusiast, StitchArtist)  

You can quickly save a transparent .PNG file of your design page with this item, found on the Utility 
menu.  

 

The Save Image utility 

The image is created internally at a size based on the design size and then exported at the DPI you 
specify. You can use any image editing program to adjust size or save as a different image type, if desired. 
This utility is useful for putting designs on the web, in print, etc. The .PNG format allows a transparent 
background, and that is used to make compositions. Alternate to transparent, and available in all formats, 
is the ability to adjust the background color, and/or have a simulated fabric texture behind the image. 

The square option is designed for e-commerce situations where a square image is often required. 
The border adds some extra space around the image, and is used to achieve visual interest. 

Note: Watermarking can be done by adding a transparent image (.png) as the final design. Adjust 
its  transparency until you get the des ired effect.  
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Applique  (Essentials, StitchArtist)  

When you select a color by clicking on it in the Properties window, you see the color window 
appear. This has two tabs, the first of which is to change the color, as discussed in the prior section. 

The second tab is used to set applique states on the selected colors. This information is used by the 
program when removing overlaps, and adds other features such as saving a file for use in applique 
cutting machines. 

 

Essentials includes the ability to have the Simulated Fabric View. 

The StitchArtist version of this window is shown, which includes the use of images.  

7ÈÅÎ Á ÃÏÌÏÒ ÉÓ ÁÓÓÉÇÎÅÄ ÁÓ Ȭ!ÐÐÌÉÑÕÅ 0ÏÓÉÔÉÏÎȭ ÏÒ Ȭ!ÐÐÌÉÑÕÅ -ÁÔÅÒÉÁÌȭ ÔÈÅÎ ÔÈÁÔ ÃÏÌÏÒ ÂÅÃÏÍÅÓ 
exempt from having its stitches removed. They are likely to be hidden, but they are necessary when 
sewing the applique design. 

Colors can be assigned as applique position or material in three ways:  

1. Use the drop list on the Applique tab of the Color Window. 

2. Right click on the color ship in the Property window and use the context menu. 

3. Name the object in the Object Tree as Applique Material or Applique Position. The 
×ÏÒÄÓ ÃÁÎ ÂÅ ÁÂÂÒÅÖÉÁÔÅÄȡ Ȱ!ÐÐÌÉÑ -ÁÔȱ ÏÒ Ȱ!ÐÐÌÉÑ 0ÏÓȱ ÁÒÅ ÁÃÃÅÐÔÁÂÌÅ 

Material  

4ÈÅ Ȭ-ÁÔÅÒÉÁÌȭ ÌÁÙÅÒ ÉÓ ÕÓÅÄ ÓÔÒÉÃÔÌÙ ÔÏ ÐÒÅÖÅÎÔ ÔÈÅ removal of stitches ɀ first in the sense that the 
material stitches themselves are not removed, but additionally that the fabric inside the applique can 
obscure earlier stitches. As it is not good to have bulky stitches underneath an applique, those are 
removed. By way of example, you might want to overlap two or more appliques, and where they overlap, 
you want the minimum stitches necessary. Note that some designs do not have a separate material tack-
ÄÏ×Î ÃÏÌÏÒȢ 4ÈÁÔȭÓ ÏËÁÙ ÔÏ ÌÅÁÖÅ ÏÆÆ ÉÎ ÍÏÓÔ ÃÁÓÅÓȢ 

Position  

4ÈÅ Ȭ0ÏÓÉÔÉÏÎȭ ÓÅÔÔÉÎÇ ÉÓ ÁÌ×ÁÙÓ ÔÏ ÂÅ ÆÏÕÎÄ ÉÎ ÁÐÐÌÉÑÕÅ ÄÅÓÉÇÎÓ ɀ otherwise they would not be 
applique. The position of the fabric is sewn down, and then the applique is applied.  

Using this information, we can do some additional things in the software: 
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Generate a fabric simulation: The fabric is simulated using the chosen color of the object. You can 
ÃÈÁÎÇÅ ÔÈÉÓ ÓÅÔÔÉÎÇȟ ÁÎÄ ÔÈÅ ÃÏÌÏÒ ÉÔÓÅÌÆ ȬÌÉÖÅȭ ÉÎ ÔÈÅ ×ÉÎÄÏ× ÔÏ ÐÒÅÖÉÅ× ÔÈÅ ÒÅÓÕÌÔÓȢ 7ÈÅÎ ÙÏÕ ÆÉÎÄ Á 
ÓÕÉÔÁÂÌÅ ÓÅÔÔÉÎÇȟ ÃÌÉÃË Ȭ/+ȭȢ 

 

If you have StitchArtist, you can do more, as described in the section, Photo Applique. 

IMPORTANT NOTES: 

The type of stitching is important for the operation of the applique discovery process in the 
software. Generally, applique position steps are made from single running stitches, which may jump to 
other sections and/or holes. Most digitizers will do this simple run, and then add tie-off stitches at the 
beginning and end of each outline. Sometimes the outlines will not close perfectly, but the software 
overcomes this, as well as the tie-offs. But if the digitizer uses some other stitch, it is possible that the 
process will not be recognized as an applique when you want it to. The easy way to check is to turn on the 
fabric simulation. If that looks correct, you are good to go. 

Also note that the program is not converting filled sections into appliques. That must be done by the 
digitizer who created the design. This applique discovery process is to make using existing applique 
designs easier and more fun. 

Preferences  

The 0ÒÏÇÒÁÍ 0ÒÅÆÅÒÅÎÃÅÓ ÈÁÖÅ Á ÓÅÔÔÉÎÇ ÕÎÄÅÒ Ȱ&ÉÌÅÓ-Є7ÈÅÎ 3ÁÖÉÎÇȱ ÔÈÁÔ ÃÁÎ ÂÅ ÕÓÅÄ ÔÏ ÔÕÒÎ ÏÎȾÏÆÆ 
the use of applique in the removal of hidden stitches. 

Also, ÔÈÅ ÕÓÅ ÏÆ ÔÈÅ 0ÒÏÇÒÁÍ 0ÒÅÆÅÒÅÎÃÅÓ ÕÎÄÅÒ Ȱ0ÒÉÎÔÉÎÇȱ ÃÁÎ ÁÌÌÏ× ÓÅÌÅÃÔÅÄ ÃÏÌÏÒÓ ÔÏ ÂÅ ÐÒÉÎÔÅÄȢ 
This can be useful for machines that scan in a printed output for the purpose of cutting, such as the Scan 
Ȭ. #ÕÔȢ 

Saving Cut Files  

The software analyzes the shapes created by the Position stitches and then creates a simpler output 
for the cutters, and saves it to ÔÈÅÉÒ ÆÉÌÅȢ ȢÆÃÍ ÆÏÒ "ÒÏÔÈÅÒ 3ÃÁÎ ȬÎ #ÕÔ ÁÎÄ ÔÈÅ ȢÓÔÕÄÉÏ 3ÉÌÈÏÕÅÔÔÅ ÐÒÏÄÕÃÔÓȟ 
along with .svg and .plt files can be saved. Nearly every cutter can make use of one or more of these 
formats. 

Save the cut file and send it to your machine according to the manÕÆÁÃÔÕÒÅÒȭÓ ÉÎÓÔÒÕÃÔÉÏÎÓȢ 

4ÈÅ Ȭ3ÁÖÅ !ÌÌȭ ÂÕÔÔÏÎ ×ÉÌÌ ÍÅÒÇÅ ÁÌÌ ÔÈÅ 0ÏÓÉÔÉÏÎ ÓÔÉÔÃÈÅÓ ÏÎ ÔÈÅ ÄÅÓÉÇÎ ÐÁÇÅȟ ×ÈÅÔÈÅÒ ÏÒ ÎÏÔ ÔÈÏÓÅ 
objects are selected, and the resulting cut file will have all applique elements in it. 

Generally speaking, applique steps are; 

1. Set the colors as needed. 

2. Save the cut file. 
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3. Save the design file (working and stitch) 

4. Cut the applique. 

5. Embroider the design. 

Alternately, you can still use the image in a print process, and pre-cut the applique by hand. There 
are a lot of options! 
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Photo Applique  (StitchArtist)  

1. Use an image such as a photograph or fabric swatch inside the applique shape.

 

2. Create a print that is cropped to the outline, making it easy to hand-cut pre-cut 
appliques. 

 

3. Print the cropped image on printable fabric or transfer paper for the effect of combined 
photography and embroidery. 

 

4. Inflate the shape of the outline. When digitizers create a design that will be hand-cut in 
ÔÈÅ ÈÏÏÐȟ ÔÈÅÙ ËÎÏ× ÔÈÁÔ ÔÈÅ ÅÍÂÒÏÉÄÅÒÅÒ ×ÏÎȭÔ ÃÕÔ ÅØÁÃÔÌÙ ÁÔ ÔÈÅ ÌÉÎÅ ÏÆ ÓÔÉÔÃÈÉÎÇȢ So, 
when they make ÔÈÅ Ȭ-ÁÔÅÒÉÁÌȭ ÒÕÎȟ ÔÈÅÙ ÏÆÔÅÎ ÓÉÍÐÌÙ ÄÕÐÌÉÃÁÔÅ ÔÈÅ Ȭ0ÏÓÉÔÉÏÎȭ ÒÕÎ ɀ same 
size, etc. This creates an issue for Pre-#ÕÔ !ÐÐÌÉÑÕÅ ÁÓ ÔÈÅ Ȭ-ÁÔÅÒÉÁÌȭ ÓÔÉÔÃÈÉÎÇ ×ÉÌÌ ÎÏÔ 
catch the applique ɀ ÉÔ ÉÓ ÅØÁÃÔÌÙ ÔÈÅ ÓÁÍÅ ÓÉÚÅȢ 5ÓÉÎÇ ÔÈÅ Ȭ)ÎÆÌÁÔÅȭ ×ÈÅÎ ÓÁÖÉÎÇ ÆÏÒ 
cuttiÎÇ ÍÁÃÈÉÎÅÓ ×ÉÌÌ ÃÒÅÁÔÅ ÁÎ ÁÐÐÌÉÑÕÅ ÔÈÁÔ ÓÌÉÇÈÔÌÙ ÈÉÄÅÓ ÔÈÅ Ȭ0ÏÓÉÔÉÏÎȭ ÁÎÄ ÃÁÎ ÂÅ 
ÈÅÌÄ ÉÎ ÐÌÁÃÅ ÂÙ ÔÈÅ Ȭ-ÁÔÅÒÉÁÌȭ ÓÔÉÔÃÈÉÎÇȢ 

5. 4ÈÅ Ȭ0ÏÓÉÔÉÏÎȭ ÉÓ ÕÓÕÁÌÌÙ Á ÓÉÍÐÌÅ ÅÎÏÕÇÈ ÓÅÔ ÏÆ ÓÔÉÔÃÈÅÓ ÔÏ ÂÅ ÐÒÏÃÅÓÓÅÄ ÉÎÔÏ ÏÕÔÐÕÔ ÆÏÒ 
an automatic cutting machine. These machines will take a file and use that to cut the 
fabric. Having cut the applique beforehand makes the embroidery process much more 
rewarding. 
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The Thread Editor  (Essentials, Enthusiast, StitchArtist)  

The management of threads is a challenge for every embroiderer, and every embroiderer handles 
this differently. Some people are very organized and will colorize designs with only colors they actually 
own. Others resist changing threads at all. And, of course, commercial embroiderers ignore colors 
onscreen entirely and just run whatever colors the job calls for. 

The Thread / Palette Editor provides a place for you to manage which threads you own, create 
smaller palettes for specific projects, and even share those palettes with others. 

When choosing colors in the main program window, you are given the choice of picking colors from 
thread lines or palettes. The reason for this is to allow quick access to a current set of project colors, 
rather than taking the time to scroll through a long list of threads and their complete color lists. Often, an 
ÅÍÂÒÏÉÄÅÒÅÒ ÉÓ ×ÏÒËÉÎÇ ×ÉÔÈ Á ÓÅÔ ÏÆ ÃÏÌÏÒÓ ÒÅÐÅÁÔÅÄÌÙ ÁÎÄ ÓÅÌÅÃÔÉÎÇ ÔÈÒÏÕÇÈ Á ÌÏÎÇ ÌÉÓÔ ×ÈÅÎ ÙÏÕȟ Ȱ*ÕÓÔ 
×ÁÎÔ ÔÈÁÔ ÂÌÕÅ )ȭÍ ÕÓÉÎÇȟȱ ×ÏÕÌÄ ÂÅ ÔÅÄÉÏÕÓȢ &ÏÒ ÔÈÉÓ ÒÅÁÓÏÎȟ ÔÈÅÒÅ ÉÓ Á ÃÈÅÃËÂÏØ ÔÈÁÔ ÉÓ ÕÓÅÄ ÔÏ ÄÅÔÅÒÍÉÎe 
whether the color list is shown as a thread or a palette. 

 

Note: &ÏÒ ÔÈÅ ÐÕÒÐÏÓÅÓ ÏÆ ÄÉÓÃÕÓÓÉÏÎȟ ÔÈÅ ÔÅÒÍ ȰÔÈÒÅÁÄ ÌÉÎÅȱ ÁÎÄ ȰÐÁÌÅÔÔÅȱ ÁÒÅ ÃÏÎÓÉÄÅÒÅÄ 
synonymous, except when discussing the above checkbox.  

The program ships with data for many thread lines, including some that may not be available to you 
in your area. If you would prefer not to have those threads show up in your list (while changing colors in 
Á ÄÅÓÉÇÎɊȟ ÙÏÕ ÃÁÎ ÃÈÅÃË ÔÈÅ ÂÏØ ÌÁÂÅÌÅÄȟ Ȱ$Ï ÎÏÔ ÄÉÓÐÌÁÙȢȱ 4ÈÉÓ ÄÏÅÓ ÎÏÔ ÈÉÄÅ ÔÈÅ ÔÈÒÅÁÄ ÉÎ ÔÈÅ 4Èread 
Editor, only in the Thread and Color properties when working with designs and objects. 

4ÈÅ Ȭ.ÏÔÅÓȭ ÂÏØ ÃÁÎ ÂÅ ÕÓÅÄ ÔÏ ÅÎÔÅÒ ÁÎÙ ÕÓÅÆÕÌ ÉÎÆÏÒÍÁÔÉÏÎ ÁÂÏÕÔ Á ÐÁÒÔÉÃÕÌÁÒ ÐÁÌÅÔÔÅȢ &ÏÒ ÉÎÓÔÁÎÃÅȟ 
you might create a palette of colors for a particular job or pÒÏÊÅÃÔ ÁÎÄ ÅÎÔÅÒ ÉÎÆÏÒÍÁÔÉÏÎ ÓÕÃÈ ÁÓ Ȱ4ÈÅ ÂÌÕÅ 
ÄÅÓÉÇÎ ÍÁÔÃÈÅÓ ÔÈÅ ÐÒÉÎÔ ÏÎ ÔÈÅ ÆÒÏÎÔ ÏÆ ÔÈÅ ÓÈÉÒÔȢȱ 

Each thread brand or palette is stored as a file on your computer. As such, the toolbar has options 
for you to create new thread palettes, save a palette that ÙÏÕȭÒÅ ×ÏÒËÉÎÇ ÏÎȟ ÁÎÄ ÅÖÅÎ ÄÅÌÅÔÅ Á ÐÁÌÅÔÔÅ 
ÔÈÁÔȭÓ ÎÏ ÌÏÎÇÅÒ ÎÅÅÄÅÄȢ 4ÈÅÓÅ ÁÃÔÉÏÎÓ ÁÒÅ ÐÅÒÆÏÒÍÅÄ ÂÙ ÔÈÅ ÌÅÆÔ ÔÈÒÅÅ ÂÕÔÔÏÎÓ ÏÎ ÔÈÅ ÔÏÏÌÂÁÒȢ 

Merging  Color Palettes  

4ÈÅ ÎÅØÔ ÂÕÔÔÏÎȟ Ȭ-ÅÒÇÅȭ ×ÉÌÌ ÏÐÅÎ Á ÔÈÒÅÁÄ ×ÉÎÄÏ× ÔÈÁÔ ÌÅÔÓ ÙÏÕ ÓÅÌÅÃÔ ÏÎÅ ÏÒ ÍÕÌÔÉÐÌÅ ÃÏlors to be 
merged into the current palette. Also, there is a Delete button that removes any selected threads from the 
current palette. 
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When merging colorÓ ÆÒÏÍ ÁÎÏÔÈÅÒ ÔÈÒÅÁÄ ÏÒ ÐÁÌÅÔÔÅȟ ÔÈÅ ȬÂÒÁÎÄȭ ÆÏÒ ÔÈÏÓÅ ÃÏÌÏÒÓ ×ÉÌÌ ÔÁËÅ ÔÈÅ ÎÁÍÅ 
of the current thread. This is one difference between a thread and a palette. If you merge colors into a 
palette (the palette box is checked) then the colors will keep their original thread names. 

Sharing Palettes  

If you would like to share or import a palette, use the two buttons on the right of the toolbar. 
Sharing a palette is useful when you are making a project that others will make too. 

Thread Inven tory  

You can mark threÁÄÓ ÔÈÁÔ ÙÏÕ ÈÁÖÅ ÉÎ ÙÏÕÒ ÐÅÒÓÏÎÁÌ ÉÎÖÅÎÔÏÒÙ ÕÓÉÎÇ ÔÈÅ Ȭ#ÈÅÃËȭ ÁÎÄ Ȭ5ÎÃÈÅÃËȭ 
buttons: 

 

Creating colors  (Essentials+ Enthusiast, StitchArtist)  

These products add the ability to create your own colors and add them to thread lines and palettes. 
4Ï ÃÒÅÁÔÅ Á ÎÅ× ÔÈÒÅÁÄ ÏÒ ÐÁÌÅÔÔÅȟ ÃÌÉÃË ÔÈÅ Ȭ.Å×ȭ ÂÕÔÔÏÎ ÏÎ ÔÈÅ ÔÏÏÌÂÁÒȢ 

#ÌÉÃË ÔÈÅ Ȭ!ÄÄ #ÏÌÏÒȭ ÂÕÔÔÏÎ ÔÏ ÃÒÅÁÔÅ Á ÎÅ× ÃÏÌÏÒ ÅÎÔÒÙ ÉÎ ÔÈÅ ÃÕÒÒÅÎÔ ÔÈÒÅÁÄ Ⱦ ÐÁÌÅÔÔÅȢ 4ÙÐÅ ÉÎ ÉÔs 
name and thread number, if those exist, then adjust the color itself. 

5ÓÉÎÇ ÔÈÅ Ȭ3ÈÅÅÎȭ ÓÅÔÔÉÎÇȟ ÙÏÕ ÃÁÎ ÁÌÔÅÒ ÈÏ× ÔÈÅ ÔÈÒÅÁÄ ×ÉÌÌ ÄÉÓÐÌÁÙ ×ÈÅÎ σ$ ÒÅÎÄÅÒÉÎÇ ÉÓ ÔÕÒÎÅÄ ÏÎ 
in the main display.  You can also input up to four variegated colors on a thread. UÓÉÎÇ ÔÈÅ Ȭ6ÁÒȭ ÄÒÏÐ-list 
ɉÓÈÏÒÔ ÆÏÒ ÖÁÒÉÅÇÁÔÅÄɊ ÙÏÕ ÓÅÌÅÃÔ ÔÈÅ ÎÕÍÂÅÒ ÏÆ ÃÏÌÏÒÓ ÕÓÅÄȢ 4ÈÅÒÅ ×ÉÌÌ ÁÐÐÅÁÒ Á ÓÅÔ ÏÆ ÂÕÔÔÏÎÓ Ȭ6ρȭ-Ȭ6τȭ 
each of which allows you to select and set the color for that particular variegation. 

Multiple selections can be made using 
the Ctrl and Shift keys while selecting with 
the mouse. 
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The color grabber tool lets you click in any window and pick up whatever color is under the cursor. 
This is very useful when you are building a thread palette from a document such as a .pdf or a thread 
ÍÁÎÕÆÁÃÔÕÒÅÒȭÓ ×ÅÂÐÁÇÅȢ  

Note: Once the color grabber is active, use the spacebar to pick up a color under the mouse 
cursor.  

Use the spacebar to pick up a color from another open program (which might steal normal mouse 
clicks). The spacebar also lets you pick up a color without finalizing the selection ɀ in case you have an 
ÁÒÅÁ ×ÈÅÒÅ ÔÈÅÒÅȭÓ Á ÇÒÁÄÁÔÉÏÎ ÉÎ ÔÈÅ ÃÏÌÏÒ ÂÅÉÎÇ ÓÅÌÅÃÔÅÄȟ ÙÏÕ ÃÁÎ ÒÅ-select until you have the best color 
match. 

The color picker selects a small area of pixels under the cursor and averages them. This is useful for 
images with color, where prehaps not one single pixel would represent the best color match. An example 
is when you have a scan of a wound thread card, where real threads were used as samples. Light hits the 
ÔÈÒÅÁÄ ÉÎ ÓÕÃÈ Á ×ÁÙ ÁÓ ÔÈÅÒÅȭÓ ÎÏ ȬÓÉÎÇÌÅȭ ÃÏÌÏÒ ÒÅÐÒÅÓÅÎÔÅÄȢ )Î ÓÕÃÈ Á ÃÁÓÅȟ ÍÏÖÅ ÔÈÅ ÃÕÒÓÏÒ ÁÒÏÕÎÄ ÁÎÄ 
click space again to try to get the best average color. With any color block, such as a normal colored 
ÓÑÕÁÒÅ ÏÎ Á ÔÙÐÉÃÁÌ ÍÁÎÕÆÁÃÔÕÒÅÒȭÓ ÔÈÒÅÁÄ 0$&ȟ ÓÉÍÐÌÙ ÃÌÉÃË ÉÎ ÔÈÅ square, not at the edge. 

To finalize the color selection (after using spacebar), hit the Enter key. This way you will not need to 
click while over another program, which may send the click to that other program. 

If you want to adjust the color visually, use the HSV (Hue, Saturation, Value) sliders until you get a 
color that you like. 

    

Left: A typical thread list.                                 Right: A variegated color in a user palette.  

Thread Weight  

The thickness of thread varies, naturally, and that thickness affects embroidery in terms of needle 
requirement and coverage. The program does make use of thread weight for a few bits of automatic 
process: particularly short-stitching which happens when a satin stitch turns very tightly. 

The program assumes normal weights of thread unless you tell it otherwise. You can do this by 
naming any threads with a weight, ex: Somethread 12wt. The program will notice the label of the thread 
and adjust things like short-stitching automatically.  

For a more in-depth explanation of thread weight, refer to the Color section of this manual. 
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Importing .CSV files (Essentials+Enthusiast, StitchArtist)  

 

File of type .CSV (Comma delimited text files) can now be imported. Use the rightmost button 
on the toolbar. Name the file with the brand name of the thread, and it will import using that 
name. You can save it later as anything you like, of course. 

 

The format must be as follows, for each thread, each thread on its own the line: 

 Thread Number, Thread Name, Red, Green, Blue 

If no thread name is available, leave it blank, but always have the four commas. 

1000,,0,0,0 

The red, green and blue values should be in the range of 0 ɀ 255. Most manufacturers have 
2'" ÃÏÄÅÓ ÁÎÄ ÔÈÅÙȭÒÅ ÁÌ×ÁÙÓ ÉÎ ÔÈÉÓ ÒÁÎÇÅȢ 
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Multi -Position Hooping  (Essentials, Enthusiast)  

SO, YOU SAW IT ON THE INTERNET AND HAD TO HAVE IT. 

"54 )4ȭ3 4// ")' &/2 9/52 -!#().%ȣ 

Essentials and Enthusiast  have our patented design splitting technology built into it. This system 
automatically splits designs into multiple positions for sewing as separate designs that tile together to 
make a larger design. In the past, splitting a design took hours of editing by a person schooled in the 
process. 

Our splitting feature ÄÒÁÓÔÉÃÁÌÌÙ ÒÅÄÕÃÅÓ ÔÈÅ ÖÉÓÉÂÌÅ ȬÓÅÁÍÓȭ ÔÈÁÔ ÏÃÃÕÒ ÆÒÏÍ ÍÁÎÕÁÌÌÙ ÓÐÌÉÔÔÉÎÇ ÆÉÌÅÓ 
using an editor. In most cases, the final product is indistinguishable from one created on a larger-field 
machine. 

Note: StitchArtist has multi -position hoops for the sole purpose of digitizing to accommodate 
them. You can digitize the design as a whole, and then separate designs and add 
alignment lines as needed.  StitchArtist does not include auto -splitting o f designs. 

Some hoops have multiple positions. This means that you only hoop the fabric once and generate 
the design by sewing it in those multiple sections. However, you can achieve the same result by re-
hooping the fabric multiple times to create the desÉÇÎȢ 7Å ÃÁÌÌ ÔÈÉÓ Á Ȱ6ÉÒÔÕÁÌ (ÏÏÐȢȱ 4ÈÅ %ÓÓÅÎÔÉÁÌÓ 
version of the program comes with many hoops and virtual hoops pre-defined. The Enthusiast version 
has creation and editing of these hoops as well. 

When sewing designs in multiple sections, often the question of alignment comes up. This is 
accomplished automatically with multi-position hoops, but to make it easier for regular hoops, the 
program will add basting stitches that will align the designs. To choose a hoop, click the preferences 
button on the toolbar, and the Hoops window will appear: 

 

The Multi-Position hoops are separated from the Normal hoops, and you click on the Hoop Style to 
select the list you want to see. Here is the Jumbo Frame: 
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Sewing  Multi -Position Designs  

9ÏÕȭÌÌ ÎÏÔÉÃÅ ÔÈat this hoop has two rectangles that overlap in the middle. Each of these represents a 
sewing field. To make it more obvious which lines represent which field, the inside of each rectangle has a 
dotted line indicating the inside of the field. 

If you are combining designs to make a composition, it is always going to give the best result if you 
keep whole designs into one region. This produces a split that will have the least effect on the actual 
stitches on the design. Of course, this is not necessary, however, as the design may be split even if it lies in 
the middle of the hoop, but some splitting would have to occur. 

4ÈÅ ȬϹȭ ÍÁÒËÓ ÓÈÏ×Î ÉÎÄÉÃÁÔÅ ÔÈÅ ÃÅÎÔÅÒÓ ÏÆ ÔÈÅ ÓÅ×ÉÎÇ ÆÉÅÌÄÓȢ  

Note: If you look at the Hoop in the selection window you will see a note that the design centers 
are offset from each other. This means that when you sew the two sections, the centers of 
each design will be separated by that amount. This is your initial placem ent method for 
each design. 

 

In order to position your design, it is always advisable to print an actual template of the design. This 
helps you visualize what it will look like once embroidered, and it will help define the center position of 
the design on the fabric. Once you have the center of the overall design, then you will want to mark the 
centers for the individual fields. In the example above, this would mean that you mark the fabric 5 cm. 
from the center on both the left and right of the design center. This places the two designs 10 cm. apart. 
This basic positioning will help you get the result onto the fabric where you want it to go. 

Multiple Hooping  

Multiple Hooping is the process of creating a large embroidery design by re-hooping the fabric 
as you embroider each section. Multiple Hooping is an art that requires a complete understanding 
of what you are doing, as well as an excellent ability for placing your fabric in the hoop. It is not a 
method that should be practiced by the timid. You can split designs for Multiple Hooping by 
creating your own hoop: 

Suppose you have a design that is 9 inches high and 8 inches wide. Also, suppose that your 
machine will embroider a region 9 inches high and 6 inches wide. (These are typical values for 
ÔÏÄÁÙȭÓ ÍÁÃÈÉnes.) What you want to do is to create a two-position hoop to accomplish the split. 

Create a hoop that is 9 inches high, with two positions. The separation should be set to allow 
the greatest possible overlap between the two regions: 8 inches (desired) - 6 inches (a single hoop 
width) = 2 inches. 

! ÓÅÐÁÒÁÔÉÏÎ ÏÆ ςȱ ×ÏÕÌÄ ÂÅ ÔÈÅ ÓÍÁÌÌÅÓÔ ÐÏÓÓÉÂÌÅ ÆÏÒ ÔÈÅ ÄÅÓÉÒÅÄ ψ-inch width, and would 
provide the greatest overlap of the regions.  

Note: The use of columns allows side-by-side multiple-ÐÏÓÉÔÉÏÎ ÈÏÏÐÓȢ )ÔȭÓ Á Ìot of 
embroidering, but it looks good and can easily fill a jacket back. 

It is very important to mark your fabric before embroidering. When the fabric is re-hooped, it 
must be parallel and centered to the first hooping. Also, the distance between the centers needs to 
be precise. (This is 2 inches in this example.) 



The Embrilliance Platform  

76 

)Æ ÉÔ ÉÓ ÐÏÓÓÉÂÌÅȟ ×Å ÅÎÃÏÕÒÁÇÅ ÔÈÅ ÕÓÅ ÏÆ Ȭ&ÌÏÁÔÉÎÇȭ ÔÅÃÈÎÉÑÕÅÓ ÆÏÒ ÈÏÏÐÉÎÇȡ ÎÏÔ ÁÃÔÕÁÌÌÙ ÈÏÏÐÉÎÇ 
the material itself, but rather hooping a stabilizer and attaching the fabric to it with adhesive 
and/or a basting stitch. This will provide the least distortion in the fabric while the overlapped 
regions of the design are being embroidered. One easy method, if your material can handle it, is to 
use carpet tape (double-sided and very sticky) on the bottom of your tightened hoop. This can 
then be perfectly aligned and pressed into place. (The adhesive comes off with a lot of water-
soluble solvents and even soapy water will usually work.) 

Remember:  

It is a really good idea to take a class on this type of process to get the hang of it, and practice 
before moving on to an actual project! 

Output Files  

When you save your files, the output files represent each region of your design. 

The files are automatically given names indicating their stitching order as well as the position 
×ÉÔÈÉÎ ÔÈÅ ÈÏÏÐȢ &ÏÒ ÉÎÓÔÁÎÃÅȟ Ȱ2ÏÓÅȢ0ÅÓȱ ÍÁÙ ÓÐÌÉÔ ÉÎÔÏ Ȱ2ÏÓÅ 4ÏÐ ΠρȢ0ÅÓȱ ÁÎÄ Ȱ2ÏÓÅ "ÏÔÔÏÍ ΠςȢ0ÅÓȱȢ  

Additionally, you may get a text file that explains the color sequence for your new files. In many 
designs, a color is only needed in one region. Where this is the case, that color will not exist in all the 
ÏÕÔÐÕÔ ÆÉÌÅÓȢ 4Ï ÈÅÌÐ ÒÅÄÕÃÅ ÔÈÉÓ Ȱ#ÏÌÏÒ #ÏÎÆÕÓÉÏÎȱȟ Á ÔÅØÔ ÆÉÌÅ ÉÓ ÃÒÅÁÔÅÄ ×ÉÔÈ Á ÔÁÂÌÅȢ 4ÈÅ ÆÏÌÌÏ×ÉÎÇ ÉÓ ÔÅØÔ 
from an example file: 

Ȱ2ÏÓÅÓȢ0ÅÓ 

Your original file had 3 colors.   

The program has split your file into 2 segments. 

This cross-reference has been created for you because some thread colors in the original file were 
not needed in some of the split segments. 

File: C:\ Roses Top #1.PES 

Color 1 = original color 1 

Color 2 = original color 2 

Color 3 = original color 3 

Color 4 = original color 4 

Color 5 = original color 5 

File: C:\ Roses Bottom #2.PES 

Color 1 = original color 1 

Color 2 = original color 2 

Color 3 = original color 3 

(ÁÐÐÙ %ÍÂÒÏÉÄÅÒÉÎÇȦȱ 

As you can see, the table is easy to follow. Since this is a text file, you can also edit it (double-click to 
launch Notepad), print it, etc. It is a good idea to add any real thread numbers or names if you have them. 
Often, the digitizer of a design will supply a real-color thread list for this purpose. 

We cannot stress enough the fact that the order of embroidering the files is important.  
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The files will overlap each other as they sew. If you embroider out-of-order you will get overlapping 
that is incorrect, and parts of your design will not be visible! 

Region Naming  

On hoops that have three positions, the regions are named for you: Top, Center and Bottom. On 
hoops that have more positions, the other positions are given numbers, starting at the top. Hence, you 
might have a hoop withȡ 4ÏÐȟ 0ÏÓȢ ςȟ #ÅÎÔÅÒȟ 0ÏÓȢ τ ÁÎÄ "ÏÔÔÏÍȢ #ÏÌÕÍÎÓ ÈÁÖÅ ÎÁÍÅÓ ÌÉËÅ Ȱ,ÅÆÔȱȟ Ȱ2ÉÇÈÔȱ 
ÏÒ Ȱ#ςȱȢ 

Getting Best Results  

To get the best results, there are some things you should know. 

First is that you should trim your jump stitches as you go, if your machine does not do it 
automatically. This is true in the course of normal embroidery, but somewhat necessary when 
embroidering a split design. When splitting a design, it is natural that the machine will have to go from 
place to place a little more frequently. This results in extra jump stitches. We have made every effort to 
minimize the amount of effort that it takes to split embroidery files, and apologize for any inconvenience 
this may cause, but please accept our assurance that your finished product will have a nicer appearance if 
you clean the jumps from the design. 

If you are using an appliqué design, you will need to embroider each color in each region before 
moving on to the next color. This will ensure that the full appliqué can be applied without incorrect 
oversewing by the other colors.  

There is a compensation control in the Hoop Properties window. This control is available on all 
hoops, even the factory-defined ones. Compensation is the amount that each region will overlap the 
neighboring regions. This is used to correct for the fact that fabric will shrink as it is embroidered. 
Additionally, an imperfectly hooped project will allow registration problems to occur. If you are not able 
ÔÏ ÈÏÏÐ ÙÏÕÒ ÆÁÂÒÉÃȟ Ȭ$ÒÕÍ-ÔÉÇÈÔȭȟ ÔÈÅÎ ÙÏÕ ÍÁÙ ×ÁÎÔ ÔÏ ÉÎÃÒÅÁÓe the compensation setting for your hoop. 

Important:  )Æ ÙÏÕ ÁÒÅ ÉÎÃÒÅÁÓÉÎÇ ÔÈÅ ÓÉÚÅ ÏÆ Á ÄÅÓÉÇÎȟ ÐÌÅÁÓÅ ÄÏÎȭÔ ÉÎÃÒÅÁÓÅ ÔÈÅ ÓÉÚÅ ÍÏÒÅ ÔÈÁÎ ÙÏÕ 
will actually need for your hoop.  

Note: 4ÈÅÒÅ ÉÓ Á ÖÅÒÙ ÉÍÐÏÒÔÁÎÔ ÐÈÒÁÓÅ ÉÎ ÔÈÅ ÃÏÍÐÕÔÅÒ ÉÎÄÕÓÔÒÙȡ Ȱ'ÁÒÂÁÇÅ ÉÎȟ ÇÁrbage out.  
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Editing the Hoops  (Enthusiast)  

When you click the Ȱ.Å×ȱ ÏÒ ȰEditȱ ÂÕÔÔÏÎ ÉÎ ÔÈÅ (ÏÏÐÓ !ÖÁÉÌÁÂÌÅ ×ÉÎÄÏ×ȟ ÙÏÕ ×ÉÌÌ ÓÅÅ ÔÈÉÓ 
screen: 

 

EXPLANATION OF FIELDS: 

Å  4ÈÅ ÆÉÒÓÔ ÆÉÅÌÄ ÉÎ ÔÈÉÓ ×ÉÎÄÏ× ÉÓ ÔÈÅ Ȭ(ÏÏÐ .ÁÍÅȭȢ 4ÈÉÓ ÉÓ ÊÕÓÔ ×ÈÁÔ ÉÔ ÓÏÕÎÄÓ like. Type in whatever 
name you want. 

Å  .ÅØÔȟ ÃÈÏÏÓÅ ÔÈÅ Ȭ&ÉÌÅ 4ÙÐÅȭ ÏÆ ÔÈÅ ÍÁÃÈÉÎÅ ÔÈÁÔ ÔÈÉÓ ÈÏÏÐ ×ÏÒËÓ ÏÎȢ 4ÈÅ ÌÉÓÔ ÃÏÎÔÁÉÎÓ ÔÈÅ ÆÉÌÅ ÔÙÐÅÓ 
that can be saved. 

Å  4ÈÅ Ȭ)ÎÄÉÖÉÄÕÁÌ &ÉÅÌÄ 3ÉÚÅȭ ÉÓ ÔÈÅ ÓÉÚÅ ɉÉÎ ÍÍɊ ÔÈÁÔ ÙÏÕÒ ÅÍÂÒÏÉÄÅÒÙ ÍÁÃÈÉÎÅ ÃÁÎ ÃÒÅÁÔÅ ×ÉÔÈ Á 
single hoop position. If you are unsure about this size, consult your dealer. 

Å  4ÈÅ Ȭ2Ï×Óȭ ÆÉÅÌÄ ÓÐÅÃÉÆÉÅÓ ÔÈÅ ÎÕÍÂÅÒ ÏÆ ÖÅÒÔÉÃÁÌ ÐÏÉÎÔÓ ÁÔ ×ÈÉÃÈ ÔÈÅ ÈÏÏÐ ÃÁÎ ÂÅ ÁÔÔÁÃÈÅÄ ÔÏ ÙÏÕÒ 
machine. For most multi-position hoops, this number is three. For sliding hoops such as those 
made by Hoop-It -All, you will have to determine how many sections you want to embroider in. In 
so doing, however, keep in mind that there should be a good overlap between adjoining sections. 
5ÓÅ ÔÈÅ ÈÏÏÐÓ ×ÅȭÖÅ ÐÒÏÖÉÄÅÄ ÁÓ ÅØÁÍÐÌÅÓȢ 

Å  4ÈÅ Ȭ#ÏÌÕÍÎÓȭ ÆÉÅÌÄ ÓÐÅÃÉÆÉÅÓ ÔÈÅ ÎÕÍÂÅÒ ÏÆ ÐÏÉÎÔÓ ÁÔ ×ÈÉÃÈ ÔÈÅ ÈÏÏÐ ÃÁÎ ÂÅ ÁÔÔÁÃÈÅÄ ÔÏ ÙÏÕÒ 
machine sideways. For most hoops, this number is one, but there are exceptions on the market. 
4ÈÅÓÅ ÁÒÅ ÕÓÕÁÌÌÙ ÄÅÓÃÒÉÂÅÄ ÁÓ Ȱ$ÏÕÂÌÅ-7ÉÄÅȱȢ 9ÏÕ ÃÁÎ ÁÌÓÏ ÕÓÅ ÔÈÅ ÃÏÌÕÍÎÓ ÔÏ Éndicate that you 
want to divide the design into horizontally-tiled segments. 

Å  4ÈÅ Ȭ3ÅÐÁÒÁÔÉÏÎȭ ÆÉÅÌÄÓ ÓÐÅÃÉÆÙ ÔÈÅ ÄÉÓÔÁÎÃÅ ÂÅÔ×ÅÅÎ ÔÈÅ ÈÏÏÐ ÐÏÓÉÔÉÏÎÓȢ ɉ&ÏÒ ÅØÁÍÐÌÅȟ ÔÈÅ ÄÉÓÔÁÎÃÅ 
from needle-center of the top position to the needle-center of the middle position.) This can be 
measured physically if you do not know: hoop a piece of paper and drop the needle through it, in all 
ÈÏÏÐ ÐÏÓÉÔÉÏÎÓȟ ÍÅÁÓÕÒÉÎÇ ÔÈÅ ÄÉÓÔÁÎÃÅ ÂÅÔ×ÅÅÎ ÔÈÅ ÈÏÌÅÓȢ !ÌÔÅÒÎÁÔÅÌÙȟ ÍÏÓÔ ÍÁÎÕÆÁÃÔÕÒÅÒÓȭ 
software will show a grid behind the hoop on the screen. You can count the grids (usually 1 grid = 
10mm) between the region marks to get the separation. It is very important that you correctly 
assign the separation; otherwise, the design will not be split accurately. 

Å  4ÈÅ Ȭ2ÉÇÈÔ-to-,ÅÆÔȭ ÆÉÅÌÄ ÉÓ ÕÓÅÄ for multi -ÃÏÌÕÍÎ ÈÏÏÐÓ ɉȬ$ÏÕÂÌÅ-7ÉÄÅȭɊȢ )Ô ÉÎÄÉÃÁÔÅÓ ÔÈÁÔ ÔÈÅ ÉÎÉÔÉÁÌ 
direction the program will split the design will be right-to-left, as opposed to the standard, left-to-
right. The use of this depends on the machine and hoop. Some manufacturers have wide hoops that 
start by sewing the left side of the design upside-down, then you turn the hoop halfway around and 
embroider the other side (now the right side, and the design is right-side-up). Hence, the default, 
Ȭ,ÅÆÔ-to-Right.  
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NOTE: You can tell if your separation figure is correct! The manufacturer of the hoop will 
definitely provide you with the number of positions used as well as the full size of the 
ÅÍÂÒÏÉÄÅÒÉÎÇ ÒÅÇÉÏÎ ÏÆ ÔÈÅ ÈÏÏÐȢ !Ó ÙÏÕ ÁÄÊÕÓÔ ÔÈÅ ÓÅÐÁÒÁÔÉÏÎȟ ÔÈÅ ÆÉÅÌÄȟ Ȱ/ÖÅÒÁÌÌ 3ÉÚÅȱ ÉÓ 
calculated.  If this matches the figure given to you by the manufacturer, you have 
correctly set your separation.  

Å  Ȭ#ÏÍÐÅÎÓÁÔÉÏÎȭ ÁÌÌÏ×Ó ÔÈÅ ÆÉÎÁÌ ÒÅÇÉÏÎÓ ÔÏ ÂÅ ÓÌÉÇÈÔÌÙ ÉÎÃÒÅÁÓÅÄ ÉÎ ÓÉÚÅȢ 4ÈÉÓ ÆÏÒÃÅÓ ÔÈÅ ÒÅÇÉÏÎÓ ÔÏ 
overlap each other. This is useful because as the machine adds stitches, the fabric gathers slightly. 
It is entirely possible to have a gap between regions if no compensation were to be used. The 
amount of compensation required depends on several factors: The size of the hoop, the fabric being 
embroidered, the number of stitches, the quality of the stabilization, etc. We have chosen some 
settings for our factory hoops that have worked well in our design testing. Please embroider some 
test designs with the desired hoop before tackling a project. This will ensure that you have a 
reasonable setting for your compensation. 

Å  Ȭ#ÏÌÏÒ-by-#ÏÌÏÒȭ ÄÅÎÏÔÅÓ Á ÄÉÆÆÅÒÅÎÔ ÔÙÐÅ ÏÆ ÆÉÌÅ ÓÐÌÉÔÔÉÎÇȢ !Ó ÏÆ ÔÈÉÓ ×ÒÉÔÉÎÇȟ ÏÎÌÙ ÔÈÅ 6ÉËÉÎÇ -ÅÇÁ 
(ÏÏÐΆ ÁÌÌÏ×Ó ÆÏÒ ÔÈÉÓ ÔÙÐÅ ÏÆ ÄÅÓÉÇÎ ÓÐÌÉÔÔÉÎÇȟ ÓÏ ÁÓ Á ÇÅÎÅÒÁÌ ÒÕÌÅȟ ÎÅÖÅÒ ÃÈÅÃË ÔÈÉÓ ÂÏØȢ 4he Color-
by-Color method is for use in machines that can sew each color in all of the hoop regions before 
going on to the next color. When the machine operates this way, it will stitch in its current region 
until it no longer can. It will then stop and ask the user to reposition the hoop, whereupon it will 
continue stitching. In the case of most designs, this will cause a lot of position switching as a color 
typically stitches objects out in a random fashion all over the design. The program ×ÉÌÌ ȬÓÏÒÔȭ ÔÈÅ 
stitch objects to reduce the number of position-switches required. 

Å  Ȭ)ÎÖÅÒÔ !ÌÔÅÒÎÁÔÅ #ÏÌÕÍÎȭ ÉÓ ÕÓÅÄ ÆÏÒ Ȭ$ÏÕÂÌÅ-7ÉÄÅȭ ÈÏÏÐÓ ÔÈÁÔ ÇÅÔ ÔÕÒÎÅÄ ÕÐÓÉÄÅ-down for their 
second row.  

Å  Ȭ!ÄÄ ÂÁÓÔÉÎÇ ÁÌÉÇÎÍÅÎÔ ÌÉÎÅÓȭ will provide a basted line of stitching to each output file. These lines 
of stitching will have their end and/or center points line up on the fabric when you go to stitch out 
the designs. If the lines do not line up, then adjust your hoop/fabric position until they do. 

Å  Ȭ"ÁÓÔÅ ,ÅÎÇÔÈȭ ÓÅÔÓ ÔÈÅ ÓÉÚÅ ÏÆ ÔÈÅ ÁÌÉÇÎÍÅÎÔ ÌÉÎÅ ÓÔÉÔÃÈÉÎÇȟ ÉÎ ÍÍȢ 

/ÎÃÅ ÙÏÕ ÈÁÖÅ ÆÉÎÉÓÈÅÄ ÃÒÅÁÔÉÎÇ ÏÒ ÅÄÉÔÉÎÇ ÙÏÕÒ ÈÏÏÐȟ ÓÉÍÐÌÙ ÃÌÉÃËȟ Ȭ3ÁÖÅȭ ÔÏ ÓÁÖÅ ÉÔȢ 

If it is a new hoop, it will appear in the Hoop Available window. 

Split into  Hoop (En thusiast)  

9ÏÕ ÃÁÎ ÓÐÌÉÔ ÔÈÅ ÄÅÓÉÇÎ ÕÓÉÎÇ Ȱ3ÐÌÉÔ into (ÏÏÐȱ ÆÒÏÍ ÔÈÅ 5ÔÉÌÉÔÙ ÍÅÎÕȢ 4ÈÉÓ ÏÐÅÎs a new design page 
with the split files so that you can preview them or do other work before saving. 9ÏÕ ÄÏÎȭÔ ÓÁÖÅ ÔÈÅ ÎÅ× 
split page: It is for preview only. Save the original page, and the result will be multiple files. 

     

Left: A single design placed on a 100x172 hoop.  Right: The design has been split. 
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In the example above, the 100 x 172 PES hoop was chosen, and the design was centered in it. Then 
the menu item, Utility->Split into Hoop was chosen. This created a new design page, represented by a 
new tab. In that page there are two designs, one for the top hoop section, and one for the bottom. Using 
ghost mode, we show the designs separately: 

 

    

Left: The top design is selected.   Right: The bottom design is selected. 

Stitch Properties  (Essentials/Enthusiast)  

The stitch properties tab appears when a stitch design is selected. There are controls where 
you can add or remove up to 25% of the stitches by increasing or decreasing the density of the 
selected items. The slider controls will separately allow the adjustment of satin stitching and fill 
stitching, which allows very specific control. 

 

If you are a DRK user, there are additional controls that  also tie in to the Project Advisor and the 
Project  system.  
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Product: Essentials Ê 

The idea behind Essentials is to include the features, which are essential for every embroiderer, yet 
not to overwhelm the user with unnecessary extras. It is designed to be simple and easy, yet powerful 
enough to accommodate the person who wants to do more than simply using existing designs.  The 
feature packs are additional programs that you may purchase to add on to your Embrilliance Essentials to 
make it YOUR software.  No need to learn a new program!  You simply add new features and functions as 
you want them to your existing software.  

The Essential Features: 

Å  12 Fonts for multi-line text, monogramming and circle text. 
Å  Sample designs, which are scalable and recalculate their stitches as you interactively transform 

them. 

Å  Unlimited lines of letters or monograms and embroidery designs can be combined. 

Å  You can mix and match fonts and sizes. 

Å  Merge existing embroidery files into your design. 
Å  Overlap designs ɀ even appliques ɀ and have hidden stitching removed. 

Å  Browse and Merge designs in folders and from inside .ZIP files. 
Å  Resize existing embroidery files with stitch recalculation. You can resize embroidery designs up to 

250% and down to 50%. 
Å  Colorize any embroidery design. You can change the colors one at a time, or convert the entire 

design or any selected part of it to your preferred thread brand with just a few mouse clicks. 
Å  Simulate the sewing of any design. The simulator can play in 3D, play forward and backward, and 

has variable speed. The simulator also has a slider so that you can manually scroll forward and 
backward through the design to any point without waiting. You can even insert a color stop in the 
sewing process. 

Å  Convert any design from one format to any of the supported types, which include: 
Å  Read: ART, CND, CSD, DST, DSZ, EMD, EXP, EXP+, GNC, HUS, JAN, JEF, JEF+, PCM, PCS, PEC, PES, 

PHC, SEW, SHV, TAP, VIP, VP3, XXX, EMB. 

Å  Write: CSD, DST, DSZ, EXP, EXP+, HUS, JEF, PCS, PES (v1-9), PCM, SEW, SHV, TAP, VIP, VP3, XXX. 
Å  Designer 1 Disk Utility for floppy and USB machines. 

Å  Split designs for several multi-position hoops, including the Brother/Baby Lock 100x100 machines, and the 

ρτȱ Ø ρτȱ *ÕÍÂÏ (ÏÏÐȢ  

Å  Project Advisor, a patented expert system with guidance to help successful embroidery on all your projects. 

Å  Install .BX files, the industry standard for distributing fonts in a ready-to-type format. 

Å  Create working files (.BE extension) to save your design as an editable and merge-able file. Your 
workÉÎÇ ÆÉÌÅ ÉÓ ÓÁÖÅÄ ÆÏÒ ÙÏÕ ÁÕÔÏÍÁÔÉÃÁÌÌÙ ×ÈÅÎ ÙÏÕ ÓÁÖÅ Á ÓÔÉÔÃÈ ÆÉÌÅ ÓÏ ÙÏÕ ÄÏÎȭÔ ÈÁÖÅ ÔÏ Ȭ3ÁÖÅȭ 
twice every time you make some changesɂonce for the stitch file and once for the working file. 

Å  %ÍÂÒÉÌÌÉÁÎÃÅ ÈÁÓ ÁÎ ÁÄÖÁÎÃÅÄ ÐÒÏÇÒÁÍ ÉÎÔÅÒÆÁÃÅ ÔÈÁÔȭÓ ÓÕÐÅÒ ÅÁÓÙ ÔÏ ÕÓÅ ÙÅÔ ÏÆÆÅÒÓ ÆÅÁÔÕÒÅÓ 
normally reserved for very expensive programs. 

Å  Real Scale zooming allows you to view your designs on screen at the actual size that they will stitch 
out. 

Å  .ÁÖÉÇÁÔÉÏÎ 7ÉÎÄÏ× ÔÈÁÔ ÐÒÏÖÉÄÅÓ ÉÎÓÔÁÎÔ ÃÏÎÔÒÏÌ ÏÖÅÒ ÔÈÅ ÚÏÏÍ ÁÎÄ ÓÃÒÏÌÌ ÉÎ ÔÈÅ ÐÒÏÇÒÁÍȭÓ ÖÉÅ×Ȣ 
Å  Sewing Order control allows you to re-sequence the designs to sew in the order you want them to 

sew. 
Å  Color Sorting control to intelligently reduce the number of extra color changes. 

Å  Adjustable Mouse Wheel attribute for Zoom or Scroll. 

Å  Simple centering in the hoop plus advanced alignment. 
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Å  Thread Palette creation and thread inventory system. 

Å  Basting designs. 

Å  Automatically check for updates. 

Resizing  

Essentials has a technology known as a stitch processor that lets you resize existing stitch files 
upward to 250% and downward to 50%. 

This recalculation of the stitches allows even lettering designs that have been added with a BX font 
or AlphaTricks to be scaled and stitches recalculated. 

When sizing using handles in the Main View, stitches are recalculated ɀ if you hold down the Ctrl key 
while dragging, recalculation is disabled for that drag (which can be useful to very simply lighten the 
density in a design a bit). 

4ÈÅ ÐÒÏÃÅÓÓ ÏÆ ÒÅÃÁÌÃÕÌÁÔÉÏÎ ÉÓ ÔÏ ÁÄÄ ÍÏÒÅ ȬÌÉÎÅÓȭ ÏÆ ÓÔÉÔÃÈÉÎÇ ÉÎ ÔÈÅ ÓÁÔÉÎ ÁÎÄ ÆÉÌÌ ÁÒÅÁÓ ÏÆ Á ÄÅÓÉÇÎȢ 
They may even be curved fill lines, or lines with carved areas such as pattern fills. The sizing engine will 
preserve the look of the fill while keeping the density the same as it was when the design was at its 
original size. 

You can size, resize and resize again in Essentials, as the original design is kept behind the scenes 
and is always re-referenced when creating a new size. 

When sizing with the handles in the Main View, the upper and lower limits of percentage are limited 
to help prevent overly-distorted designs. You may override this using the size boxes on the Tool Pane 
which let you specify a size. 

Sizing Properties  

When you resize a regular stitch file, the density would normally get more or less dense, but 
Embrilliance will recalculate the stitches for you automatically. 

 

That recalculation process is complex and difficult, so there are some settings you can adjust to 
achieve optimal results.  

Use the Preferences button on the main toolbar to adjust the sizing settings. 

The sensitivity slider is used to control how well the program discovers fills and satin stitches. If you 
have a design that has a lot of manually created stitch effects, then you may want the sensitivity higher, 
×ÈÅÒÅÁÓ ÎÏÒÍÁÌ ÄÅÓÉÇÎÓ ÔÈÁÔ ÁÒÅ ÄÉÇÉÔÉÚÅÄ ×ÉÔÈ ÏÂÊÅÃÔÓ ÌÉËÅ ÆÉÌÌÓ ÐÒÏÂÁÂÌÙ ÄÏÎȭÔ ÎÅÅÄ ÓÏ ÍÕÃÈ ÓÅÎÓÉÔÉÖÉÔÙȟ 
especially if there is blending going on. 

Å  Gap Reduction is a function within the  software that helps adjacent areas lessen gaps that might 
be exposed or widen during increases in size. 
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Å  The stitch length filters are used to prevent loopy stitches on the fabric from stitch elongation, 
and in the other direction, small stitches from gathering on the fabric making too many 
perforations or simply bunching up the fabric. 

The settings are broken out by stitch type because the handling of satin stitches is special and you 
may want to achieve a split-satin look at a certain size. 

Color Sorting  

The Ȱ(ÁÐÐÙ "ÉÒÔÈÄÁÙȱ design has 6 unique colors but 13 color stops. To make it more efficient for 
sewing, you might like to optimize the sewing order to reduce extra color changes.  

Because letters added together are considered one oÂÊÅÃÔȟ ÙÏÕ ÃÁÎȭÔ ÓÅÌÅÃÔÉÖÅÌÙ ÒÅÁÒÒÁÎÇÅ ÔÈÅÍ ÉÎ 
the object tree. Fortunately, there is easier method accomplished via Color Sort. 

Use the ȬColor Sortȭ choice on the Utility menu, which displays the following dialog window: 

 

Notice our design has been reduced by 7 colors. 

!Ô ÔÈÅ ÔÏÐ ÏÆ ÔÈÅ ×ÉÎÄÏ×ȟ ÙÏÕȭÌÌ ÓÅÅ ÔÈÅ ÒÅÓÕÌÔ ÏÆ ÔÈÅ ÓÏÒÔȢ .ÏÔÉÃÅ ÔÈÁÔ ÃÏÌÏÒ ÓÔÏÐÓ ÍÁÙ ÂÅ ÒÅÄÕÃÅÄ 
(the basic reason for sorting) but you can also wind up with a sorted applique design that keeps the same 
number of stops. In that case you may ÓÅÅ Á ÍÅÓÓÁÇÅȟ Ȱ4ÈÅ ÄÅÓÉÇÎ ÈÁÓ ÂÅÅÎ ÓÏÒÔÅÄ ÂÕÔ ÎÏÔ ÒÅÄÕÃÅÄȢȱ 2ÅÁÄ 
ÍÏÒÅ ÁÂÏÕÔ Ȭ+ÅÅÐ #ÏÌÏÒ 3ÔÏÐȭ ÂÅÌÏ× ÔÏ ÕÎÄÅÒÓÔÁÎÄ ÔÈÉÓȢ 

#ÌÉÃË Ȭ.Å× 6ÉÅ×ȭ ÔÏ ÏÐÅÎ Á ÎÅ× ÄÅÓÉÇÎ ÐÁÇÅ ×ÉÔÈ ÔÈÅ ÓÏÒÔÅÄ ÒÅÓÕÌÔȢ 4ÈÉÓ ÉÓ ÕÓÅÆÕÌ ÔÏ ÃÈÅÃË ×ÈÁÔ 
youȭÒÅ ÄÏÎÅ ÂÅÆÏÒÅ ÓÁÖÉÎÇ ÔÈÅ ÄÅÓÉÇÎȢ 

#ÌÉÃË Ȭ3ÁÖÅ )Ôȣȭ ÔÏ ÓÁÖÅ ÔÈÅ ÃÏÌÏÒ ÓÏÒÔÅÄ ÆÉÌÅ ÁÓ Á ÓÔÉÔÃÈ ÆÉÌÅȢ )Æ ÙÏÕ ÄÏÎȭÔ ÃÈÁÎÇÅ ÔÈÅ ÎÁÍÅȟ the program 
×ÉÌÌ ÁÐÐÅÎÄ ȰͺÓÏÒÔÅÄȱ ÔÏ ÔÈÅ ÅÎÄ ÏÆ ÔÈÅ ÃÕÒÒÅÎÔ ÆÉÌÅ ÎÁÍÅȢ 9ÏÕÒ ÏÒÉÇÉÎÁÌ ×ÏÒËÉÎÇ ÆÉÌÅ ɉȢ"% ÆÉÌÅɊ ÉÓ ÐÒÅÓÅÒÖÅÄ 
and not changed. 

There are some additional controls available for more precise handling of the design page during 
the sort process: 

¶ Ȭ2(3 0ÒÅ-3ÏÒÔȭ ×ÉÌÌ ÐÒÏÃÅÓÓ ÔÈÅ 2ÅÍÏÖÅ (ÉÄÄÅÎ 3ÔÉÔÃÈÅÓ ÆÕÎÃÔÉÏÎ ÂÅÆÏÒÅ ÓÏÒÔÉÎÇȢ 4ÈÉÓ ÉÓ 
ÔÈÅ ÓÁÍÅ ÁÓ ÉÆ ÙÏÕ ÈÉÔ ÔÈÅ 2(3 ȬÓÃÉÓÓÏÒÓȭ ÂÕÔÔÏÎ ÏÎ ÔÈÅ ÍÁÉÎ ÔÏÏÌÂÁÒȢ )Ô ÉÓ ÕÓÅÆÕÌ ÔÏ ÄÏ ÔÈÉÓ 
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sometimes, as those stitches being removed could have affected layering. By removing 
them, the chances of the layers moving together are greater. 

¶ Ȭ&ÏÒÃÅ !ÐÐÌÉÑÕÅȭ ×ÉÌÌ ÍÁËÅ ÔÈÅ ÁÐÐÌÉÑÕÅ 0ÏÓÉÔÉÏÎ ÁÎÄȾÏÒ Material steps sort together 
regardless of layering issues. This is used on things like lettering designs where 
overlapping can occur, but you want to run all the positions or even add the materials 
to all the letters in one stop. 

¶ Ȭ4ÏÌÅÒÁÎÃÅȭ ÃÏÎÔÒÏÌÓ ÈÏ× ÍÕÃÈ ÏÖÅÒÌÁÐ ×ÉÌÌ ÂÅ ÁÌÌÏ×ÅÄ ÉÎ ÏÒÄÅÒ ÔÏ ÓÏÒÔȢ 7ÈÉÌÅ ÉÔȭÓ ÎÏÔ 
really a percentage, it is okay to think of it that way, and the value goes from 0-100. 
7ÈÅÎ ÙÏÕ ÓÅÔ ÉÔ ÁÔ π ÔÈÅÎ ÙÏÕ ÁÒÅ ÓÁÙÉÎÇȟ Ȭ$Ï ÎÏÔ ÓÏÒÔ ÉÆ ÔÈÅ ÌÁÙÅÒÓ ×ÉÌÌ ÃÈÁÎÇÅ ÁÔ ÁÌÌȢȭ 
ConÖÅÒÓÅÌÙȟ Á ÖÁÌÕÅ ÏÆ ρππ ÍÅÁÎÓȟ Ȱ3ÏÒÔ ÔÈÅ ÃÏÌÏÒÓ ÔÏÇÅÔÈÅÒ ÎÏ ÍÁÔÔÅÒ ×ÈÁÔ ÉÔ ÌÏÏËÓ ÌÉËÅȢȭ 

KEEP COLOR STOP 

Normally, when two colors that are the same follow each other, the stop in-between those colors 
can be removed: It lets the machine continue sewing without bothering the operator. 

Certain designs, such as appliques in particular, will require that the machine stop so the operator 
can do something, such as lay down an applique. For this purpose, there is a setting on every color called 
Ȭ+ÅÅÐ #ÏÌÏÒ 3ÔÏÐȭ ×Èich is accessible by right-clicking the color chip in the Color Properties. 

 

When sorting, the program is aware of applique colors and will sort them together, but will add a 
Ȭ+ÅÅÐ #ÏÌÏÒ 3ÔÏÐȭ ÆÌÁÇ ÏÎ ÔÈÅ ÃÏÌÏÒ ÉÆ ÉÔ ÓÅÅÍÓ ÔÏ ÏÖÅÒÌÁÐ ÏÒ ÔÏÕÃÈ ÔÈÅ ÐÒÅÖÉÏÕÓ applique step. 

Color sorting can be useful in designs like this or designs that have poor sequencing. Color sorting in 
ÔÈÉÓ ÐÒÏÇÒÁÍ ÉÓ ÉÎÔÅÌÌÉÇÅÎÔȟ ÍÅÁÎÉÎÇ ÉÔ ÄÏÅÓÎȭÔ ÉÎÄÉÓÃÒÉÍÉÎÁÔÅÌÙ ÃÏÍÂÉÎÅ ÁÌÌ ÌÉËÅ ÃÏÌÏÒÓ ÔÏÇÅÔÈÅÒȢ )Ô ÌÏÏËÓ 
for layering and knows that some colors simply must be repeated.  

 

Note: Do use caution when color sorting. Some designers have intentionally added extra color 
changes either for design flexibility or to optimize registration. For this reason, always 
save the Color Sort with a differ ent name (or save the .BE file) just in case you want to go 
back to the original !  

Fit to Hoop  

 Design elements can be scaled up to the design page by selecting them and clicking the Fit 
Hoop tool. This will recalculate stitches wherever possible. There are limits, though, such as with regular 
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embroidery designs, which can only be sized up to 250%. This button will scale your design as large as it 
can go, up to the built-in limits. 

Remove Hidden Stitches  

 When designs are overlapped, there may be stitches that are hidden, which you would like to 
have removed. This process is automatically done when you save a file (controllable by preferences) but 
you may want to preview the results before saving. The Remove Hidden Stitches will run the process on 
those stitches so that you can evaluate the result. The result is temporary, however, so if you change 
anything on the design page, the stitches will return. This happens because changing a design will almost 
always regenerate its stitches. 

For applique designs, use the applique tab on the color properties to tell the program that certain 
colors are applique steps. The position and material steps will not have their stitches removed, as it is 
considered likely that you will need those stitches. However, the applique material would naturally cover 
over other stitches, and the material fill is used in the removal of earlier stitching. This is controlled by 
ÔÈÅ 0ÒÅÆÅÒÅÎÃÅ Ȱ7ÈÅÎ 3ÁÖÉÎÇȢȱ 

Project Advisor  

 The Project Advisor is a patented expert system, a form of artificial intelligence, which helps 
you select stabilizer, needles and hooping techniques for many common projects.  

The system also provides instructions, helpful how-to advice and some words of caution when 
necessary. First, you select a project from the list. If your exact project or fabric is not listed, there are 
enough choices available where you can choose something very similar. Next, you can tell the Advisor if 
your fabric has more or less stretch, and you can adjust thickness. The Advisor takes your input in 
account as it makes its recommendations that are displayed as text in the window. 

DRK users will also have the Project system, which extends the Project Advisor settings to actually 
ÁÄÊÕÓÔ ÙÏÕÒ ÄÅÓÉÇÎÓȭ ÓÔÉÔÃÈÅÓ ÆÏÒ ÔÈÅ ÃÈÏÓÅÎ ÐÒÏÊÅÃÔȢ 

 

Both the backing (under the fabric) and topping (on top of the fabric) stabilizers are 
recommended. 
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Creating a Designer 1 Disk or Stick  

  

)Æ ÙÏÕ ÈÁÖÅ Á (ÕÓÑÖÁÒÎÁ 6ÉËÉÎÇ $ÅÓÉÇÎÅÒ ÍÁÃÈÉÎÅ ÔÈÁÔ ÕÓÅÓ ÅÉÔÈÅÒ Á 53" ÓÔÉÔÃÈ ÏÒ Á σȢυȱ ÄÉÓËÅÔÔÅȟ ÙÏÕ 
can create the proper files and file structure via Utility -> Designer 1 Disk Utility. 

When the Designer 1 Disk Utility window opens, you choose whether you want to write to a diskette 
or a stick. Next, choose the menu you on which you want to store the designs. Designs are imported to 
only one menu at a time. 

 

Note: If you want to add files to a previously created Designer diskette or stick, you will need to 
first read in the designs and then add the new files to one of the menus. When a Designer 
disk or stick is writte n, it replaces any matching file and folder names.  

#ÌÉÃË ÔÈÅ Ȭ'ÅÔ $ÅÓÉÇÎsȣȭ ÂÕÔÔÏÎ ÁÎÄ ÎÁÖÉÇÁÔÅ ÔÏ ÔÈÅ ÄÅÓÉÒÅÄ ÄÅÓÉÇÎÓȢ 9ÏÕȭÌÌ ÓÅÅ ÔÈÅ ÎÏ× ÆÁÍÉÌÉÁÒ Ȭ'ÅÔ 
$ÅÓÉÇÎÓȭ ×ÉÎÄÏ× ×ÈÅÒÅ ÙÏÕ ÓÅÌÅÃÔ ÉÎÄÉÖÉÄÕÁÌ ÄÅÓÉÇÎÓ ÏÒ ÔÈÅ ÅÎÔÉÒÅ ÆÏÌÄÅÒ ÔÏ ÉÍÐÏÒÔȢ 

Note: Each menu can store up to 36 designs. If you select more than that to import, only the first 36 
will be imported.  
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The designs are imported with their original file names and file types at this point. To finish the 
ÐÒÏÃÅÓÓȟ ÃÌÉÃË ÔÈÅ Ȭ7ÒÉÔÅȭ ÂÕÔÔÏÎȢ .ÁÖÉÇÁÔÅ ÔÏ ÔÈÅ ÄÅÓÉÒÅÄ ÄÅÓÔÉÎÁÔÉÏÎ ÁÎÄ ÃÌÉÃË Ȭ3ÅÌÅÃÔ $ÉÓËÅÔÔÅȢȭ 

3ÉÍÉÌÁÒÌÙȟ $ÅÓÉÇÎÅÒ ÄÉÓËÅÔÔÅÓ ÁÎÄ ÓÔÉÃËÓ ÃÁÎ ÂÅ ÒÅÁÄ ÉÎÔÏ %ÍÂÒÉÌÌÉÁÎÃÅ ÂÙ ÃÌÉÃËÉÎÇ ÔÈÅ Ȭ2ÅÁÄȭ ÂÕÔÔÏÎȢ 

 

7ÈÅÎ ÙÏÕ ÖÉÅ× ÔÈÅ ÎÅ×ÌÙ ÃÒÅÁÔÅÄ $ÅÓÉÇÎÅÒ ρ ÍÅÄÉÁȟ ÙÏÕȭÌÌ ÓÅÅ ÔÈÅ ÆÉÌÅÓ ÁÒÅ ÒÅÎÁÍÅÄ ÁÐÐÒÏÐÒÉÁÔÅÌÙ 
and all the necessary support structure is also created. 

Tip: You are not required to write to an actual diskette. If you create folders ahead of time, you 
ÃÁÎ ÁÃÔÕÁÌÌÙ Ȱ×ÒÉÔÅ ÔÈÅ ÄÉÓËÅÔÔÅȱ ÉÎÔÏ Á ÆÏÌÄÅÒ ÏÎ ÙÏÕÒ ÈÁÒÄ ÄÒÉÖÅ ÆÏÒ ÃÏÐÙÉÎÇ ÏÎÔÏ Á 
diskette later.  
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Basting Around a Design  

 

Individually selected designs can have a basting stitch added automatically. This is useful when you 
want to add a layer of stabilizer or some other material before the sewing of a design. The baste is always 
placed intelligently so that it runs immediately before the selected element(s), as shown in the screen 
shots below. 

 

All elements were selected (Ctrl-A) before applying baste. 

 

Various elements selected individually and together before applying baste. 
Notice where the baste stitches are placed in the Objects View. 
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Here an initial baste is applied and then various areas. 

Basting stitches can also be used to secure a layer of topping stabilizer in place before any designs 
are sewn. A typical use of this is to add a layer of water-soluble topping to a towel, which keeps the 
stitches from becoming embedded in the terry cloth loops during sewing. It can be hard to hoop a towel, 
and the topping stabilizer will want to slide around before the stitching happens, so basting it first can 
make the process easier. 

The basting stitches are added to the start of the design or file, and are added as a separate color; 
naturally you can use any color you want to sew the basting stitches. 
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Product: Enthusiast Ê 

Once you have mastered the Essentials, you might be ready to play a little bit more, explore more 
advanced functions, and take on a little more challenge. If this is you, you might be an enthusiast. We 
named this program after you! 

¶ Stitch editing 

You can select stitches in your design using Lasso and similar tools; move, delete, copy paste, split, 
and more. Repair gaps in stitching. Adjust compensation, change stitch type from satins and fills, select 
and correct stitch types, including cleaning up jumps, ensure tie stitches before and after jumps. 

¶ Multiple hooping 

Many built-in multiple position hoops pre-loaded. Split AUTOMATICALLY using our patented 
feature. Use Mega Hoop, Plus Hoop, Jumbo Hoop, Dream Hoop, etc. 

¶ Baste Hoop 

Beyond basting a design, sometimes tricky fabrics and toppings require an extra bit of help. 

¶ Precise Position 

Accurate positioning of any design on the page. Use this advanced customizing feature for perfect 
layouts. 

¶ Mirror X 4 

Take corner designs and perfectly set them in all four corners of the hoop. 

¶ Instant repeat 

Repeat a design across and down. Make a nice effect. 

¶ Carousel 

Create a circular composition out of your designs. 

¶ Scatter 

Unique effect to create copies of your designs, including lettering, for neat effects on large spaces. 

¶ Advanced Thread editor 

Beyond the Essentials palette creator, the Enthusiast editor lets you make your own thread brands, 
and pick colors right off web pages or PDFs. 

¶ Advanced Stitch properties 

Control satin and fill density within each color layer in any stitch file. 

¶ Save Image utility menu item 

Create a transparent .png file of the current design page for use on the web, etc. 
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Stitch Editing  

 The ability to edit individual stitches is a very useful tool. Sometimes there are parts of a 
design that you simply do not want. Other times, there are jams of stitches that simply cannot be removed 
any other way. In still other cases, you want to add a few stitches to get rid of gaps or increase coverage in 
ÁÎ ÁÒÅÁ ÔÈÁÔȭÓ ÎÏÔ ÎÅÃÅÓÓÁÒÉÌÙ Á ÆÉÌÌȢ -ÁÙÂÅ ÙÏÕ ÊÕÓÔ ×ÁÎÔ ÔÏ ÍÁËÅ a pocket topper?  

4Ï ÂÅÇÉÎ ÅÄÉÔÉÎÇ Á ÄÅÓÉÇÎȭÓ ÓÔÉÔÃÈÅÓȟ ÃÌÉÃË ÔÈÅ 3ÔÉÔÃÈ %ÄÉÔ ÂÕÔÔÏÎ ÏÎ ÔÈÅ ÔÏÏÌÂÁÒȢ 4ÈÉÓ ×ÉÌÌ ÃÁÕÓÅ ÔÈÅ 
Tool pane to display the Stitch Edit controls, and the main view will show the stitch points. 

 

 

Stitch points can be turned on or off from the View menu. They help identify the individual 
needle penetrations in the design. 

Selecting Stitches  

Stitch selection is accomplished two ways: 
1.) A range of continuous stitches. 
2.) A graphical section of stitches (lasso, rectangle, brush selection). 

 

9ÏÕ ÃÁÎ ÓÅÌÅÃÔ Á ÒÁÎÇÅ ÏÆ ÓÔÉÔÃÈÅÓ ÂÙ ÃÌÉÃËÉÎÇ ÁÎ Ȭ!ÎÃÈÏÒȭ ÓÔÉÔÃÈȟ ÁÎÄ ÔÈÅÎ ÕÓÅ ÔÈÅ ËÅÙÂÏÁÒÄ ÔÏ ÓÅÌÅÃÔ 
additional stitches.  (See the keyboard reference at the end of this section.) 

(ÅÒÅ ÙÏÕ ÃÁÎ ÓÅÅ ÔÈÁÔ ×ÅȭÖÅ ÓÅÌÅÃÔÅÄ Á ÒÁÎÇÅ ÏÆ ÓÔÉÔÃÈÅÓ ÉÎÓÉÄÅ ÔÈÅ ÇÏÌÆ ÂÁÌÌȟ ÂÕÔ ×ÅȭÖÅ ÓËÉÐÐÅÄ ÔÈÅ 
satin stitches that go around the edge. If we hit delete on the keyboard, we can remove them! 
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Another way to select stitches is graphically. You can drag a rectangle or a lasso around stitches to 
select them. You can also use the Brush selection, which selects anything the cursor touches, or with the 
Ctrl key, the brush can de-select points. 3ÅÌÅÃÔÅÄ ÓÔÉÔÃÈÅÓ ÃÁÎ ÂÅ ÄÅÌÅÔÅÄ ×ÉÔÈ ÔÈÅ ȬÄÅÌÅÔÅȭ ËÅÙ ÏÒ ÓÐÌÉÔ ÕÓÉÎÇ 
ÔÈÅ Ȭ3ÐÌÉÔȭ ÂÕÔÔÏÎȢ 

Select stitches for an entire object or design using the Object View. While in Stitch Edit mode, simply 
select objects in the tree and the corresponding stitches will be selected. 

 

Left: Lasso.     Right: Selected 

 

You can also select a single stitch by clicking on the line representing the stitch itself. Make sure no 
other stitches are selected first, and then simply click on a stitch line. The stitch point at the end of that 
line will select. This makes it easier to select a single stitch out of a jumble of stitches that may exist near 
each other. 

Converting Stitch Types  

Right-click to bring up a context menu that will give you the ability to switch stitch types between 
Jump and Normal stitching. For color stop inserting, use the Sewing simulator. 

When you convert a stitch to a Jump, you have the option of ensuring the stitches on either side are 
tied off. If you choose this option and the stitches are already tied off, then no stitches will be inserted. 

Ensuring Ties  

If you have a stitch that appears not to be ties down, and you will want to cut it, you can ensure ties 
using the context menu. Simply select the stitch (as directed above) and then right-click for the context 
menu. 
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Splitting a design  

 Once stitches have been selected, you can delete them or split them. To split them, click the 
Ȭ3ÐÌÉÔȭ ÂÕÔÔÏÎȢ 4ÈÉÓ ×ÉÌÌ ÃÒÅÁÔÅ Á ÓÅÐÁÒÁÔÅ ÄÅÓÉÇÎ ÆÏÒ ÔÈÅ ÓÅÌÅÃÔÅÄ ÓÔÉÔÃÈÅÓȢ )Ô ×ÉÌÌ ÁÌÓÏ ÒÅÍÏÖÅ ÔÈÅ ÓÔÉÔÃÈÅÓ 
from the current design. If your design is lettering or a Library design, this process will convert that 
design to stitches so you will not be able to adjust that design the same as before. 

 

Above, the design has been split, and the crown was copied and pasted. 

 

When spliÔÔÉÎÇȟ ÎÏ ÎÅ× ÓÔÉÔÃÈ ÐÏÉÎÔÓ ÁÒÅ ÁÄÄÅÄȢ )Æ ÙÏÕ ×ÁÎÔ ÔÏ ÕÓÅ ÔÈÅ ÓÅÌÅÃÔÉÏÎ ÓÈÁÐÅ ÙÏÕȭÖÅ ÍÁÄÅ 
to actually cut the stitches, which will insert new stitch points, use the second button to split the design. 
This is useful for something like a pocket-topper where you want a clean line of stitches instead of what 
might otherwise be a feathered-edge. 

    

Insert Stitches  

If you have a stitch selected, right-click to get a pop-up menu that will let you insert stitches. 

Notice that you can see the direction of the stitches when you are zoomed in. This helps determine 
ȬÂÅÆÏÒÅȭ ÏÒ ȬÁÆÔÅÒȭȢ The arrow on each stitch points toward the next stitch as the design would sew. 
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Left: Right-click to select the Insert mode.  

Middle: Inserting stitches.   

Right: Stitches have been inserted. 

Converting Stitches  

5ÓÉÎÇ ÔÈÅ Ȭ3ÁÔÉÎȭ $ÒÏÐ-down box, you can convert selected stitches to a satin stitch, a choice of split 
satin stitches, or even add a fill effect to an existing satin stitch. 

 

Adding Compensation  

Once stitches have been selected, you can add compensation, which makes the outside stitches of 
fills or satins a bit longer or shorter. This is useful when you have gaps in a stitch-out and you would like 
ÔÏ ȬÓÔÒÅÔÃÈȭ ÔÈÅ ÓÔÉÔÃÈÅÓ ÔÏÇÅÔÈÅÒȟ ÔÈÕÓ ÒÅÄÕÃÉÎÇ ÏÒ ÅÌÉÍÉÎÁÔÉÎÇ ÔÈÅ ÇÁÐÓȢ 9ÏÕ ÃÁÎ ÁÌÓÏ ÕÓÅ ÃÏÍÐÅÎÓÁÔÉÏÎ ÔÏ 
adjust the width of lettering you may have imported. 

     

Left: a typically gapped design. Middle: The stitches around the gap are selected. Right: 
Compensation has been added by moving the slider to the right. 

Allow Re -Generate  

If you have edited a native object, such as one of the built-in lettering designs, the object still 
retains its original digitizing data. However, as you have edited the object, the ability for the 
program to generate stitches on that object has been turned off. You can re-enable generation 
using the to normal Select Mode, select the object, right click > Allow Regenerate.  
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Stitch Editing Keyboard Shortcuts  

Left Arrow: Select Backwards 
Right Arrow:  Select Forward 
Up Arrow:  Select Forwards 10 stitches 
Down Arrow: Select Backwards 10 stitches 
Page Up:  Select next command (jump or color) 
Page Down: Select previous command 
Home:  Select First stitch 
End:  Select last Stitch 
Delete:  Delete selected stitches 
Shift Left Arrow: Range select backwards 
Shift Right Arrow:  Range select forward 
Shift Up Arrow: Range select forwards 10 stitches 
Shift Down Arrow: Range select backwards 10 stitches 
Shift Page Up: Range select next command (jump or color) 
Shift Page Down: Range select to previous command 
Shift Home: Range select to first stitch 
Shift End:  Range select to last Stitch 

Utilities  

Various features of Enthusiast are found as additions to the Utility menu. 

Precise Position  

You can precisely position designs using these buttons. The three buttons on the (top, left) control 
the display of the x-axis position. There are Left, Center and Right, which means that when you have the 
Left button set, the display will be of the left edge of the design. 

 

Similarly, the bottom three buttons control the vertical axis, top, center and bottom respectively. 
The position controls are very useful for creating tiled patterns. 

Your best friends will be the top ruler and left ruler along the edge of the Design Page. You will 
ÎÏÔÉÃÅ ÔÈÁÔ ÃÅÎÔÅÒ ÏÆ ÔÈÅ ÒÕÌÅÒ ÉÓ ȰπȱȢ 4Ï ÔÈÅ ÌÅÆÔ ÏÆ Ȱπȱ ÉÓ -Ȣ 4Ï ÔÈÅ ÒÉÇÈÔ ÏÆ Ȱπȱ ÉÓ ÐÌÕÓȢ  ,ÅÔȭÓ ÐÌÁÃÅ Á ÄÅÓÉÇÎ ÏÎ 
the design page and get started with Precise Position! 

1. Decide what size embroidery hoop you are going to use and open it onto the Design 
Page. You will notice that there are four quadrants inside the hoop. 

2. Open a design onto the design page. 

3. Place the design in the top left quadrant. Note the numbers in the x and y location 
boxes. (-47.17 and 50.25) 
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4. Select the design and right click to copy and then right click to Paste the design. 

5. Click on Flip Horizontally.  

6. Delete the minus (Ȱ-Ȱ) from 47.53 and hit enter. This will move the copied design to the 
right top corner. 

7. Select the design and right click to copy and then right click to Paste the design. 

8. Click on Flip Vertically.  

9. Place a ÍÉÎÕÓ ɉȰ-ȰɊ next to 50.14 in the y location box. (-50.14) 

10. Hit enter. The design moves to the bottom right corner. 

 

11. Copy and paste the design in bottom right corner. 

12. Click on Flip Horizontally. 

13. Place a ÍÉÎÕÓ ɉȰ-ȰɊ next to 47.53 (-47. 53) in the x location box. Hit Enter. 

14. Your frame is now complete! 
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This is a great way to align your designs without the frustration of where you placed the first design 
and how to get the others to follow suit.  



0ÒÏÄÕÃÔȡ %ÎÔÈÕÓÉÁÓÔΆ 

99

Instant Repeat  

&ÒÏÍ ÔÈÅ 5ÔÉÌÉÔÙ ÍÅÎÕȟ ÓÅÌÅÃÔ Ȱ)ÎÓÔÁÎÔ 2ÅÐÅÁÔȢȱ 4ÈÉÓ opens window that lets you create a pattern of 
designs, copied from the current selection, and pasted in rows and columns. 

To change the values, click the arrows next to each value, or type in a value and then click on 
another one to set it. 

As you change the values, you will see your result on the main view. 

Click OK to accept your new designs. 

                   

Above: An example of a repeated design. 

.ÏÔÉÃÅ ÈÏ× ÔÈÅ ÐÒÅÖÉÅ× ÅÎÁÂÌÅÓ ÙÏÕ ÔÏ ÓÅÅ ÔÈÅ ÐÁÔÔÅÒÎ ÁÓ ÙÏÕ ÁÄÊÕÓÔ ÉÔȟ ×ÈÉÃÈ ÈÅÌÐÓ ÉÆ ÙÏÕȭÒÅ ÔÒÙÉÎÇ 
to fit an area, for example the hoop. 

Note: The initial design will be the (top, left) design, and the copies will go to the right and down.  

  
























































































































































































































































































































